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Introduction

The Earned Value Analysis (EV Analysis) is an industry standard for analyzing project
performance, and it can be used to track:

Progress to date
Forecast completion date
Forecast completion cost
Schedule variances
Budget variances
Performance

v v v v v Vv

As a feedback tool, the EV Analysis helps you to:

» Identify where the problems may occur and whether the problems are critical or not.
» Determine what needs to be done to put the project back on track.

The Earned Value Analysis node (Earned Value Manager > Earned Value Analysis) in
Unifier is based on the project schedule data (activities and assignments) and company rates
(resources and roles) imported from P6 through integration. The Earned Value Analysis node
in Unifier:

» Optimizes the use of Unifier cost control features.

» Calculates earned value and other related measures for a project, such as planned value,
actual cost, variances, performances indexes, and at completion values using rates defined
in Unifier.

Note: Unifier EVM requires database partition tables in Oracle
Database. The database partition feature is only available in Oracle
Database Enterprise Edition and should be enabled with license.

Use the Earned Value Analysis Report node (Earned Value Manager > Earned Value
Analysis Report) to generate ANSI Reports.
In This Section

(T =0 UL = 7
Summary of Steps for Earned Value (EV) ANAlySiS .......ccooovevviiiiiiiiiiiiieeeeeeeeee e 8

Prerequisite

To be able to use the Earned Value Management (EVM) module:

» You need a license for Primavera Unifier Earned Value Management
» Oracle DB, being used for Unifier, must have DB Partition feature enabled.
» The following Oracle third-party applications must be available:

» P6
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»  Gateway
» Unifier and P6 Integration through Gateway must be established.

Ensure that P6, Gateway, and Unifier integration have configured properly. P6 must have at
least one project (if baseline is available in P6 you are set; otherwise, you must use the P6
Current Schedule as baseline).

The option to enable multiple projects mapping between P6 and Unifier is included in the
Shell Attributes form. In the Shell Attributes form, use the Integration tab to map multiple P6
projects with the respective shell in Unifier using P6 Project ID.

Summary of Steps for Earned Value (EV) Analysis

The following is a summary of steps that you must perform for EV Analysis:

1) Begin by setting up integration parameters in Gateway, P6 and Unifier.

2) In Company Workspace (Admin mode), use the two new synchronizations in Unifier
Gateway node to import P6 activities, assignments, and rates for EV analysis.

3) In Company Workspace (User mode), initiate the synchronizations from the company-level
Master Rate Sheet node to fetch the global roles and resources data from P6.

4) In Shell Details, Integration tab, select the Link Multiple P6 Projects check box and add P6
projects.

Notes:
= The same P6 project cannot be mapped to other Unifier shells. The
one-many relationship is unique for EVM functionality.

= The Unifier company currency and P6 base currency must be the
same.

5) Inthe Shell (User mode), the Activity Manager module is available to store an activity sheet
and shell-level rate, WBS, and OBS sheets.

I. Initiate synchronizations in the Activity Sheets log to get:
1. The activities and assignments data from the linked P6 projects.

2. Inthe Rate Sheet node, create rate sheets, if shell-specific rates are required. This
creates a shell-level Rate Sheet with roles and resources that will be used in the shell.

6) Inthe Shell (User mode):

In the Earned Value Analysis node (Earned Value Manager > Earned Value Analysis),
perform earned value analysis corresponding to an activity sheet.

I. Activity sheet data (WBS, CBS, and all projects) is consolidated, rolled up, and displayed
in summary tables in an EV scenario.

2. Earned value analysis can be generated directly for cost loaded projects, with Unifier
Rate Sheet.

3. Forresource loaded projects, resource and role rates must be present before analyzing
earned value and other matrices.

4. Duration based projects are ignored because they do not have cost data.

7) Inthe Company Workspace and Shell, the related areas in Unifier include all permissions,
reporting, and Configuration Package Management modules.
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Note: Only the Cost-loaded and Resource-loaded projects are used for
EV analysis. Although it can be included in an Activity Sheet, a
duration-based project cannot be used for Earned Value Analysis.






Configuring the Gateway Integration

After integration parameters are set up in P6 and Gateway, configure the Gateway integration
options in Unifier.

Notes:
= The Summary sheet Integration will not work when you enable link to
multiple projects in the Integration tab of a shell.

= All existing Activities data, and corresponding Audit log data, will be
deleted when you enable link to multiple projects in Integration tab of
a shell.

= When the P6 project id is added in General tab of a Shell Details
(which is already added in another Shell Integration tab), then the
priority will be given to the shell in which the p6 project id added in
Integration tab on running Get Data from any of the shells.

1) Go to the Company Workspace (Admin mode) and navigate to the Gateway node.

2) Open the Integration Settings dialog.

3) Complete the two synchronizations that are available to import P6 activities and rates for
Earned Value analysis:

I. Select Synchronization to import Activity & Assignment data.

11
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2. Select Synchronization to import Role & Rate rates.

The solution uses existing Unifier and P6 projects only. The existing export
synchronization will be used to export data from Unifier to P6 for activity sheet with
multiple projects.

For a successful integration, the Schedule type must be selected in P6. This is a
mandatory condition.

3. P6 Base Currency
By default, the P6 currency is populated with Company Currency.
If the P6 base currency is not the same as Company Currency, the admin can change it
to the relevant P6 base currency.
Begin initiating the Gateway synchronizations to import and store P6 data:

» Role and Resource Rates
» Activity and Assignment Data

In This Section

Role and RESOUICE RALES.........ccoiiiiiiiiiiii e 12
Activity and ASSIGNMENT DAt ........oooeiiiiiiiie e e e eeeees 12
Prerequisites for Configuring the Gateway Integration..............cccccevvvvieiiieeeeeeeevvnnnnn, 13

Role and Resource Rates

In the Company Workspace (User mode), initiate the synchronization from the Master Rate
Sheet node to fetch the global roles and resources data from P6.

Click Get Data to run the synchronization and create the Master Rate Sheet. The Master Rate
Sheet fetches and stores global roles and resource data from P6. Effective dates and standard
price/unit imported from P6 on first import can be modified in Unifier. Rates from the Master
Rate Sheet are used in the Activity Sheet in a Unifier project for P6 resource loaded projects.
See Master Rate Sheet (on page 17) for more information.

Note: Rates are not imported on subsequent synchronizations. Only
resource and role lists are updated.

Activity and Assignment Data

In the shell Details, use the Integration tab to map P6 projects.

1) Click to expand the the Activity Manager module.

2) Click the Activity Sheet node to open the log.

3) Click Get Data to run the synchronization and create the Activity Sheet.

The Activity Sheet fetches and stores the activity and assignment data from P6, and the role and

resource rates data from the company-level Master Rate Sheet. Subsequent synchronizations
will update the data. For more information, see the following:

12



Configuring the Gateway Integration

» Mapping P6 Projects in Shell Details (on page 15)
» Attributes (on page 229)

Prerequisites for Configuring the Gateway Integration

» Integration Parameters in Gateway and P6
» Permissions

Integration Parameters in Gateway and P6

Complete configuration of the integration parameters in Gateway and P6. The Schedule type
must be selected for projects in P6 for successful integration.

Permissions

Grant the required Administration and User mode permissions for the relevant modules in
Unifier by using the following modules:

» Permission templates
» Access Control
» User Administration

For Administration mode access (Company) use:
» Gateway

For User mode access (Company) use:

» Master Rate Sheet

For User mode access (Project/Shell)

» Activity Manager
» Activity Sheet
» Rate Sheet
» WBS Sheet
» OBS Sheet
» Earned Value Manager
» Earned Value Analysis
» Earned Value Analysis Report

See Permissions (on page 221) for details.

13






Mapping P6 Projects in Shell Details

When Unifier is integrated with P6 via Gateway, an additional Integration tab is displayed in
shell details.

1) Navigate to the shell in which you want to map multiple P6 projects to perform Earned Value
analysis.

2) Inthe Integration tab, select the Link Multiple P6 Projects checkbox. (This drives the
synchronizations in the Gateway node).

3) Click Add.
4) In the Add P6 Project dialog, enter the project ID and click OK.
The project name and schedule type are auto-populated after running the sync.

Only Cost Loaded and Resource Loaded projects are used in Earned Value Analysis. Duration
Based projects are ignored because they do not have cost data.

After the P6 project and its activities are synced to the Activity Sheet, you cannot modify or
delete respective Project IDs. Deselecting the Link Multiple P6 Projects check box also cannot
be done if any P6 project Ids are added.

15
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The same P6 shells cannot be mapped to other Unifier shells. The one-to-many relationship is
unique for Earned Value Management functionality.

16



Master Rate Sheet

Note: The same P6 shells cannot be mapped to another Unifier shell.
The one-to-many relationship is unique for Earned Value Management
functionality.

Master Rate Sheet

Unifier enables you to set a series of rate rules that should be applied when certain conditions
are met in a project by way of the Master Rate Sheet.

In P6, users can assign a role, or resource, to an activity under the assignments tab of an
activity for any project. The rates (Price/Unit) for assigned roles and resources are managed at
global level in P6, which can then be used in a project while doing the costing (calculating
Present Value, Earned Value, etc.) of the project depending on the rate source (resource, role or
override) corresponding to that assignment in an activity.

A Master Rate Sheet is created after the first P6-Unifier integration via Gateway. It fetches and
stores global roles and resource data (and their corresponding rates) from P6.

Subsequent synchronizations will update roles and resources but not the rates. By default, the
rates present in the Master Rate Sheet are used across all the resources and roles present in
the activity sheets across all shells unless you assign a shell-level rate sheet to the Activity
Sheet in that shell.

There is no support to export data from the Master Rate Sheet in Unifier to P6 in the multiple
mapping paradigm.

The sheet stores all the changes made across all the resources and roles present in it manually
or by way of synchronization.

The P6 synchronization for Resource rates and Role rates can result one of the following
scenarios:

Scenario One:

P6 Resource currency = P6 Project currency = Unifier Company currency
No changes required

Scenario Two:

P6 Resource currency <> P6 Project currency = Unifier Company currency

The value against any resource rate from P6 comes in P6 company currency, even if the
resource currency is different. As a result, while synchronizing with P6, the value coming
from P6 as resource rate will be converted to the respective amount in the resource
currency.

The exchange rate for doing this will be fetched from the Standards and Libraries with unifier
company currency as the base currency.

If there is no exchange rate, then by default Unifier uses zero as the exchange rate. The
converted resource rate will be stored in the Master Rate Sheet for an effective date.

If there are multiple rates with different effective dates, then Unifier uses the exchange rate
applicable at that effective for conversion.

17
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Scenario Three:

P6 Resource currency = P6 Project currency = <> Unifier Company currency

The currency object between P6 and Unifier will be mapped in Gateway to get the P6 Project
currency. Once, Unifier receives the P6 project currency, Unifier treats it as explained in
Scenario Two, by applying the exchange rate to individual resources.

Scenario Four:

P6 Resource currency <> P6 Project currency <> Unifier Company currency

Unifier implements the process indicated in Scenario Three; thereby, converting all the
resource rates in unifier company currency.

If the resource rate currency is different from the P6 project currency, then Unifier applies the
process indicated in Scenario Two to handle this scenario (Scenario Four).

Note: While creating a shell-level rate sheet Unifier keeps the currencies
that are being used in the Company Workspace because that is where
the currency is going to be used by a resource.

Master Rate Sheet and P6 (Multiple Row Rates)

In P6 both the resource and role rates are maintained globally. You can import P6 resource and
role rates into the Unifier Master Rate Sheet.

For a resource loaded schedule, you need rates corresponding to these roles and resources for
doing costing of any project in Unifier.

There are two types of rate sheets in Unifier:
» Master Rate Sheet (at Company Workspace)
Company Workspace > User mode > Master Rate Sheet
» Rate Sheet (at Project/Shell)
Project/Shell > User mode > Activity Manager > Rate Sheet

For P6 resource loaded schedule, the Master Sheet receives the standard rates which
correspond to the roles and resources, and the rates are used in costing of any project in Unifier.

In P6 you can define a role with multiple rates and multiple effective dates and bring the
information into the Unifier Master Rate Sheet.

Note: When you click on Get Data from the Master Rate Sheet log, the
rate sheet displays all of the existing role rates with effective date as
01/01/2020.

When you create a project rate sheet that only has the resources and roles that are being used
in the resource-loaded project in the system activity sheet of a shell, you can see the assigned
roles, with the multiple rates, that have been sent to the Master Rate Sheet.

You can assign the role rate to the activities and resource assignments and any cost
calculations will use the assigned rate.

When you refresh data in the Master Rate Sheet, Unifier performs all of the existing validations.

18



Master Rate Sheet

For a cost loaded schedule, there are no calculations conducted in Unifier, and Unifier uses the
data directly from P6.

In P6, rates are assigned to a role or resource at global level. To maintain the consistency, the
P6 global data is imported to Unifier Company Workspace. This data is captured under the
Master Rate Sheet. That is to say, the rate sheet is created through P6-Unifier integration and is
saved as "Master Rate Sheet" under a new node in company workspace called Master Rate
Sheet.

Under Company Workspace, there is only one rate sheet called Master Rate Sheet. You are
not permitted to create a copy sheet of the Master Rate Sheet under Company Workspace.
The Master Rate Sheet contains rates for both roles and resources. You will be able to toggle
between role and resource rates within the window.

Note: By default, the rates present in the Master Rate Sheet are used
across all roles and resources present in all activity sheets across all
shells unless the user has assigned another rate sheet (present at the
shell level) to the activity sheet/project.

To assign rates at the activity sheet level, you can use a subset of Master Rate Sheet in a shell
with the roles and resources being used in the resource-loaded projects in the system activity
sheet of that shell, only. Rate sheets present at any shell are subsets of Master Rate Sheet.
This means, when you click on refresh data (Refresh) for any rate sheet at shell level, then
Unifier updates the Master Rate Sheet with:

» The list of roles and resources based on the latest data available in resource-loaded projects
in the activity sheet
» The corresponding rates from Master Rate Sheet

The following rules are in place when refreshing data:

» If arole or resource rate has been removed from the system activity sheet (for that shellO,
then Unifier deletes the role or resource rate along with the rates in the Rate Sheet being
refreshed.

» If arole or resource rate has been added in the activity sheet, then Unifier updates the rate
sheet being refreshed with the new role or resource rate along with the rates in the Master
Rate Sheet.

» For arole or resource rate that appears across both the system activity sheet and rate sheet,
Unifier updates the currency or Resource/Role name (if applicable), using the role or
resource ID as the identifier.

A rate sheet in the Master Rate Sheet (at Company Workspace) is updated through P6, but a
rate sheet in the Rate Sheet (at Project/Shell) gets updated in Unifier through the Master Rate
Sheet at Company Workspace) and system activity sheet at that shell.

Accessing the Master Rate Sheet Log

To access the Master Rate Sheet log:

1) Gotothe Company Workspace.
2) Switch to User mode.
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3) On the left-hand Navigator, click the Master Rate Sheet node.

Note: The location of the node may differ in your implementation based
on the Company Workspace User Mode Navigator configuration.

The Master Rate Sheet (at Company Workspace, User mode) log displays the Master Rate
Sheet created at Company Workspace through P6-Unifier integration. When you click on the
Master Rate Sheet module, the Master Rate Sheet log opens.

The Master Rate Sheet log contains the following toolbars:
» Get Data
To initiate getting the data.
The Master Rate Sheet log contains the following columns:
» Name

For the master rate sheet being created through P6-Unifier integration, the name will be
"Master Rate Sheet."

» Description

It will be left blank while creating the master rate sheet through P6-Unifier integration and is
an editable field.

» Last Updated
Date when master rate sheet was last updated.
» Created By

For master rate sheet being created through P6-Unifier integration the created by will be P6
or any other Oracle 3rd part applications (if applicable).

The gear menu (ﬂ') next to the Master Rate Sheet enables you to:
» Open
» Export CSV
» Export Role Rate Breakdown
» Export Resource ate Breakdown
» Update Data
» Import Role Rate Breakdown
» Import Resource ate Breakdown

The Master Rate Sheet log contains the following tabs (right-hand pane):

Audit Log | Stores all the changes made across all roles and resource present in the
Master Rate Sheet (manual/synchronization).

Schedule | To schedule get data and see the history. The Schedule tab enables you
to:

» Set frequency for getting data or sending data (Set Frequency for).

» Select the frequency time (Frequency).

» Set the start and end dates.
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History

The History tab enables you to see a history of changes made on the
system activity sheet such as:

Action
Requestor
Initiated On
Start Date
End Date
Status

v v v v v Vv

When you open the Master Rate Sheet, the Master Rate Sheet - Resource overlay page

opens.

The Master Rate Sheet - Resource overlay page contains the following toolbars:

Status Enables you to select to see which status to display on page. The options
are:
» Active
» Inactive
» Delete
View Enables you to select the items according to Resource or Role.
Print Enables you to print or export the items listed on the page.
Refresh | To refresh the list of items on the page.
Edit View | To change the view of the listed items on the page.
Search To search for a particular item.
Find on |To find an item on the page.
Page
Collapse |Enables you to collapse or expand the items on the page.
or
Expand

The Master Rate Sheet - Resource overlay page contains the following columns which provide

details about the resource:

ID
Name

Type

v v v v Vv

Status

Currency

The gear menu (ﬂ) next to an item listed on the Master Rate Sheet - Resource enables you

to:

» Open Expand Row
» Collapse Row
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Master Rate Sheet Log: Toolbar Functions

Get Data is the only option available. Click Get Data to initiate the synchronization from the
Master Rate Sheet node to fetch the global roles and resources data from P6. Currency and
Rates are not imported on subsequent synchronizations. Only resource and role lists are
updated. Rates can be modified in the Master Rate Sheet.

The main grid of the log displays the Master Rate Sheet. The log columns are as follows:

4
4
4
»

Name: Master Rate Sheet

Description: Master list of Resource and Role. Not editable.

Last Updated: Date when sheet was last updated via synchronization or manually.
Created By: The user who initiated the synchronization.

The gear menu (ﬂ) for the Master Rate Sheet are:

4
4

Open: Select to open the Master Rate Sheet.

Export CSV: Use the options to export Role or Resource Rates as CSV. This comprises the
global list imported from P6. The structure includes the following information:

» Resource ID

» Resource Name

» Resource Type (Labor, Non-labor, Material)
» Status

» Effective From

» Price/Unit

Update Data: Use the options to import the modified Role or Resource Rates CSV files in
order to update role and resource rates.

Note: You cannot modify the name and status fields in the import file.
The rest (ID, effective from date and price/unit) are all required fields.

Master Rate Sheet Log: Tabs

The right pane of the Master Rate Sheet log has the following tabs:

» Audit Log
» Schedule
» History
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The Audit Log tab tracks all changes made inside the rate sheet.

The Schedule tab allows you to set the frequency of automatically running the Get Data
synchronization at daily, weekly, monthly or quarterly intervals between the specified start and
end dates. Possible values in the Status field are:

» Running
» Completed
» Failed
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The History tab captures information about manual/synchronization (schedule get data) job.
The toolbar has Refresh and Find of Page functions. When you click Refresh, Unifier refreshes
the History. This enables you to track the status of an ongoing synchronization. For example,
when you click Get Data, and switch to the History tab, and you see new record with
"RUNNING" (sometimes empty), then click Refresh to see the status changed to "Completed," if
the job is done.

The following rules are followed while synchronizing the Master Rate Sheet data with P6:

» If aresource/role has been removed from the global list in P6, the Master Rate Sheet
role/resource and corresponding rates will not change.

» If aresource/role has been added to the global list in P6, then the new role/resource is
added to the Master Rate Sheet along with its corresponding rates.

» If the resource/role exists in both P6 and the Master Rate Sheet, then the system updates
only the resource/role name, if applicable (using resource or role ID as the identifier).

Opening Master Rate Sheet

Click on the gear menu (ﬂ) to open the menu and click Open to open the Master Rate Sheet.
When opened, the Master Rate Sheet displays as an overlay.

The Master Rate Sheet log window has the following toolbar options :

Status

View

Print

Refresh

Find on Page

Expand All or Collapse All

v v v v v Vv
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The Status option enables you to assign one of the following standings on the sheet:

» Active

» Inactive

» Deleted
There are two default views available under the View option which enables you to switch
between views:

» Resource

» Role

The Master Rate Sheet log window has the following tab:
» Rates

The Rates tab provides Price/Unit, populated from P6. Click Create to manually add new
breakdown structure for the following:

» Cost Type
» Rate Type
» Price/Unit

To add new values, click the Add icon (the plus + icon). When finished, click Save.

You can use a formula to establish rates based on other cost types. When you edit the cell
Price/Unit, a formula icon is displayed and when you select the formula icon a hew formula
window will be displayed.

Note: In Master Rate Sheet some Resources or Roles have incorrect
breakdown structure, but they are not assigned to any project. If the
Resources or Roles have correct breakdown structure in the project,
then the recost will work.

See Attributes (on page 229) for details about column headings and elements. Refer to the
Unifier Reference Guide for details on each element.
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Unifier enables you to create, consolidate, and monitor activities that must be completed on a
schedule by way of the Activity Manager.

To access the Activity Manager node:

1) Goto your shell in User mode.
2) Click Activity Manager node to expand.

The following provides details about each sub-node.
Note: To view the Activity Sheet, or other sheets, you must have the
appropriate permissions.

You can create user-defined reports (UDRSs) from the Activity Sheet Data Elements (DES).

For a cost loaded schedule, we don't do any calculations in Unifier and use the data directly from
Pé6.

The Activity Manager node contains the following sub-nodes:

Node name |Description

Activity The Activity Sheet node contains a list of activity sheets listed in the
Sheet Activity Sheets log window. You can have have multiple activity sheets.

An activity sheet captures scheduling data from the mapped P6 projects
and role and resource rates from the company-level Master Rate Sheet
(default) or shell-level rate sheets, and calculates the Earned Values
metrics and derivatives. It is the primary source of data for the Earned
Value Analysis.
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Rate Sheet

The Rate Sheet node captures the list of resources and roles (based on
the latest data available in activity sheet) and corresponding rates from
the master rate sheet.

In P6, users can assign a role, or resource, to an activity under the
Assignments tab of an activity for any project. In P6, rates are assigned to
a role or resource at global level. To maintain the consistency, we will
import the P6 global data to Unifier company workspace. This data will be
captured under a new entity called Master Rate Sheet. The rate sheet
being created through P6-Unifier integration will be saved as 'Master Rate
Sheet' under a new node in company workspace called Master Rate
Sheet.

The rates (Price/Unit) for assigned roles and resources are managed at
global level in P6, which can then be used in a project while doing the
costing (calculating Present Value, Earned Value, etc.) of the project
depending on the rate source (resource, role or override) corresponding
to that assignment in an activity.

For a resource loaded schedule, we need rates corresponding to roles
and resources for costing of any project in Unifier. There will be two types
of rate sheets in Unifier:

» Master Rate Sheet (at company workspace)
» Rate Sheet (at Shell) explained in the subsequent sections.

A company will only have one Rate Sheet called the "Master Rate Sheet."
So, users are not allowed to create a copy sheet of the Master Rate
Sheet under company workspace. This sheet will contain rates for both
roles and resources, users will be able to toggle between resource and
role rates from the display. By default, the rates present in master rate
sheet will be used across all the resources and roles present in all activity
sheets across all shells unless user has assigned another rate sheet
present at the shell level to the activity sheet/project.

Refer to the Unifier Earned Value Management User Guide for details.

WBS Sheet

A WBS Sheet (Work Breakdown Structure sheet) contains the following
information:

» Planned Units

Planned Total Cost

Actual Units

Actual Total Cost

Remaining Units

Remaining Total Cost

At Completion Units

At Completion Total Cost

The WBS Sheet node log displays the only available WBS sheet.
Refer to the Unifier Earned Value Management User Guide for details.

v v v v v v Vv
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OBS Sheet |An OBS Sheet (Organization Breakdown Structure sheet) contains the
following information:

» Full Name

Short Name

Unifier User

Title

Department

Status

WBS Name

Contract No

Weekly Capacity

The OBS Sheet node log displays the only available OBS sheet.
Refer to the Unifier Earned Value Management User Guide for details.

Vv v vV vV VvV v v Vv

In This Section

ACHIVIEY SREEEINOE ... 29
RAE SNEET NOUE... ...t e e e e e e e e e e eans 132
WBS SREEENOUE ... .ceviiii et e e e e e e 141
OBS ShEEEINOUE..... et e e e e e e eas 167

Activity Sheet Node

An activity sheet captures scheduling data from the mapped P6 projects and role and resource
rates from the company-level Master Rate Sheet (default) or shell-level rate sheets, and
calculates the Earned Values metrics and derivatives. It is the primary source of data for the
Earned Value Analysis.

The Activity Sheet node contains a list of activity sheets listed in the Activity Sheets log
window. You can have have multiple activity sheets.

After P6-Unifier integration has been run and P6 projects mapped in the Integration tab of shell
details, a single activity sheet can be created in the Activity Sheets log of the shell. (Shell >
User mode > Activity Manager > Activity Sheet > Activity Sheets log)

Each P6 project is associated with a baseline project sheet and a current schedule project
sheet. The activity sheet allows you to switch between baseline and current project types and
view the specific scheduling information — activities, assignments, dates, etc.

Notes:

= Once produced, the baseline project sheet cannot be altered,
however, you can update the current project sheet, per Data Date.

= If you update the project baseline in p6, then the project baseline will
get updated in Unifier (when running the sync by selecting the
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P6

Baseline option for the respective project).

projects in the activity sheet are classified as:

Duration Based projects

Duration Based projects bring activity duration data only. They do not include resource
assignment or cost related information, and are, therefore, not available for Earned Value
analysis.

Resource Loaded projects
Resource Loaded projects load duration and resource assignment information, but no cost
related information from P6. In Unifier, you can assign rate sheet and costing to calculate

resource costs in the projects. After costing is completed, they are available for Earned
Value analysis.

Cost Loaded projects

Cost Loaded projects bring duration, resource assignment as well as cost information from
P6. No further cost calculation is necessary. You can directly use the Earned Value module
for cost comparisons and analyses in these projects.

After integration, data brought in to the Activity Sheet are constrained by project categories and
the constrains govern the behavior of the Activity Sheet.

In Unifier, we use the Schedule type for defining the projects, and it is displayed as:

Resource The Activity Sheet receives the entire duration based information from

P6

The Activity Sheet receives the entire resource assignment related
information

(Not always) The Activity Sheet receives the entire cost related
information

The Activity Sheet is available as a source for Cash Flow and Cost
Sheet

The Activity Sheet has all cost related feature (Assign rate sheet and
Recost)

The Activity Sheet is available for Earned Value Analysis
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Cost The Activity Sheet receives the entire duration based information from
P6

The Activity Sheet receives the entire resource assignment related
information

The Activity Sheet receives the entire cost related information

The Activity Sheet is available as a source for Cash Flow and Cost
Sheet

The Activity Sheet does not have any cost related feature (Assign rate
sheet and Recost)

The Activity Sheet is available for Earned Value Analysis

Duration The Activity Sheet receives duration based information from P6
(without

‘Based) (Not always) The Activity Sheet receives resource assignment related

information
(Not always) The Activity Sheet receives cost related information

The Activity Sheet is not available as a source for Cash Flow and Cost
Sheet

The Activity Sheet does not have any cost related feature (Assign rate
sheet and Recost)

The Activity Sheet is not available for Earned Value Analysis

When you click on the Activity Sheet node the Activity Sheets log opens. The following
explains the Activity Sheets log.

Activity Sheets Log

The Activity Sheets log lists the activity sheets which capture project scheduling data coming
from P6.

To access the Activity Sheets log, go to the shell (User mode), click to expand the Activity
Manager module, and click Activity Sheet sub-node.

Note: The location may differ in your implementation based on the
Project/Shell User Mode Navigator configuration.

You can use the Activity Sheets log to:

» Create an activity sheet
» See a list of activity sheets.

» Review the following information (on the right-hand pane of the log) about a System Activity
Sheet:

» Mapped Projects
» Schedule
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» History

» Review the following information (on the right-hand pane of the log) about a selected activity
sheet:

» Properties

» Permissions
» Audit Log

» History

Activity Sheets Log Toolbar Options

If you have the Create Manual Activity Sheets permission, or the Full Access permission (see
the Activity Sheet in Shell (User Mode) Permissions (on page 223) topic in this document),
then the toolbar options in the Activity Sheets log are as follows:

Toolbar Description
Option
Create Enables you to create new activity sheets. This option is enabled when the

user has at least the Create permission for the manual activity sheets.
The Create option has two additional sub-options to support the manual
creation of an activity sheet and creating an activity sheet from Activity
Sheet templates (when the Activity Sheet templates is made available in
the admin mode).

When you click Create, Unifier checks for manual activity attribute form, if
a system activity sheet has been created by using the system activity
sheet attribute form.

If there is no system activity sheet attribute form defined, or there is no
manual activity attribute form, in the design, then Unifier uses the canned
form for the activities in the activity sheet.

An activity attribute form must be defined in order for you to be able to
create custom activity sheets. If a system activity attribute form is defined
in uDesigner, but there is no manual activity attribute form, then Unifier
displays this message: Activity attribute form must be defined
in order to create custom activity sheets.
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Toolbar Description

Option

View Enables you to select how to view the list of the activity sheets that are
available.

To be able to see any activity sheets in the Activity Sheets log, you must
have the View permission, or above.

The View drop-down field displays the following out-of-the box, or default,
options:

All

To display all of the activity sheets.

Active

To display all of the activity sheets with active status. Available if there are
activity sheets in the log that have active status.

Note: The System Activity Sheet will be active (Status) at all times, and
the status cannot be changed.

Actions To set permissions and import options:
Permissions

To assign activity sheet-level permissions similar to the record-level
permissions set for the non-Workflow BPs.

Import (Microsoft MPP or P6XML)
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Toolbar Description
Option
Get Data |The Get Data option will be enabled when you have the Get Data
: permission at the node level in the Permissions tab. This option enables
you to receive the schedules from P6 or Primavera Cloud based on
Get Data |synchronization selected in Gateway settings.
into Use the Get Data option to:
System o s
Activit » Create an activity sheet for the first time.
Sheet y » Update an existing activity sheet with the most recent activity spread

data from the Oracle Primavera Cloud project.

Updating an existing activity sheet triggers a new OOTB import
synchronizations if you have selected the Select Synchronization to
Exchange Activity Data option in Gateway integration settings drop-down
list.

All of the synchronized Oracle Primavera Cloud project activities, planned
dates, actual, at completion dates, and associated WBS Code will be
displayed in the activity sheet.

If the shell is not active (inactive shell), then Gateway integration will fail.

When you select Get Data, the system checks for the Oracle Primavera
Cloud project that as defined in the Integration tab and then brings the
Oracle Primavera Cloud project activity data and their schedules into the
activity sheet based on the import synchronization defined in Gateway
settings, and if Oracle Primavera Cloud and Unifier projects are linked.

If you select Get Data and there is no Project ID added in the Integration
tab, Unifier will display this message: Valid Project ID is not specified in
the Shell Integration Tab.

Unifier does not bring the baseline (project data) from Primavera Cloud.
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Toolbar Description
Option

Send Data | The Send Data option will be enabled when you have the Send Data
permission at the node level in the Permissions tab. This option enables
you to receive the schedules from P6 or Primavera Cloud based on
Send Data |synchronization selected in Gateway settings.

from Use the Send Data option to run the export synchronization in order to
System send the updated activities and schedules from Unifier Activity Sheet to
Activity the Oracle Primavera Cloud.

Sheet The data elements in the business processes, or the shell attribute form,
which have been set to reverse auto-populate (RAP) back to the Oracle
Primavera Cloud Activity Sheet (using P6 Activity Picker) will get the latest
updates into the Oracle Primavera Cloud Activity Sheet.

You can send the updated Unifier Activity Sheet data (such as: updated
Actual Start Date or Finish Dates) to the Oracle Primavera Cloud project
which is linked by way of the OOTB export synchronization option: Update
Unifier Activity data in to Primavera Cloud.

The Schedule tab, in the Activity Sheet log, shows this option, and you
can set the scheduled send data based on frequency.

Before the initial synchronization, the Get Data is the only toolbar function
available in the log. Click Get Data to initiate synchronization and create
the Activity Sheet.

—

Refresh To retrieve the latest number of activity sheets created in the log.

Print To print the log contents into HTML, CSV, or Excel formats.

Find on To search in the log.
Page

If you do not have the Create Manual Activity Sheets permission, or the Full Access
permission (see the Activity Sheet in Shell (User Mode) Permissions (on page 223) topic in
this document), then the toolbar options in the Activity Sheets log are as follows:

Toolbar Description
Option
View See the entry in the table above.

Actions See the entry in the table above.
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Toolbar Description
Option

Get Data |See the entry in the table above.

—

Get Data
into
System
Activity
Sheet

Send Data | See the entry in the table above.

i,
—

Send Data
from
System
Activity
Sheet

Refresh See the entry in the table above.

Print See the entry in the table above.

Find on See the entry in the table above.
Page

Activity Sheets Log Columns
»
»
»
»

The Activity Sheets log lists the activity sheets. Each activity sheet has a gear menu (ﬂ) that
can be used to open the activity sheet.
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Note: You can also double-click to open the sheet.

In Unifier, you can use an activity sheet to capture the scheduling data from P6 or Primavera
Cloud. A single activity sheet (called System Activity Sheet) is mapped to multiple source
projects, by way of integration. You have the option to view the activities (from the mapped
source projects) by using the project drop-down field which contains a list of all source projects
mapped to your shell.

The Activity Sheets log enables you to see all of the activity sheets, including the system
activity sheet. The log displays the following columns that describe the listed activity sheets:
» Name

The name of the activity sheet provided. This field is a required when capturing the activity

sheet properties. The activity sheet name must be unique across the activity sheets. For an
activity sheet that is created by way of integration from P6 or Primavera Cloud, this column
will show the activity sheet as, "System Activity Sheet."

» Description
The activity sheet description entered in the properties for the manual activity sheets.
» Source Type

The activity sheet as either System or Custom. Activity sheets that are created by way of
using Get Data will be displayed as "System," and the activity sheets that are created
manually will be displayed as "Custom."

» Status

The status of the activity sheet. For the System Activity Sheet the status is active and you
cannot change the status. For the manual activity sheets, the default status is active, and you
can change status to inactive. The Status column is used in rolling up the costs and spreads
to the Earned Value Analysis, Cash Flow, or Cost Sheet, and so forth.

» Last Updated On

Populated with the latest date that the activity sheet was updated. The activity sheet will be
updated by means of the schedule, as well as manual updates.

» Creation Date
Populated with the date that activity sheet was created.

All of the date columns will honor the data preference set at the user-level.

Activity Sheets Log Tabs

The Activity Sheets log displays the activity sheet properties on the right-hand pane.
For a System Activity Sheet, the following tabs display the properties:
» Mapped Projects

» Assigh Rate Sheet

» Recost

» Schedule
» History
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For Manual Activity Sheets, where source-type is, "Custom," the following tabs display the
properties:

» Properties
» Permissions
» Audit Log

» History

To view the tabs, the three vertical dots.
To view the tabs details, click the expand icon, in the right pane or tab screen.

The following explains each tab in details.

Mapped Projects Tab

The Mapped Projects tab lists the P6 projects drawn from the Integration tab of shell details
into the Activity Sheet.

The Mapped Projects tab toolbar options are:
The toolbar options are:

» Assign Rate Sheet
See below for details.
» Recost
See below for detalils.
Refresh
Find on Page
Use the toolbar options to assign a shell-level rate sheet to selected projects, recost resource

loaded or cost loaded projects, refresh page, and find an item displayed on the page
respectively.

The Mapped Projects tab columns are:

Project ID

Project Name

Project Type: The values are Current or Baseline

Project Start Date

Data Date: The date a project is updated in P6

Schedule Type: The values are Duration, Resource, or Cost

v v v vV vV v Vv

1/CPI; PF = 1; (1/CPI)*(BAC - EV); 0.75 * (BAC — EV)
» Rate Sheet (Planning): The Master Rate Sheet or a shell-level rate sheet used to calculate
the costs.

» Rate Sheet (Actuals): The Master Rate Sheet or a shell-level rate sheet used to calculate
the costs.
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Assign Rate Sheet

By default, the resource and role rates in the activity sheet are retrieved from the Master Rate
Sheet and applied across all the projects. If you have created shell level rate sheets, you can
assign a rate sheet to one or more projects.

1) Select one or more projects in the tab.

2) Click Assign Rate Sheet to open the Assign Rate Sheet window. The Assignh Rate Sheet
window has the following options:

a. Planning

If you are familiar with the rate sheets in the shell, you can click the drop-down arrow to
select a rate sheet, or Master Rate Sheet, as the source. If you need more details about
the rate sheets, click the select icon (next to the drop-down arrow) to open the Select
Rate Sheet window and review the details of the available rate sheets before selecting.

Alternatively, you can enter the name of the rate sheet in this window that you want to
use to calculate the respective cost.

b. Actuals
If you are familiar with the rate sheets in the shell, you can click the drop-down arrow to
select a rate sheet, or Master Rate Sheet, as the source. If you need more details about
the rate sheets, click the select icon (next to the drop-down arrow) to open the Select
Rate Sheet window and review the details of the available rate sheets before selecting.

Alternatively, you can enter the name of the rate sheet in this window that you want to
use to calculate the respective cost.

3) Click Assign (or click Cancel to exit without making any changes).

Note: An alert “No Rate Sheets to Assign” is displayed if no rate sheets
exist. You can Assign Rate Sheet only to Resource-loaded projects in
the Activity Sheet.

The role and resource rates are applied to the activities/assignments in the selected projects,
when refreshed. You must perform Recost in order to apply rates from the new assigned rate
sheets.

When a different rate sheet is assigned to a project, Unifier displays the following alert message:
Perform Recost to see updated costs.

Recost

Recost enables you to perform the cost calculations in an activity sheet, for type selected (i.e.,

current schedule or baseline schedule). Upon initiating this option, Unifier refreshes the rates for
Price/Unit for each assignment, based on the rate source from the rate sheet assigned using the
latest rates present. The field will be updated (or used) in recost according to the following rules:

» If the rate source is Resource, then Unifier gets the corresponding data from the resource
rate sheet.
If the rate source is Role, then Unifier gets the corresponding rate from the role rate sheet.

If the rate source is Override, then Unifier update the Price/Unit and uses the Price/Unit for
the respective assignment present in the Activity Sheet.
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This functionality applies to Resource loaded projects. Recost for Cost-loaded Projects also
takes care of applying the exchange rates for Cost fields if P6 Currency is different than Unifier
Company Currency or Shell Currency. Use Recost to perform cost calculations in the Activity
Sheet for the schedule type selected (current or baseline).

Note: Recosting cannot be performed on Duration-based projects.

By default, the Master Rate Sheet is used to perform costing; however, if a shell level rate sheet
is assigned, then values are derived from it instead.

When you activate recost, the following fields (within activities and assignments) are refreshed
using the spread data and rates from the assigned rate sheet.

See the following topics for details:

» Recost — Activity Attributes (on page 229)
» Recost — Assignment Attributes (on page 233)

The values are taken from the baseline or the corresponding baseline values from the current
schedule.

The activity attributes are re-calculated by using the spread data and rates from the assigned
rate sheet.

The corresponding values at the activity level are calculated by rolling up the values from the
assignments.

Note: For recosting, if price/unit and resource/role rates are not defined
in the Activity Sheet, a default value of 0 is used, and a warning is
displayed. If the values are defined, then the project currency is used for
the calculations. The rate is multiplied by the number of units to get the
cost.

Unifier applies the following logic to recosting:

The calculations are triggered while doing the re-costing for Activity Sheet. Once Unifier receives
all the rates, Unifier proceeds according to one of the following scenarios:

Scenario One

Resource Currency = Company Currency = Shell Currency
No changes are required.

Scenario Two

Resource Currency <> Company Currency = Shell Currency

Unifier calculates all the spread data (currency fields) that is present in the Activity Sheet (in
the company currency) by using the resource/role rates applicable at each spread Data Date
field.

If the resource rate currency is different from the company currency, then the exchange rate
will be applied at each spread Data Date field to calculate the spread data.

The spread data will then be rolled up to the respective currency field.

40



Activity Manager

These calculated values in the company currency are used to calculate any dependent field
(for example, CPI, SPI, etc.) as part of recosting.

Scenario Three

Resource Currency = Company Currency <> Shell Currency

Unifier calculates all the spread data (currency fields) that is present in the Activity Sheet (in
the company currency) by using the resource/role rates applicable at each spread Data Date
field.

The spread data will then be rolled up to the respective currency field.

These calculated values in the company currency are used to calculate any dependent field
(for example, CPI, SPI, etc.) as part of recosting.

Note: Only Scenario Three is applied to the cost-loaded.

The values in the shell currency will be calculated by using the applicable exchange rate for
that shell currency at each spread Data Date field for all currency fields. Unifier uses these
values to calculate any dependent field (for example, CPI, SPI, etc.) as part of recosting.

Note: Despite being in the Activity Sheet user interface, you can only
see the Activity Sheet data in the Shell currency.
Scenario Four

Resource Currency <> Company Currency <> Shell Currency

Apply the steps indicated in Scenario Two and then apply the steps indicated in Scenario
Three.

The Recost action must be manually triggered by the user after the following actions are
performed in the Activity Sheet, or the Rate Sheet:

1. Assign CBS.

2. Assign Rate Source.

3. Assign Price/Unit.

4. Update Data in actions button inside the activity sheet.

5. Changes in Rates for any of the resources/roles in Rate Sheet in case the resources/roles are
referred in Assignments.
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Schedule Tab

Set the frequency of synchronizations to automatically get data from P6 or send data from
Unifier at daily, weekly, monthly, or quarterly intervals. The default value is None. Define the
start and end dates for the scheduled syncs.

History Tab

The tab displays the history of all scheduled jobs that are performed across the projects included
in the Activity Sheet. Toolbar has Refresh and Find on Page actions. Columns include:

» Action — Displays actions related to Get Data, Send Data, Recost, and Cost Roll up
» Requestor

» Initiated On

» Start Date

» End Date

» Status - Displays Failed, Running, or Completed
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Properties Tab

All the activity sheets that are defined in Unifier will be displayed with source type as '‘Custom’ in
the Activity Sheets log. Upon expanding the split pane, the first tab shown will be the activity
sheet properties (Properties tab). In the right pane, under the Properties tab, You can change
the values for the following fields:

» Name
» Description

» Status

» Calendar

» Activity Sequence Numbering

The Project Schedule Start Date can be maodified if there are no activities that are in progress
in the log.

You can maodify the activity sequence number in the Properties tab. The modified sequence will
be displayed for any new activity sheets that are created after the sequence got modified. The
activity sheets will not be impacted with this change in the activity sequencing.

When changes are made in the Properties tab, the Cancel and Save options will be enabled.
There will be an entry in the activity sheet Audit Log tab for the changes made.

Permissions Tab

Use the Permissions tab to define, edit, or view other members' permissions in the project. The
activity sheet owner, or the user with full access permission, will be able to assign, modify, and
view other members' permissions.

The permissions that are allowed to be assigned to other users are:

» Modify Permissions

» Edit Data

» View
The permissions will be similar to record-level permissions set for earned value reports or
non-workflow business process. You can select an activity sheet or multiple activity sheets,

right-click, and select Permissions. This action enables you to assign permissions to multiple
groups and users.

Audit Log Tab
The Audit Log tab in the Activity Sheets log captures the following events:

» Creation of the sheet.

» Update of the activity sheet properties, including the data date and activity sequence
numbering field.

» The Cost Sheet roll up of costs (in the future).
The Audit Log tab will be available for the activity sheets that are created manually.
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About System Activity Sheet

The Activity Sheets log captures project scheduling data coming from P6. A single activity
sheet, for example System Activity Sheet, in Unifier will be mapped to multiple project
schedule sheets, which are created by way of integration.

Default View of System Activity Sheet

The activity sheets in Unifier are used to capture project scheduling data coming from P6 or
Primavera Cloud. An activity sheet created in Unifier can be mapped to multiple source projects
which get created by way of integration.

When you open the System Activity Sheet, (<shell> > User mode > Activity Manager node >

Activity Sheet sub-node > Activity Sheets log > System Activity Sheet > gear menu (ﬂ') >
Open) that is created by way of integration with P6, or Primavera Cloud, it will list all of the
activities in the Activity Sheet log.

In the Activity Sheet log, the list of all activities are displayed in a flat grid. The first three
columns as fixed columns (Spread column, Activity ID, and Activity Name). All of the other
columns seen in the grid are in the same order as showing the activity attribute form. The
column labels are derived from the activity attribute form.

You can view the activity spread data by using the gear menu (ﬂ) option, "View Activity
Spread" or by navigating to the Activity Spread tab in the dock at the bottom of the screen (or
the bottom right pane where the activity details can be viewed). When you click View Activity
Spread, the activity spread tab will be highlighted, and you can view the spread data of the
selected activity.

The activity details and other tabs can be seen in the bottom pane, by default, the first time
when a sheet is created. You can use the split pane to view the activity and assigned resources
details.

Within the System Activity Sheet, the default name of the view is "Default." The default view is
not editable. You can create new views based on the default view, when editing the view
settings. This is similar to the default view available in WBS Sheet.

The Source Project drop-down field is visible at the top of the activity sheet as, "<Source
name> Project : <Project ID>." The Source Project drop-down contains list only if the activity
sheet received activity data from multiple source projects.

The link to the source project is base on the source URL, provided in the company properties.

The ink to view the baseline project is displayed next to the source project, where you can select
the link to view the baseline data for the selected source project. If there are no baselines
received for the selected source project, then this link is not displayed.

The CBS Code column is an editable column in the Activity Sheet for all of the activities, and
the picker is displayed when you double-click the CBS Code column cell.

You can assign the CBS codes to the activities by selecting the picker, or by using the
type-ahead functionality. You can assign a single CBS Code to multiple rows by dragging.
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The CBS Code assigned to an activity for the first time automatically assigns the same CBS
Code to all of its resources. Unifier does not push to the resources any subsequent updates of
the CBS Code, at the activity level.

The Save and Cancel options will become available once you edit the CBS Code, or the Rate
Source, in the activity sheet.

When you click the gear menu (ﬂ) for an activity, you can click the Apply CBS Code to All
Assignments to assign the CBS Code to all of the resources under that activity.

Once the CBS Code is updated at the activity level, you can assign same CBS Code to all of
the resource assignments of the activity by using right-click on the activity and selecting the
option "Apply CBS Code to all Assighments". This selection causes all of the assigned
resources CBS Code to be updated.

Once you assign or update the CBS Code, both at the activity level and the assignment level,
Unifier updates the contents of the the Audit Log tab.

You can select multiple activities and update the CBS Code to the resources of the selected
activities by right-clicking and selecting the option "Assign CBS Code to All Assignments."

All of the actions related to the export of the activities and the assignments, and the import of the
CBS Code assignments to the activities and the assignments, can be done by way of the Menu
(the icon with three horizontal lines), on the right-hand side of the window. The Menu has the
following options:
» Export
» CSV Template for Activities
» CSV Template for Assignments
» All Activities
» All Assignments
» Import
» CBS Code for Activities
» CBS Code for Assignments
» Audit Log

You can assign the same CBS Code to multiple activities by selecting multiple consecutive cells,
in the CBS Code column, and adding CBS Code. Similarly, you can remove CBS assignment
by selecting the Clear option in the picker column itself. The following option is available within
the Actions menu: Apply CBS Code to all Assignments. Using this option enables you to
apply the CBS Code assignments to all of the resources associated to the highlighted activities.

You can also use the gear menu (ﬂ) option "Apply CBS Code to all Assignments" to
highlight multiple activities and apply the same CBS Code to the assigned resources.

In the Activity Sheet log, you can view the activity details by selecting a row and clicking on the
split panel. When you select the split panel, the bottom pane will expand to show the details of
the activity in multiple tabs: General, Resource Assignments, Activity Spread, and Audit
Log.

General tab
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Contains all of the details related to the activity sheet, which are defined in activity attribute form
including the WBS Details. The data elements and the order of the data elements, shown in the
General tab, are based on the activity attribute form. The hidden data elements are not shown in
the General tab. You can dock this pane to the right side of the screen. If you dock the pane at
bottom, or right side, manually, Unifier retains your choice after closing the Activity Sheet
window. You can expand the bottom pane by using the expand icon on the right-hand side.

Activity Spread tab

When you select the spread column option for an activity, the Activity Spread tab will be
highlighted to show the spread of the selected activity. The Activity Spread tab will show all of
the data (both for costs and for units) in one spread sheet. Also, the Type drop-down field will no
longer be available because the costs and units spread data appears on one single sheet. You
can expand the screen to view more spread data. The order of the columns in the Activity
Spread tab are as follows:

Periods (Instead of Period Start)
Cost & Rate Type

Planned units

Actual Units

Remaining Units

At Completion Units

Planned Cost

Actual Cost

Remaining Cost

At Completion Cost

VvV vV vV vV vV vV vV v v v

The Frequency drop-down field shows "Day" timescale to enable you to view the daily spread
data. The toolbar options available are:
» Find on Page
» Print
» Frequency
» Cost & Rate Type

You can view the spread data for each activity by navigating to different activities under the
spread column.

Note: Only one activity spread data is displayed. If you select multiple
activity rows, then Unifier displays: "Details of multiple activities
cannot be viewed."

Resource Assignments tab

In the Resource Assignments tab, all of the resources associated with the activity are
displayed. Both the CBS Code and the Rate Source columns are editable. By default, the
picker icon is not displayed until you click on the cell of the columns.

You can edit a CBS Code for a particular resource and assign the same CBS Code to other
resources by dragging the CBS Code to multiple rows.

The Rate Source drop-down field displays all of the rate sources:
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» Resource
» Role
» Override

In the case of the resource, the Rate Source field drop-down shows the option "Resource" as
selected.

For the roles, the Rate Source field drop-down shows the option "Role" as the source selected.

You can edit the price or unit for planning and actuals if the value for the Rate Source is selected
as: "Override."

The Cancel and Save options appear when you attempt to edit the Rate Source value, or the
CBS Code, or other fields based on the Rate Source in the Resource Assignments tab.

If you try to navigate to an activity sheet without saving the tab information, then Unifier notifies
you.

Selecting the "View Assignment Spread" from gear menu (ﬂ) option (for any selected
resource) displays the spread data for that resource (a full screen overlay window). You can
view the daily spread data of the resource. The Frequency drop-down field will show additional
option to select: "Daily."

This window will have an additional drop-down field to select the resources that are in the
Resource Assignments tab, for the selected activity. Both the costs and the Units spread will be
seen in a single spread sheet. Click Close to close the spread sheet. In the Activity Sheet the
following two default views are available:

» Default View
> WBS View

Note: Any existing views that were created prior to the 20.10 upgrade
will not be seen in the View drop-down field.

The Default View will be seen by default when you open the sheet. In the Default View
drop-down field, all of the activities will be in flat mode.

When you select the WBS View drop-down field, all of the activities within the sheet will be
grouped by WBS hierarchy. At WBS (Summary level), all of the costs show the sum of the costs
of all of the activities, as well as the costs that are received at the summary level.

The Start and Finish dates, in the WBS row, will show the earliest start date and latest finish
dates for all of the activities under that WBS.

All the attributes defined in the Activity Attribute form will be displayed as columns in the WBS
View, similar to the Default View. The order of columns will be the same as selected in the
design, in uDesigner.

You can create views with filters, groupings, and so forth (within an activity sheet) in order to
view the filtered and small list of activities and associated columns, instead of scrolling down and
right to navigate to specific activities.

For the default and user-defined views, you can perform the following functions, in addition to
adding, deleting, and updating the activities and the schedules:
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» Drag and drop columns and reorder the columns, except the first 2 columns (Activity ID and
Activity Name) which are fixed.

Click at a column header to change the Sort By option.
Right-click at a column header and select Lock after this column option to lock a column.
Right-click at a column and select Lock after this column option to lock a column.

Note: You cannot lock before this column beyond the Activity Name
column.

Similar to a Cost Sheet or a WBS Sheet, you can group selected columns in the sheet.

Creating System Activity Sheet
The System Activity Sheet can be created using the following synchronizations:

» Get Activity data from P6
» Get Activity and Assignment data from P6 for EVM
» Send Primavera Cloud Activity data to Unifier

Note: For an activity sheet, the blocks and fields on the right-hand pane
can differ based on the synchronizations.

You have the option to view activities present in a P6 Project mapped to Unifier Shell, in the
Activity Sheets log, by selecting the corresponding P6 Project ID in the Project drop-down
present inside the Activity Sheet log, when you open the system activity sheet from the Activity
Sheets log.

The Project drop-down will contain the list of all P6 projects mapped to the shell and selecting a
project from this drop-down will load the respective scheduling data (activities) in the Activity
Sheets log.

A project in P6 can be a current schedule project or a baseline schedule project. Over the
project life span, a user can create multiple baseline projects which are mapped to a current
schedule project.

While sending data from P6, a baseline project sheet is created for the Project baseline (and not
for Primary baseline, Secondary baseline, or Tertiary baseline, etc.). As a result, every project
from P6 will have a baseline project sheet and current schedule project sheet (which will have
the scheduling information i.e. activities, assignments, etc.).

If a P6 project has only current schedule, then Unifier treats the planned data in current
schedule as the baseline.

The project sheets which are created in Unifier by way of integration are grouped under a single
activity sheet that can be selected to perform Earned Value (EV) analysis. Refer to the Unifier
Earned Value Management User Guide to learn how to calculate earned value and related
measures for your project.

The fields related to costing can be updated in Unifier and re-costed for a resource loaded
schedule.
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You can assign a rate sheet to a resource-loaded projects present in the Activity Sheet log,
when you open the system activity sheet from the Activity Sheets log, but if you want to
perform an operation at the project sheet level, then you can open the activity sheet, select the
project and schedule type, while working on the activity sheet.

You have the option to switch between current schedule and baseline schedule for the project
that you have selected from the drop-down list.

The Activity Sheet node, Activity Sheets log, has the following toolbar options:

Get Enables you to create an Activity Sheet for the first time, or update an existing
Data | Activity Sheet with the most recent data from P6.

The Get Data synchronization that created the activity sheet also populates
the activity sheet with the:

» Scheduling data (activities along with assignments and spread data) from
the P6 projects mapped to the current shell in the Integration tab.

» Role and resource rates data from the Master Rate Sheet for the mapped
projects.

Note: Subsequent updates of Role and Resource Rates in P6 will not trigger
the updates in Unifier Master Rate Sheet; however, subsequent updates of
CBS Code for activities in P6 will trigger the updates in the Unifier Activity
Sheet CBS assignments.

Send |Enables you to send data from Unifier to P6. This will trigger the
Data |synchronizations at Gateway level.

The Activity Sheet node, Activity Sheets log, has the following columns:

Name | The shell name that the activity sheet is being created through P6-Unifier
integration.

Descri | Populated with the value "System Activity Sheet created via P6-Unifier
ption |Integration" for system activity sheet.

Last The date when the activity sheet was last updated, based on either Recost or
Update | Integration.
d

Create | The user who initiated the Get Data flow for activity sheet that is being created
d By |through P6-Unifier integration.

If there are no data present (when Get Data is launched) Unifier creates a line
item (with history), by default.

The gear menu (ﬂ) next to the system activity sheet enables you to open the system activity
sheet.

The Activity Sheet node, Activity Sheets log, has the following tabs (right-hand pane):
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Mappe | The Mapped Projects tab has the following toolbar options:

d _ » Assign Rate Sheet: To select Planning and Actuals specifications. You
Project can select a rate sheet from the list and specify the project to which the
S rate sheet will be assigned (from the Project).

» Recost: To roll up the CBS costs (Cost Loaded), or to re-calculate all
costs (Resource Loaded). It enables you to perform the cost calculations
in an activity sheet, for type selected (i.e., current schedule or baseline
schedule).

Refresh: To refresh the Mapped Projects tab log items.

Find on Page: To find a particular project in the Mapped Projects tab log
items.

The Mapped Projects tab has the following columns:
Project ID

Project Name

Project Type

Project Start Date

Data Date

Schedule Type

ETC Technique

Rate Sheet (Planning)

Rate Sheet (Actuals)

Vv v v vV VvV vV v v Vv

Sched |The Schedule tab enables you to:

ule » Set frequency for getting data or sending data (Set Frequency for).
» Select the frequency time (Freguency).

» Set the start and end dates.

Histor | The History tab enables you to see a history (the history of all events that
y have been performed across project sheets present in the activity sheet) of
changes made on the system activity sheet such as:

Action

Requestor

Initiated On

Start Date

End Date

Status

v v v v v Vv

When you open the activity sheet (system activity sheet) from the Activity Sheets log the
Activity Sheet overlay page opens. The Activity Sheet overlay page displays all of the
activities data, in columns, and it enables you to view activity spreads, source project, and so
forth.

The Activity Sheet overlay page has the following toolbar options:
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Actions Enables you to:
Assign CBS

The option Assign CBS changes to Assign CBS Code in an existing
activity sheet that has been created by using "Get Activity and
Assignment from P6 for EVM" synchronization, and the Assign CBS
window label changes to the Assign CBS Code.

Export CSV (Activities - Assignments - Audit Log)
Update Data

Activities (Export CSV Template - Import CSV)
Assignments (Export CSV Template - Import CSV)

View Enables you to:
» View all activities (All). The default view with all the columns.

» Create a new view (Create New View). Create a new view and save
it under a user defined custom name.

» Manage your views (Manager Views)

Refresh To refresh the list of items on the page.

Edit View To change the view of the listed items on the page.

» Columns: Enables you to add or remove any column to the default
Activity sheet view. Also enables you to arrange columns in any
order within the sheet.

» Filter: Enables you to filter the results based on a column.
» Group by: Enables you to change the Group By option.
» Sort by: Enables you to choose a sort order.

Search To search for a particular item.

Find on To find an item on the page.

Page

Project Enables you to select a project for the list.

51



Unifier Earned Value Management User Guide

Open
Project in
<source

name> E’

<source
name> =
Oracle
Primavera

Cloud or P6

You can use the Open Project in <source name> option (also see
About Unifier and Oracle Primavera Cloud Integration (on page
172)) to open the Oracle Primavera Cloud page and open the source
URL either in P6 or Oracle Primavera Cloud, in a new tab with the
Activities tab pointing to the relevant project data (the project that is
selected in the drop-down provided there is an active login session).

The login on the new tab for P6 or Oracle Primavera Cloud will be
displayed where you ender your login credentials to sign in and see the
relevant project data.

Note: You can see the project is opened even when that particular
project is closed in the source server.

Selecting this icon will open the source application in a new tab
provided there is a valid URL specified. If no URL is defined in the
company properties page, then this link will not be shown in the Activity
Sheet.

Also when you switch to Baseline, the link is not displayed.

The Activity Sheet overlay page has columns that provide more details such as:

Activity ID

Activity Name

Activity Status

»
4
» Activity % Complete
4
4

Activity Type

More information about the columns below.

The gear menu (ﬂ') next to the activity enables you to:

» View Activity Spread
» Assign CBS

The Activity Sheet overlay page has the following tabs (right-hand pane):

General

This tab provides information about:

v v v v v Vv

WBS Attributes

Activity Attributes (General)
Activity Attributes (Schedule)
Activity Attributes (Units)
Activity Attributes (Cost)

Activity Attributes (Earned Value)

More information about fields within the information above:
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Assignm |This tab provides information about:
ents Resource Name
Role Name

Rate Source

CBS Code

Planned Units
Actual Units
Remaining Units

At Completion Units
Price/Unit (Planning)
Price/Unit (Actuals)
Planned Cost

Actual Cost
Remaining Cost

At Completion Cost

VvV VvV vV vV vV vV VvV vV vV vV vV v v v

The gear menu (ﬂ') enables you to:
» View Assignment Spread

» Assign CBS

» Assign Rate Source

Audit Log | This tab enables you to see audit details.

Creating an Activity Sheet

In the Activity Sheets log window, click Get Data to open the Get Data window.

1) Choose one of the following options:

a. Click to select the All Projects field and populate the field box with all available projects.
You can use the x in front of the project name to remove it from the field box.

b. Click the field box to see the list of projects and then click on the project that you need.
2) Select the project type: Type. You may have to scroll down, if you select all projects.
3) Click OK to apply your selection and close the window.

When the Activity Sheets log window opens, you will see the following additional options on the
toolbar:

» Send Data: Use this to send Unifier activity sheet data to the projects in P6. This will trigger
the synchronizations at Gateway level.

Creating an Activity Sheet (Manual)

In the Activity Sheets log (User mode):
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If you have permission to receive and send the scheduling and resource data into an activity
sheet from P6 or Primavera Cloud, then the Activity Sheets log displays the following options in
the log window:

» Get Data
» Send Data

As explained in the previous topic, you can use these toolbar options to create an activity sheet.

If you have permission to use Get Data only, then you will see the Get Data option in the log
window.

If you have the Create Manual Activity Sheets permission, or the Full Access permission, (see
the Activity Sheet in Shell (User Mode) Permissions (on page 223) topic in this document),
then you will see the Create option in the log window.

If only the standard activity attribute form is defined but not manual activity attribute form (in
uDesigner), then the Create option in the Activity Sheets log is not displayed.

When you click Create, the Create Activity Sheet window opens which enables you to name
the manually created activity sheet, determine the status, select a calendar, select the source for
the project schedule start date, select the schedule start date, data date, and the activity
sequence number.

When you have permission to create activity sheets both manually and through synchronization
with P6 or Primavera Cloud, the following options are displayed in the log:

» Create
» Send Data
» Get Data

The following explains the Create Activity Sheet window fields:

Name To specify the activity sheet name. This is a required field. The name
specified should be unigue. Also, you cannot enter the sheet name as
'System Activity Sheet'. The field allows up to 150 characters long
names.

Description To describe the activity sheet. This field allows alphanumeric
characters and supports all special characters. It is a long description
field that allows up to 400 characters long.

Status To make an activity sheet active or inactive. The default status is
Active. The activity sheet can later be set as active or inactive through
the properties screen. Only the active sheet data will be rolled up to
other cost modules like Cost Sheet, EVM Sheet, and Cash Flow, and
so forth.

Calendar A drop-down field with 'Project/Shell Calendar' as the default value. It
lists all of the calendars that have been defined at the Custom
Calendars node, in the shell, project, and company calendars (as
defined in Standards & Libraries). This field enables you to select any
calendar for the project schedule. You cannot deselect the calendar
from the drop-down, but you can change the selected calendar.
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Project
Schedule
Start Date

This field is identified as the start date for the project schedule as
defined in the activity sheet. The project schedule start date can be
entered manually by selecting the Manual option or by using the shell
attribute: uuu_project_start_date. This is a required field in the activity
sheet properties. If it is selected as manual, then you must provide a
start date in order to be able to save the activity sheet properties.

The second option 'From Shell Attribute' will populate the start date on
the activity sheet by using the targeted project start date
(uuu_project_start_date) on the shell or project properties which in turn
can be received from the project creation business process.

Any change in the project start date in shell properties will
automatically update the activity sheet start date. Synchronous update
to the activity sheet takes place as long as there is no activity which is
either in-progress or has been completed.

Data Date

The value in this field will populate the data date for the scheduled
activity sheet. Initially, the value is the project start date, if no schedule
has been run.

Activity
Sequencing
Numbering

To define the sequence number for the Activity ID while defining
activities or tasks in the activity sheet. The following sub-fields are
available:

Activity ID
Prefix

To define the sequence prefix which can be a sequence of characters.
The limit on the number of characters will be between 1 to 20. This is a
required field, and the default value is'A.' The field allows
alphanumeric characters.

Activity ID
Suffix

This field defines the suffix for the Activity ID. It allows integer digits
from 1 to 6 characters long. The range will be between 1 to 999,999.
No negative and decimal values are allowed. The default value will be
1000.
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Increment

To define the increment that each activity sheet can be incremented. It
allows only integer digits from 1 to 1000. The default value i '1.' No
negative and decimal values are allowed. Unifier shows the unique 1D
for each activity sheet that is defined.

Example: Prefix of A combined with the suffix of 1000 with default
increment as '1' would show the activity IDs as A1000, A1001, etc.

The above activity sequencing format will be honored for all new
activities that get created within the Sheet. Any activities that get
imported from an external source (MPP or P6 XML) or CSV import
then the activity ID column will show the imported IDs if provided
otherwise would use the activity sequence defined in the sheet
properties to generate a unique Activity ID for all the activities that are
imported.

You can change the activity sequencing anytime from the properties
window. All of the new activities will honor the new sequence format, if
the activity sequencing is changed. Any changes to the activity
sequence numbering fields will be audited (Audit Log).

Activity Sheets Log - Activity Sheet Window

The Get Data synchronization that created the activity sheet also populates the activity sheet

with the:

» Scheduling data (activities along with assignments and spread data) from the P6 projects

mapped to the current shell in the Integration tab.
» Role and resource rates data from the Master Rate Sheet for the mapped projects.

Go to the shell (User mode) > Activity Manager module > Activity Sheet node to open the
Activity Sheets log which lists the activity sheets. You can also double-click to open the activity

sheet.

Note: Subsequent updates of CBS Code, Role Rate, and Resource Rate
in P6 will not trigger the update of the CBS Code (in the Activity Sheet)
and Role Rate and Resource Rate (in the Master Rate Sheet) in Unifier.
This is to prevent data in Unifier to be overridden by updates in P6.

Each activity sheet has a gear menu (ﬂ') that can be used to:

» Open

To open the Activity Sheet from the log. Alternatively, you can highlight a row, right-click, and

use the Open option.

» Copy
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Also available by using right-click on the activity sheet. To create a new activity sheet by
copying all of the activities, schedules, associated WBS, and assignments (in future). The
default name of the Activity Sheet will be 'Copy of <Activity Sheet Name>'. This gear menu

(ﬂ) option will not be seen if you select multiple activity sheets or for the System Activity
Sheet.

» Permissions
To assign Edit, View, and Modify permissions to other users for the selected activity sheets.
The functionality supported is same as assigning permissions to nhon Workflow BPs.

When you open an activity sheet, the Activity Sheet log window opens.

The Activity Sheet log window contains the full log. By default, the left grid displays the current
schedule for the first project (displayed in the Project field) as a flat and alphabetically organized
list of the project activities and attributes.

The Activity Sheet log window right-hand pane displays the following tabs:

» General
» Assignments
» Audit Log

You can use the toolbar options in the Activity Sheet log window to:

» Assign a rate sheet to the project

» View, create, edit, and manage log views

» Filter by project

» Switch between schedule types (current or baseline) of the project

The following explains each toolbar option:
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Actions

The Actions drop-down list has the following options:

» Permissions

This option is not applicable to the System Activity Sheet. This option is
available when you select a single or multiple activity sheets (manual or
custom). The functionality is the same as when the Permissions option

is selected using the gear menu (ﬂ') option. You can assign
permissions to multiple activity sheets that are created manually from
the log. his includes the sheets created using import from MPP or P6
XML files.

» Export CSV

To export information from the tabs in a CSV (Comma Separated
Value) file.

» Select the Activities option to export the WBS and activity attributes
data in the General tab.

» Select the Assignments option to export the assignment information
in the Assignments tab.

» Select the Audit Log option to export the activity-related events in
the Audit Log tab. Audit Log option (in Export CSV) exports the
project-related events which also consists of Activity-related events.
The Audit Log option is not the same as Audit Log tab. The Audit
log tab is specific only to the selected Activity-related events.

» Update Data

Use the options to export the activities and assignments column
structure in CSV templates, and then import the modified templates to
make changes in editable fields.

» Select the Activities, Export CSV Template option to export the
activity attributes data in the sheet.

» Select the Activities, Import CSV Template option to import the
modified CSV file and update activity data in the sheet.

» Select the Assignments, Export CSV Template option to export the
assignments data in the sheet.

» Select the Assignments, Import CSV Template option to import the
modified CSV file and update assignment data in the sheet.

» Assign CBS
To assign CBS to multiple activities at a time.

58




Activity Manager

View The View option enables you to switch between default and custom log
views. The View drop-down list has the following options:

» All
The default option displays all columns in the log.

» Create New View
Use this option to create a custom view. Custom views appear in the
View list.

» Manage Views
Use this option to reorder, show/hide views, and delete custom views.

Refresh  |When a different rate sheet is assigned to roles and resources or when
recost is performed, values in the sheet are not automatically updated.
Click Refresh to display updated data in the fields.

Edit View |Select or Hide columns, apply filters, group and sort by available fields.
Save custom views.

» Inthe Columns tab, add/remove/reorder columns in the default view.
You can save as a custom view.
In the Filter tab, add conditions to filter the results of a column.
In the Group By tab, create or modify groups using column elements.
For example, activity status.

» Inthe Sort By tab, define the sorting order (Ascending or Descending)
of columns.

Search To search for related items in the database. You can filter the data based
on cost type and rate type.

Find on | To filter results displayed on the screen. In any column, begin typing in the

Page field below the header to trigger results.

Below the toolbar options, the following options are available:

Project Enable you to select a project and display the project activities on the
Activity Sheet log window., and the tabs on the right-hand pane are
dynamically updated with the corresponding items

Switch to | A P6 project can be a current schedule project or a baseline schedule

Baseline |project. This is a toggle key that provides access to the current or baseline

Project project types.

To view the Activity Spread for an activity sheet:

1) Select an activity in the Activity Sheet log window.

2) Click the gear menu (ﬂ) and select View Activity Spread to open the Activity Spread
window.

59



Unifier Earned Value Management User Guide

3)

Select your options from the following fields to display the results on the Activity Spread
window.

» Type

» Frequency
» Cost Type
» Rate Type

To assign CBS to an activity sheet:

1)
2)
3)
4)
5)
6)

7)

Select an activity in the Activity Sheet log window.

Click the gear menu (ﬂ) and select Assign CBS to open the Assign CBS window (cost
code picker).

Click the drop-down arrow to select the CBS Code from the list.
Click the select icon (next to the drop-down arrow) to open the CBS Picker log window.

Click to select one or multiple CBS codes from the list and click Select to return to the
Assign CBS window.

Click to select the Apply to all Assignments in the Activity. This enables you to apply the
cost code to only the activity or all assignments of the activity.

Click OK.

The Activity Sheet log window has the following columns, in the default layout:

VWV VvV VvV VvV VvV VvV VvV ¥V VvV VvV VvV VvV VvV VvV VvV vV vV VvV VvV v v v
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Activity ID

Activity Name

Activity Status

Activity Type

Activity % Complete
Actual Start

Actual Finish

Actual Duration

Actual Total Cost

At Completion Duration
At Completion Total Cost
Planned Start

Planned Finish
Planned Duration
Planned Total Cost
Start

Finish

Remaining Early Finish
Remaining Early Start
Remaining Duration
WBS Code

WBS Name
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WBS Path
Remaining Total Cost
Primary Constraint
Secondary Constraint

v v v Vv

Note: Use can change the default by creating and managing custom
views in the View drop-down list.

The Activity Sheet log window displays the activity sheet properties on the right-hand pane
within the following tabs:

» General

» Assignments

» Audit Log

Tip: Click the expand icon, in the right pane, to better view the tab detalils.

The following explains each tab in details. Each tab provides information corresponding to
activity attributes, assignments, and events respectively:

The General tab displays the attributes for the selected activity in groups:

WBS Attributes

Activity Attributes (General)
Activity Attributes (Schedule)
Activity Attributes (Units)

Activity Attributes (Cost)

Activity Attributes (Earned Value)

See Attributes (on page 229) for details.

v v v v v Vv

The Assignments tab displays the resources and roles assigned to the activity selected in the
main grid. The layout displays the following columns:

Resource Name
Role Name

Rate Source

CBS Code

Planned Units
Actual Units
Remaining Units
At Completion Units
Price per Unit
Planned Cost
Actual Cost
Remaining Cost

At Completion Cost

VvV vV vV vV vV vV VvV VvV vV vV v v v

Assign Price/Unit
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To override the price or unit. The Planning and Actuals will be fetched from corresponding Rate
Sheet or Overridden Price/Unit from override action. Whenever a different Rate is assigned to a
Resource, system will display the following alert message: Perform Recost to see updated costs.

The gear menu (ﬂ) in the Assignments tab are:

» View Spread
» Assign CBS
» Assign Rate Source

Select View Spread to view the spread of costs or units for a role or resource assignment in a
separate pop-up window.

The gear menu (ﬂ') in the Assignments tab vary depending on the project type. There is
only one option for Cost-loaded and Schedule-based projects:

» View Assignment Spread

The following options are available for the Resource-loaded projects:
» View Assignment Spread

» Assign CBS

» Assign Rate Source

In the Type list, select Cost or Units. Column headings change accordingly.
In the Frequency list, change the granularity level of the spread to Week, Month, or Year.
In the Assignment Spread dialog, view values in the following columns:

» Period Start

» Planned Cost (or Units)

» Actual Cost (or Units)

» At Completion Cost (or Units)
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» Remaining Cost (or Units)

Use this option to assign a CBS code to a resource and/or role. Select Assign CBS and select a
code in the CBS field, and then click OK.

Select Assign Rate Source to assign a rate source to an assignment.
The Rate Source drop-down list has the following options:

» Resource (default)

63



Unifier Earned Value Management User Guide

» Role
» Override

Select an option.

Unifier updates the rates for price/unit of each assignment after retrieving them from the
corresponding source fields in the rate sheets as follows:

» If the rate source is Resource, the data is fetched from the Resource Rate Sheet.
» If the rate source is Role, the data is fetched from the Role Rate Sheet.
» If the rate source is Override, the Price/Unit data is not refreshed.

In this case, you must manually specify the value. To do so, click Rate Source and follow the
prompts. The Assign Rate Source is only applicable for Resource-loaded projects.

» Select Override and click OK.
» The gear menu (ﬂ') displays an additional option for Override. Click the gear menu

(ﬂ) and select Assign Price/Unit.
» Modify the existing rate and click OK.

When finished, click OK.
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Unifier rolls up the assignment values to calculate values at the activity level.

The Audit Log tab displays the audit details at the activity level in the following columns:

> Date
> Event
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Action
Field Name
Old Value
New Value
User Name
Proxy User

v v v v v Vv

Activity Sheet Default

When you create a new activity sheet, after defining the activity sheet properties (you can also
populated the newly created activity sheet by way of opening an existing activity in the log),
Unifier creates a default activity sheet.

Note: In the process explained above, the Project Start Date and Project
Finish Date fields will not be seen in Unifier 20.12, but the fields will be
made available in later releases.

In the newly created activity sheet:

» Project Start Date

Displays the earliest date of all the activities. In the case of a blank activity sheet, the
scheduled start date will be the project start date.

» Project End Date
Displays the latest date of all the activities on the activity sheet. In the case of a blank activity
sheet, the scheduled start date will be the project end or finish date.

The following explains the first five columns displayed in a created activity sheet, in the grid
section of the activity sheet:
» Row Number

Displays the row number and errors, if any. This is a read-only column, with a sequential
number starting from 1 (one).

» Activity ID
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Displays the activity ID for each added activity sheet. Unifier uses the default sequence
number specified in activity sheet properties to populate the activity ID. You can edit the
column and enter custom activity ID for a selected activity sheet. This is a required field and
alphanumeric characters are allowed, only. Verify that no special characters are entered
when defining the activity ID.

» Activity Name
Displays the name of the activity sheet. This is a required field and alphanumeric characters
are allowed.

Note: The attachments and notes features will not be seen in the activity
sheet in Unifier 20.12, but the features will be made available in later
releases.

A default lock will be seen after the first three columns.

» Attachments
Displays the attachment icon. You can add attachments to the activity sheet in the
Attachments tab (in the right pane or dock bottom pane).

» Notes

Displays the notes icon. You can add notes for the selected activity sheet in the Notes tab.
The functionality will be the same as in the CBS rows. This functionality will allow you to
enter the notes. For example, you can use notes to specify the reasons for the change of the
activity sheet dates or duration from the initial baseline.

All the other columns are displayed in the order defined in uDesigner, followed by the Notes
column. If there is no attribute form defined in uDesigner (for manual activity sheets), then all of
the P6 data elements (uuu_P6 data elements) are displayed as columns.

Activity Sheet Default (Toolbar Options)
The following explains the toolbar options in a created activity sheet, in default view:
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Toolbar Description

Add To add a new row. The row will have the Activity ID field value
pre-populated with the sequence number specified in the activity sheet
properties. The Activity Name field is displayed as required and other
required columns will be highlighted with red triangle, on the right-hand
side corner. Upon selecting Save All, the required fields will show as
errors in the first column (similar to manage rows in the cost sheet).

» If you select an activity and click Add, then the new activity row will be
created after the selected
activity.
If you do not select an activity and click Add, then the new activity row
will be created after the selected
activity.
If the user do not select any activity, then the new activity row will be
created at the very end.
Note: The activity sheet shows the flat list of activities. Any user with edit
permissions would be able to add
and update the activities to the activity sheet.

Schedule |To enable the scheduling in the activity sheet, once you add the activities,
and updating the activity schedules like planned, actual dates, duration,
and so forth. It also enables you to remove the activities. All of the
dependent activities will be rescheduled based on the data date specified
in the schedule. If you select this option in a blank sheet, then Unifier
displays this message: There are no activities in the sheet to be
scheduled.

View Same as in the System Activity Sheet, the View drop-down list displays
the system-defined view 'Default’ and 'WBS View', by default.

You can create and manage views in the activity sheet.

» Default

» Create New View

» Manage Views
You can add activities and change column structure in the Default view,
also.

Similar to the other activity sheets, the data creation (both rows and
columns) will be available in the default view.

Edit View |To edit the user-defined views.

Settings
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Toolbar Description
Actions If you (the user) have at least Edit Data permission for manual activity
sheet, then you can use the Actions option and perform the following:
» Schedule
» Create Baseline
» Update Baseline
» Baseline Comparison
» Link Selected Activities
» Unlink Selected Activities
See the "Actions Option" topic, below, for more details.
Refresh All of the existing export and import options available for CBS Code
activities and assignments will be seen in the Menu Options.
To refresh the contents of the activity Sheet.
Note: If there are unsaved changes in the sheet, Unifier displays this
message: You have unsaved changes in the sheet. These will be lost on
refresh. Do you want to proceed? If you select 'Yes', then the activity
sheet should be refreshed; otherwise, refreshing of the activity sheet will
not happen.
Print The following printing options are available:
» Print
» Exportto CSV
» Export to Excel
Find on To conduct search in the activities and other attributes within the activity
Page sheet.
Search To search the activities based on search parameters that are defined in
uDesigner.
Note: If there are unsaved changes in the activity sheet and you click
'Search’, the search result will include the unsaved rows.
Menu There will be no option for updating the CBS Code for Activities or
Options Assignments. Any Activity Sheet defined in project, where the logged user
- o have at least edit data permission to the sheet, has the following options:
» Export > Activity Details
(the three y E P > Al A ty .
horizontal xpor ¢ '_V' €S
line icon » Export > All Assignments
with » Import > Activity Details
down-arro | » CSV Import of Activities
w) » View History Log

See the "Menu Options" topic, below, for more details.
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Toolbar Description
Gantt Once you click Gantt, the following toolbar options become available:
= Gantt ) A Grid
» Grid
» Focus Activity
» Baseline Comparison
Enables you to see the baseline bars along with current activities. The
relationship between the current activities will be seen, also.
» Critical Path
The Critical Path calculation follows a standard mathematical algorithm
known as the Critical Path Method (CPM). CPM calculates the starting
and ending times for each activity. CPM determines which activities
are critical (uuu_float = 0) to the completion of the project (called
Critical Path) and reevaluates activities with uuu_float values. The
tooltip for the current activities will show the current and baseline
dates, and the variance in number of days between the baseline start
and start dates.
The Show drop-down field will be editable once you select Gantt from the
toolbar. This drop-down has the following options:
» Default Gantt
» Critical Path
» Baseline Comparison
Dates and Numeric values displayed in tool-tip are based on the user
preference set at company-level.
For more details about Gantt view, see "Gantt View" below.
Switch to |Enables you to see the current project.
Current
Project
View
Switch to |Enables you to:
Baseline | ) see the baseline for the project.
\F;irgd\f’Ct » Add activity and change the activity schedule.

Actions Option

Depending on your permissions, the Actions option enables you to:
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Option

Description
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Schedule

To schedule the activities based on the data date. You update the
progress of the activity both:

» At the activity-level in the sheet grid or in the General tab of
activity.
» Inthe Assignments tab.

The Schedule option, in the Activity Sheet, is similar to the scheduling
option in P6. When you click Schedule, the Schedule window opens
which enables you to select a date (from the Data Date field) and click
Schedule Now to initiate the scheduling process.

You can take any actions within the activity sheet, but the activity
sheet data will be refreshed after schedule completion.

You can use the History Log (available under Menu option) to view a
lot of the actions that have been performed on the activity sheet, as a
part of scheduling.

The following actions will be performed as a part of rescheduling:

- If the activity start, finish, duration, calendar, or predecessor
changes, then Unifier reschedules the successor activities (based on
the data date).

- If the activity is in progress, then Unifier calculates the remaining
duration of the activity (based on the data date) and recalculates the
successor activities start and finish dates (if not started). Unifier also
calculates the remaining duration for all incomplete activities (based
on the data date).

- Unifier moves the activities, or tasks, that are not finished (based on
the data date). This happens even if the activities, or tasks, expected

finish date is earlier than the data date. Unifier retains the relationship
logi for the dependent activities, for example, Unifier recalculates the

start and finish dates for the successor activities.

- Unifier retains the schedule logic. Unifier moves the activities that
are in progress and activities that are incomplete (with finish date
earlier than the data date) to the data date which makes the activities
the first tasks that must be completed. This also moves the start date
of the successor activities to a future date, based on the Lead/Lag
time and relationship.

- Unifier recalculates the Float value for all of the activities, according
to the schedule.

- Unifier recalculates the Critical Path based on the changes in the
duration or dates of the activities. The Critical Path is determined by
the activities that contain a Total Float of zero.

Once Resources or Roles have been assigned to activities you must:
- Enter the progress and then recalculate the assignment costs.

- Use Schedule to calculate both the Remaining units or costs as well
as the At Completion units or costs.

Unifier calculates all of the Remaining units or costs as well as the At
Completion units or costs for the activities, based on the actuals that
were entered for the activities that have progress update.

Unifier calculates all of the costs, based on the new Resources or
Roles assigned to the activities or based on the update of planned
and actual units at the assignment level.
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Create Used for creating the baseline data for the project schedule defined in
Baseline the Activity Sheet.

Once you create the baseline, the Update Baseline option appears in
the Actions drop-down allowing you to update the baseline view with
the latest data and date.

In the Project Baseline view, the window title will show the name that
is given while creating the baseline, and the baseline creation date will
be shown on the right-hand corner. This date retains the date
preference set for the logged in user. Within the Project Baseline view
all the fields are read-only and contain the current project data
including CBS and WBS assignments.

You can view the activity sheet details in the General tab.
The creation date will be populated with the current date.
The baseline name will be defaulted to the project schedule name.

Update Used for updating the baseline data for the project schedule defined in
Baseline the activity sheet. This option becomes available once you create a
baseline.

If there are no baselines, the Update Baseline option will be replaced
by Create Baseline. You can navigate to the Project Baseline view by
clicking the Switch to Project Baseline view link (this function is
similar to the system activity sheet, once the baseline is created). You
can export all the activities using the Menu Options > Export > All
Activities.

Baseline To compare the current project dates and costs with the baseline
Comparison |dates and costs and highlight the cells where:

» The activity progress is not as expected, or
» The activities are delayed (comparing to the baseline).

The link to view the baseline data will be seen only when the baseline
is created successfully.

You can view the schedule comparison of current project data with
baseline data by way of the Menu option > Baseline Comparison.
When you click Baseline Comparison, the Baseline and Current
Project Comparison window opens. This window displays all of the
activities comparing the schedules based planned, actual, remaining
dates, and other dates. Variance will show the number of days the
activity has been delayed, and the number of days the activity has
started ahead or on time.

By default, all of the columns within the current activity sheet will be
compared with the baseline. This is shown as Default view. The View
option enables you to filter the columns that can be seen. You can
filter the columns that can be seen in the Baseline and Current
Project Comparison window by navigating to Views and create a
new view and filtering the columns displayed.
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Link Selected |To link multiple activity sheets. The selected activity sheets will be
Activities linked with the default relationship (Finish-to-Start) if no relationship
exists. See the "Dependencies Tab" topic for more details.

Unlink To unlink multiple activity sheets.
Selected
Activities

Gantt View

The Activity Sheet in Unifier supports the manual Activity Sheets in order to define project
schedules. To be able to view the activities and the relationship between the activities and their
associated resources that define the project schedule, Unifier provides the option to view the
Gantt chart (bar chart) in the manual Activity Sheets.

The Gantt chart provides a representation all of the activities of the project in a time-line view,
the amount of time each activity is expected to take, the time-frame in which an individual task
has to be completed, and the relationship between various activities.

The Gantt chart can be launched from both the System Activity Sheet and the Manual Activity
Sheet (the Gantt option on the toolbar).

Once you click Gantt, the right-pane will show the Gantt representation of the project schedules,
and you will be able to view and perform the following functions:

Show project schedules activities in a Gantt mode.

Zoom in or zoom out to view the details of the activities and links.

Show dependencies between activities (predecessors and so forth).

Show assigned resources by category.

Show percent (%) complete for each activity to monitor the progress of the activities.

Allow changing the activity durations by dragging the bars.

Allow moving activities from one time-frame to another (modifying start and end dates at the
same time).

Allow critical path calculation and viewing activities in the critical path.

Show tooltips for the activity, link, and milestones.

v v v v v v Vv

v v

Increasing duration of activities and moving activities

In Gantt view, you can move the activities (tasks) that do not start ahead of the schedule. The
selected activity start and finish dates are updated along with duration. When you select the
schedule option in the toolbar, the successor activities start and finish date will be updated along
with the current updated activity according to the new data date, and the Gantt view will reflect
the changes in activity start and finish dates. The tooltip will show the updated start and finish
dates, duration, and so forth upon selecting the activities.

You can increase or decrease the duration of the activity using drag-and-drop of the selected
activity. In this scenario, the duration and the Finish Date values will be updated accordingly, for
the selected activity.

The following shows the basic keyboard shortcuts for moving activities:
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» Tab: Tab to the Gantt view and use the arrow keys to navigate to the task you want to move.
You can select multiple tasks and move them together.

» Ctrl + m: Click "Ctrl + m" to enter into the move mode. Use the left arrow and the right arrow
keys to move the activities (tasks) horizontally, and use the up arrow and so keys to move
the task(s) to different rows.

» Enter: Enter to finalize the move and exit move mode, or Esc to cancel and exit move mode

To perform task resize, use:

> Alt+s
> Alt+e

Menu Options

Depending on your permissions, the Menu Options option enables you to:

Option Description

Export > To export the CSV template with activity attributes defined in

Activity uDesigner.

Details All of the columns that are seen in the Activity Sheet will be exported.
The order of columns seen in the CSV template would be the same as
in the activity sheet.

The Required columns will show additional required symbol in the
CSV template.
All of the existing activities details will be exported.

Export > All To include all of the activities.

Activities

Export > All To include all of the assignments.

Assignhments

Import > To import the activities and add new activities if activities do not exist.

Activity See the "About System Activity Sheet" topic for more details.

Details When you select this option, the existing activities in the sheet will be
exported to CSV template.
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CSV Import of | The Activity ID is generated using the activity sequence numbering

Activities setup at properties level, if no value is provided in the Activity ID
column. You can enter only alphanumeric characters in the Activity ID
column.

You cannot leave any of the required field in an activity attributes form
blank. If the CSV file imported does not have data for all of the
required fields in the activity attributes form, then import will fail.

Only columns that are editable can be updated, for the existing
activities. Changes to read-only columns in the CSV file will be
ignored.

The WBS Code and CBS Code for the activities can be added for new
activities. For the existing activities, the WBS Code and CBS Code for
the activities can be updated.

CSV restrictions:

The data elements that are added in the Integration tab must match
the names, or labels, in the exported CSV template.

All of the data elements that are defined in the Integration tab will be
seen as column headers in the CSV template. The order of the
column headers are as they appear in the Integration tab.

If no integration interface is defined, then all of the uuu_P6
pre-defined columns will be seen in the CSV template. In this case,
the Activity ID and Activity Name will be shown as the first two
columns, followed by other uuu_P6 data elements.

The existing rows (activities) must be in the same order as currently
seen in the sheet.

The Activity ID and Activity Name columns are shown as required in
the exported CSV template, along with other required fields.

View History |To open the History Log window. This window contains the following
Log toolbar options:

» Refresh

» Find on Page

This window contains the following columns:
Action

Requestor

Initiated On

Start Date

End Date

Status

v v v v v Vv

Activity Sheet Adding, Copying, Updating, and Deleting

For each activity sheet that you add into the Activity Sheet log, the following columns appear:
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Column

Description

ID <label of the

uuu_P6ActivitylD
>

pre-populated with the sequence number provided in the activity
sheet properties. It should be a unique value. User should be able to
edit the Activity ID or Activity Name columns data.

Note: The task icon should be populated in the ID column for
Activity ID. The color of the task icon should be blue (code
#359DFC) for 'Not Started' activities. Similarly the color of task icon
will be orange (code : # FA9C45) for 'In Progress' activities and
green (code: #02D824) for 'Completed’ activities.

Name <label of
the
uuu_P6ActivityN
ame>

This should show the column as required and user have to specify
the activity name. All the alpha numeric characters are allowed for
the activity name.

Start Date <label
of
uuu_P6StartDate
>

populated with the project start date by default. User can edit the
date by selecting date picker in the column. User can edit the date.

For Activities which are 'In Progress' and 'Completed', Start Date
will be Actual Start Date (uuu_P6ActualStart). For any activities
which are created newly once the project is scheduled on certain
data date. The new activities Start Date will be by default the data
date. User can edit the date before or later but cannot move the date
before project start date. Upon scheduling if the activity is still not
started as per the 'Data Date' then it will be rescheduled to data
date.

Finish Date
<label of
uuu_P6FinishDat
e>

populated with the project start date by default for Activities with
status 'Not Started'. User can edit the date. When the sheet is not
scheduled then the Data Date will be the project start date. For any
activity created after the sheet is scheduled on certain data date
then finish date will be defaulted to start date which is the '‘Data
Date'.

For Activities which are 'In Progress' and 'Completed', Finish Date
will be the date from Data Date plus duration. When the sheet is not
scheduled then the Data Date will be the project start date.

Duration <label
of
uuu_P6Duration
>

populated with duration as 1 day by default for regular
Tasks/Activities and duration as 0 for the milestone activity. Duration
will be updated by means of finish date changes or user can
manually update the duration column. Finish date will be calculated
accordingly.

Activity Status
<label of
uuu_P6Activity St
atus>

This will be default with status 'Not Started' and Activity icon seen
before the activity ID will be in blue color for not started activities.
Explained the color codes in the above case 1) for ID. Activity
Status will be changed to 'In Progress' or 'Completed' based on
Activity actual start date and finish dates and the color of the Activity
ID will be changed accordingly.
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Activity Type

populated with default type i.e., 'Task Dependent'. User can select
other values such as 'Start Milestone' which will automatically the
task to milestone with O duration days and 'Resource Dependent’
which will honor the calendars of the associated resources/roles.
Resource Dependent activities adjust to resource calendars when
resources are assigned.

Planned Start
Date <label of
uuu_P6Planned
Start>

Should be defaulted with Start Date(uuu_P6Start) for the activities
with status 'Not Started'. When Scheduled using project scheduler
all the Start and Planned Start Dates will move to the Current Data
Date if they are past dates.

Planned Finish
Date <label of
uuu_P6Planned
Finish>

Should be defaulted with Finish Date(uuu_PG6Finish) for the activities
with status 'Not Started'. When Scheduled using project scheduler
all the Start and Planned Finish Date will be planned start plus
duration.

The task dependent activities base their duration on the working and
non-working days of the activity calendar, whereas, Resource
Dependent activities base their duration on the working and
non-working days of the assigned resource’s calendar. When
multiple resources are assigned then the Finish Date of the activity
will be based on the time required by the last resource it will take to
finish the same task, based on the resource calendar.

You can edit the duration column in the sheet itself. This field will
allow only integer type data with no negative values.

Note: Calendar selected for each activity will be used to calculate
finish date.

Milestone

When the activity type is selected as 'Milestone' then that activity will
be shown as milestone activity. The duration of milestone activity is
always 0 and user cannot update the duration for milestone activity.
The Activity Status for milestone type activity can have only two
values - 'Not Started' and 'Completed’ . Default value will be 'Not
Started'.

The values for the Start Date, Finish Date, and Duration columns are controlled by an

automatic formula. A change to duration changes finish. A change to Finish changes Duration. A
change to Start changes Finish. These fields also control the display on the Gantt chart. Their

values can also change when the user manipulates the activity bar in the Gantt chart.

Similarly the activity status will be changed into 'In Progress' if the actual start date is entered . In
order to edit the activity %ocomplete (progress) user has enter the actual start date or user
should be able edit activity status and when changed to in progress then actual start date should

be populated with current date and %complete will become editable.
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Similarly when Activity Status is changed to '‘Completed' then actual start and finish date will
populated with current date and % complete will be shown as 100%.

You cannot change the status to 'Not Started' if the actual start date and % complete exists (Any
actual values exists). An error <E1> (Actual values entered must be removed in order to change
the Activity Status to Not Started.) will be thrown and the status will remain as is before updating.

Also when the actual finish date is entered the activity status will be changed to '‘Completed' or
when activity status is changed to completed then actual finish date will be updated.

Activity Sheet Gear Menu

The following explains the gear menu (ﬂ) options when you select a single activity.

Note: You can add, duplicate, copy-paste, and delete the activities by

using the gear menu (ﬂ). Whenever a new activity is created by
default, the Activity ID would be populated and you need to enter all of
the other mandatory data (such as Name and any other required fields)
in order to be able to save the activity details.

Add Activity

This option should not be available if you select more than one activity
row at a time.

When you select this gear menu (ﬂ), while highlighting an activity, a
new row will be inserted below the selected activity.

The Activity ID will have a generated sequence number, and you have
to enter the required fields to save the newly created activity row.

The Cancel and Save options, in the sheet, will be enabled.

Duplicate

You can select an activity and click duplicate to create a new activity with
same information.

The new activity will be created underneath the selected activity.

All of the information related to selected activity (such as dependencies,
WBS, and assignments) will be copied into the new activity.

The Activity ID will have a generated sequence number, as specified in
properties, and you can update the activity information.

Add
Milestone

Use this option to create a new activity which is of activity type 'Start
Milestone'.

The duration of this activity will be always 0.

If you change the Change Start Date, then the Finish Date will also be
updated to the same date as the Start Date and vice versa. The
Duration field cannot be updated, and it is always read-only.

Delete

You can select one or more activities and click Delete to remove the
selected activities. A confirmation message will be displayed and if you
select Yes, then the selected activities along with dependencies,
assignments, and WBS will be removed.
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Copy When you highlight the activities and selects Copy from the gear menu

(ﬂ) option, the Paste gear menu (ﬂ) option will become available.

Selecting Copy copies all of the activities along with dependencies,
assignments, WBS, and actuals, for the selected activities.

The other gear menu (ﬂ) options will be seen after you select Copy.

Paste This gear menu (ﬂ) option will be seen only if the activities are copied

or cut.

When you select Paste, a confirmation message will be displayed and if
you select Yes, then all of the activities along with dependencies,
assignments, WBS, and actuals will be copied into the destination row
selected.

Activity Sheet Start Date, Finish Date, and Duration
The Start Date, Finish Date, and Duration are controlled by an automatic formula.

» A change to duration changes the finish date.
» A change to finish date changes the duration.
» A change to the start date changes the finish date.

The Start Date, Finish Date, and Duration fields also control the display of the task bars in the
Gantt chart view. The Start Date, Finish Date, and Duration values can also change when you
manipulate the activity bar in the Gantt chart.

If you clear the Start Date or Finish Date, then Unifier displays an alert notifying you that the
fields are required. All of the date columns (uuu_P6Start ,uuu_P6Finish, and uuu_P6Duration)
are required columns in the activity sheet. You cannot reset the Start Date or Finish Date, and
Unifier displays an error message if you attempt to do so.

» If you enter a Start Date that is earlier than the Project Schedule Start Date (specified in
the activity sheet properties), then Unifier displays the following message: "<uuu_P6Start>
cannot be earlier than Project Schedule Start Date."

» If you update the Finish Date <uuu_P6Finish> with a date earlier than <uuu_P6Start>, then
Unifier displays the following message: "<uuu_P6Finish> cannot be earlier than
<uuu_P6Start>."

The Duration <uuu_P6Duration> and the Finish Date <uuu_P6Finish> values will change
based on the activity sheet calendar selected. The Activity Calendar drop-down field will show
all of the calendars that are defined at the project-level (which are located, by default, under
Schedule Manager > Custom Calendars).

The Activity Status (uuu_P6ActivityStatus) value will be "Not Started," by default

The Start Date and the Finish Date values will show the Project Schedule Start Date,
specified in properties, by default.

The Activity Type (uuu_P6ActivityType) value will be "Task Dependent,” by default. You can
update the task to "Resource Dependent' or "Milestone."
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Activity Sheet and CSV Template
In this section, the following topics are covered:

» CSV Template for Activity Details

Using CSV Import to Update Activities

New and Existing Activities Through CSV Import

New "In Progress" and "Completed" Activities

Update Activities

Add Start Milestone Activity

Update Existing Activity (Not Started) to Start Milestone

Update Existing Activity (In Progress or Completed) to Start Milestone

v v v v v v Vv

CSV Template for Activity Details

When you export the CSV template file (using Export > Activity Details), the order of the
columns in the CSV template matches the order of the data elements that are added in the
integration phase. You can:

» Add new activities by specifying the details for each row.

» Enter data for all editable data. The values entered in the CSV file will be ignored if that data
element is a formula column in the sheet.

» For the 20.12 release of the Unifier the CSV import does not allow activities with
dependencies and assignments.

During the CSV import (for creating new activities), Unifier performs the following validations:

» Required field validations will be shown, except for the Activity ID which uses the activity

sequence specified in sheet properties. New rows will automatically generate the next
sequence and show it as a new Activity ID.

» Activity Name is shown as required in the exported CSV template. If you do not enter the
Activity Name, then the "required field" error message will be displayed.

» Other than the Activity Name (uuu_P6ActivityName), the uuu_P6 data elements which are
marked as required in the design will not show as required in the exported CSV template, if
there are no default values.

» If you enter the Activity ID value in the CSV template, then this input will have high priority. A
new row will be created using the Activity ID specified in the CSV template. The Activity ID
value column allows alphanumeric values only in the input CSV file.

» If no value is entered, then the Activity ID will take the next auto-sequence number that is
generated. If you provide the Activity ID, then a new activity is created with the value that you
enter (provided that there is no activity with the same ID in the Activity Sheet).

» If not available in the input CSV file, then the default values will be used for the following
columns:

» Start Date

» Finish Dates

» Duration

» Activity Status
» Activity Type
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4

»

» Calendar

If the user did not provide any value for these columns in the CSV file, then by default the
value for the:

» Activity Status (uuu_PG6ActivityStatus) will be: Not Started.

» Start Date will be the project schedule start date specified in the properties.

» Finish Date will be the project schedule start date specified in the properties.

Activity Calendar (uuu_P6ActivityCalendar) will be the default calendar, as the calendar
selected in the activity sheet properties window. If the calendar is specified in the CSV file,

then Unifier validates the calendar name to ensure that it is a custom calendar or a company
calendar.

You must specify the entire path for the WBS Picker (uuu_cmwbs_picker) and CBS Picker
(bitemID) columns in the input CSV file. Check for valid WBS Code and CBS Code when
updating existing activities or importing new activities.

All of the required fields must be entered for the CSV import to be successful.

You will encounter error messages when creating new activities by way of CSV import if:

»

v v v v Vv

You enter a Start Date (uuu_P6Start) that is earlier than the Schedule Start Date
(act_sch_start_date).

You enter a Start Date (uuu_P6Start) that is later than the Finish Date (uuu_P6Finish), and
vice versa.

You enter an Actual Finish Date (uuu_P6ActualFinish) that is earlier than the Actual Start
date (uuu_P6ActualStart).

The above date-related errors will be displayed when you enter input values for the following
date combinations:

uuu_P6PlannedStart, uuu_P6PlannedFinish, and uuu_P6PlannedDuration

uuu_P6Start, uuu_P6Finish, and uuu_P6Duration

uuu_P6RemainingDuration, uuu_P6RemainingEarlyFinish, and uuu_P6RemainingEarlyStart
You enter the Actual Start Date (uuu_P6ActualStart) that is after the current date.

If the Start Date (uuu_P6Start) is provided in the input CSV file, but the Finish Date
(uuu_P6Finish) is not provided in the input CSV file.

If the Finish Date (uuu_P6Finish) is provided in the input CSV file, but the Start Date
(uuu_Pe6Start) is not provided in the input CSV file.

You enter a CBS Code that is currently inactive or does not exist in the Cost Sheet.
You enter a WBS Code that is currently inactive or does not exist in the Project WBS Sheet.
The uuu_P6Start and uuu_p6Finish dates are different for the milestone-type activity.

You will encounter the following validations when creating new activities by way of CSV import:

»
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The Start(uuu_P6Start) alone is provided with the Activity Name. In this case, the activity is
created with default duration 1 and finish (uuu_P6Finish) same as uuu_P6Start.

The Duration (uuu_P6Duration) and Start (uuu_P6Start) are provided. In this case, the
duration will be calculated based on Finish Date and uuu_activity calendar.

The Start (uuu_P6Start) and Finish (uuu_P6Finish) are provided. In this case, the
uuu_P6Duration will be calculated accordingly.

When the Start, Finish, and Duration values are provided. In this case, the Duration will be
calculated based on Start and Finish values.
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» When you enter Actual Finish Date (uuu_P6ActualFinish) without Actual Start Date
(uuu_P6ActualStart). In this case, after the CSV import, the uu_P6ActualStart and
uuu_P6ActualFinish will have the same date, and the uuu_P6ActivityStatus

» will be shown as: Completed
Note: The error validation applies to all dates in the input CSV file.

» When you enter Activity Percent Complete (uuu_P6PercentComplete), you can enter a value
for Performance Percent Complete (uuu_P6PerfPercComplete). In this case, the value must
be between 0 and 100 (zero and one hundred).

» The value of the Duration (uuu_P6Duration) must be entered in the number of days, in the
CSV file. You cannot enter a negative or decimal number.

» You can enter the CBS Code, or WBS Code, for the new activities. When entering the CBS
Code, or WBS Code, you must specify the entire path.

» When you enter the Activity Type as "Start Milestone" (for the new activities in the input CSV
file), the sheet shows the activity as milestone-type with uuu_P6Start and uuu_P6Finish
shows the same date and duration as 0, after a successful import.

» You only enter the uuu_P6Start in the input CSV file for the milestone-type activity.

Using CSV Import to Update Activities

The editable data elements in the activities that exist in the sheet can be updated by using the
CSV import, including:

Activity Name (uuu_P6ActivityName)

Start Date (uuu_P6Start)

Finish Date (uuu_P6Finish)

Duration (uuu_P6Duration)

Activity Status (uuu_P6ActivityStatus)

Percent Complete (uuu_Percent Complete)

v v v v v Vv

When updating through CSV import, Unifier validates the existing activities including:

» Activity Name (uuu_P6ActivityName)
» Start Date (uuu_P6Start)
» Finish Date (uuu_P6Finish)

If the Start Date (uuu_P6Start) exists for an activity and the Duration (uuu_P6Duration) is also
provided in the input CSV file, then Unifier calculates the Finish Date (uuu_P6Finish). In this
case, if Finish Date (uuu_P6Finish) is provided, then Unifier calculates the Duration
(uuu_P6Duration) based on the Finish Date (uuu_P6Finish) and uuu_P6ActivityCalendar.

In the CSV file, for existing activities:

» You cannot change the status of an activity that is "In Progress" to "Not Started."
» The Actual Finish Date cannot be earlier than the Actual Start Date.

» You can update the Percent Complete column. The range of values are 0 to 100 (zero to one
hundred).

» When you enter the Actual Start Date (uuu_P6ActualStart) in the CSV file after the import,
Unifier changes the
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status for that activity from "Not Started" to "In Progress."

You can update an activity with Actual Finish Date (uuu_P6ActualFinish) status as "In
Progress."

» If you update the Actual Finish Date for an activity that has not started (Status + Not Started),
then the Actual Start Date shows the same value as the Actual Finish Date, and the status
shows as "Completed" with the Percent Complete as 100% (one hundred percent).

» If you enter the Percent Complete value without providing an Actual Start Date or an Actual
Finish Date, then Unifier dismisses the Percent Complete value.

» For an activity that is in progress (Status = In Progress), if you update the Percent Complete
value to 100% (one hundred percent), then Unifier updates the Actual Finish Date to the
current date.

» When you update the Actual Start Date and the Actual Finish Date values, the dates cannot
be earlier than the Scheduled Start Date.

» When you update the Actual Start Date and the Actual Finish Date values, the dates cannot
be later than the Current Date.

You can add or update the CBS Code (bitemID) and the WBS Code (uuu_cmwbs_picker).

Unifier changes the Start Date of the successor activities accordingly and based on the
Scheduling.

» You can use reschedule the remaining activities by way of the Schedule option, in the
toolbar.

New and Existing Activities Through CSV Import

For the new activities with uuu_P6ActivityStatus as "Not Started" the following cases apply for
Start, Finish, and Duration:

Note: Invalid values for any of the date and duration columns will result in error.

If duration is provided without a start date, then the duration will be ignored.

If duration is provided with a start date, then the finish date is calculated.

If the start date and the finish date are provided, then duration is calculated.

If duration is provided without a start date or a finish date, then an error message will be
displayed.

If only the duration is provided, then an error message will be displayed.

If only the start date is provided, then an error message will be displayed.

If only the end date is provided, then an error message will be displayed.

If the start date and the duration are provided, then the finish date will be calculated.

If the start date and the finish are provided, then the duration will be calculated.

v v v v Vv

v v v v Vv

84



Note: Any new activities created without any dates entered in the input

CSV file will retain the Project Start Date.

Activity Manager

uuu_P6 |uuu_P6 |uuu_P6 |uuu_P6 |uuu_P6 {uuu_P6 {uuu_P6 {uuu_P6 |uuu_P6 |Behavi
Start Finish |Duratio |Planne |Planne |Planne |[Remain |Remain |Remain |or after
n dStart |dFinish |dDurati [ingEarl |ingEarl |ingDur |Import
on yStart |yFinish |ation
No No No No No No No No No Activity
value |value |value |value |value |value |value |value |value |will be
entere |entere |entere |entere |entere |entere |entere |entere |entere |created
d d d d d d d d d with
default
value
as
project
Start
date
for
Start,
Finish,
Planne
d Start,
Planne
d
Finish,
Remai
ning
EarlySt
art,
Remai
ning
EarlyFi
nish.
Valid Valid Calcula | If not If not Duratio | If not If not Duratio | Activity
date date ted provide | provide |n provide | provide |n will be
entere |>=Proj |fieldif |dthen |dthen |calcula |dthen |dthen |calcula |created
d>= ect not should |should |ted should |should |ted with
Project |Start |provide |[show [show |betwee [show |show |using |duratio
Start Date d same |[same |n same [same |remaini|n
Date and > |explicitl |as P6S |as P6F |planne |as P6S |as P6F |ng start | calcula
uuu_P |y tart inish d start |tart inish and ted
6Start and remaini | based
Planne ng Start
d finish finish |and
Finish
Dates
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uuu_P6 |uuu_P6 |uuu_P6 |uuu_P6 |uuu_P6 |uuu_P6 |uuu_P6 |uuu_P6 |uuu_P6 |Behavi
Start Finish |Duratio |Planne |Planne |Planne |Remain |Remain |Remain |or after
n dStart |dFinish |dDurati |ingEarl |ingEarl [ingDur |Import
on yStart |yFinish |ation
No No Calcula|Valid |Valid |Duratio |No No Duratio | Activity
date date ted date date n date date n will be
entere |entere [fieldif |entere |>= calcula |entere |entere |calcula |created
d, then |d, then [not d>= Project |ted d, then |d, then |ted with
same |[same |provide |Project |Start |betwee |[same |[same |using |duratio
as as d Start Date n as as remaini | n
uuu_P |uuu_P |explicitl | Date and planne |uuu_P |uuu_P |ng start|calcula
6Plann |6Plann |y uuu_P |dstart |6Plann [6Plann |and ted
edStart | edFinis 6Plann |and edStart | edFinis [remaini | based
; h; edStart | Planne |; h; ng Start
otherwi | otherwi d finish | otherwi |otherwi |finish |and
se, se, se, se, Finish
retain |retain retain |retain Dates
the the the the
date date date date
entere |entere entere |entere
d d d d
No No Calcula |No No Not Valid |[Valid |Duratio |Activity
date date ted date date applica | date date n will be
entere |entere [fieldif |entere |entere |ble entere |>= calcula |created
d, then |d, then [not d, then |d, then d>= Project |ted with
same |same |provide |same |same Project |Start |using |duratio
as as d as as Start Date remaini | n
uuu_P |uuu_P |explicitl juuu_P |uuu_P Date and ng start | calcula
6Rema |6Rema |y 6Rema |6Rema uuu_P |and ted
iningEa | iningEa iningEa | iningEa 6Rema |remaini | based
rlyStart | rlyFinis rlyStart | rlyFinis iningSt | ng Start
; h; ; h; art finish |and
otherwi | otherwi otherwi | otherwi Finish
se, se, se, se, Dates
retains |retains retains |retains
the the the the
date date date date
entere |entere entere |entere
d d d d

The validations mentioned above will be applied to the following dates and durations:

uuu_P6PlannedStart
uuu_P6PlannedFinish
uuu_P6PlannedDuration
uuu_P6RemainingDuration
uuu_P6RemainingEarlyFinish

v v v v Vv
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» uuu_P6RemainingEarlyStart

New "In Progress" and "Completed" Activities

Activity Manager

In the input CSV file for a new activity creation, the following applies to:

» Actual Start
» Actual Finish
» Actual Duration

The invalid values for any of the date and duration columns will result in error.

uuu_P6Actua |uuu_P6Act |uuu_P6Actu [uuu_P6Act |uuu_P6Perc |[Behavior

IStart ualFinish alDuration |ivityStatus |entComplete

Valid date Valid date |Not Not Not Activity will be

entered and |entered applicable |applicable |applicable created with

on or after and >= Activity Status as

Project uuu_P6Act "Complete"

Start Date will be 100%
Actual Duration will
be duration

between Actual
Start and Actual
Finish.
uuu_P6Remaining
Start and
uuu_P6Reamining
Finish will not show
any dates as the
activity is complete

If provided, the
remaining dates in
the input CSV file
for completed
activity will be
ignored and
remaining duration
will be O (zero)

Note: If not
provided in the
CSV input file, the
P6Start, P6Finish,
P6PlannedStart,
and
P6PlannedFinish
will be the project
start date;
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uuu_P6Actua
IStart

uuu_P6Act
ualFinish

uuu_P6Actu
alDuration

uuu_P6Act
ivityStatus

uuu_P6Perc
entComplete

Behavior

otherwise, the
user-provided
dates will be
retained.

No date
entered for
uuu_P6Start,
uuu_P6Finis
h and
entered
uuu_P6Actu
alStart

No Value
provided

No Value
provided

No Value
provided

Valid value
entered

Activity will be
created with
Activity Status as
"In Progress"

Activity Percentage
as entered in input
CSV file

Actual Duration will
be 0 (zero), if not
entered

Note: If not
provided in the
CSV input file, the
P6Start, P6Finish,
P6PlannedStart,
and
P6PlannedFinish
will be the project
start date;
otherwise, the
user-provided
dates will be
retained.

The
uuu_P6Remaining
Start will be the
Actual Start Date
and the
uuu_RemainingFini
sh will be the
uuu_P6Remaining
Start +
uuu_P6Remaining
Duration

Valid date
entered for
uuu_P6Start,
uuu_P6Finis
h but no
uuu_P6Actu

Valid date
entered
and on or
after
Project
Schedule

No Value
provided

No Value
provided

No Value
provided

Activity will be
created with
Activity Status as
"Completed"

Actual Start and
Actual Finish Dates
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uuu_P6Actua |uuu_P6Act |uuu_P6Actu |uuu_P6Act |uuu_P6Perc |Behavior

IStart ualFinish alDuration |ivityStatus |entComplete

alStart is Start Date are shown with
provided. same date as

provided in Actual
Finish Date and
Activity %
Complete should
be 100% (one
hundred percent)

Actual Duration will
be duration
between Actual
Start and Actual
Finish

Note: If not
provided in the
CSV input file, the
P6Start, P6Finish,
P6PlannedStart,
and
P6PlannedFinish
will be the project
start date;
otherwise, the
user-provided
dates will be
retained

The
uuu_P6Remaining
Start and
uuu_P6Reamining
Finish will not show
any dates because
the activity is
complete (if
provided in the
input CSV file for
completed activity,
then the dates will
be ignored and
remaining duration
will be 0)

Actual Duration will
be total duration
between Actual
Start and Actual
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uuu_P6Actua
IStart

uuu_P6Act
ualFinish

uuu_P6Actu
alDuration

uuu_P6Act
ivityStatus

uuu_P6Perc
entComplete

Behavior

Finish

No Value
provided

No Value
provided

Valid value
entered for
uuu_P6Act
ual
Duration

No Value
provided

No Value
provided

Activity will be
created with
Activity Status as
"Not Started"

Activity Complete
will be 0% (zero
percent)

Actual Duration
value will be
ignored if entered
without
uuu_P6ActualStart

If the uuu_P6Start
and uuu_P6Actual
Start are both
entered, then those
dates are retained;
otherwise, the
uuu_P6Start and
uuu_P6Finish will
be the project start
date, if it exists

The
uuu_P6PlannedSta
rt will be same as
uuu_P6Start, and
the
uuu_P6PlannedFin
ish will be same as
uuu_P6Finish

The
uuu_P6Remaining
Start and
uuu_P6Remaining
Finish will be the
same as
uuu_P6Start and
uuu_P6Finish

Valid date
entered in
uuu_P6Start
and
uuu_P6Finis

Valid date
entered
and <=
uuu_P6Act

Not
applicable

Not
applicable

Not
applicable

Error message
indicating that the
uuu_P6ActualFinis
h cannot be earlier
than
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uuu_P6Actua
IStart

uuu_P6Act
ualFinish

uuu_P6Actu |uuu_P6Act |uuu_P6Perc
alDuration |ivityStatus |entComplete

Behavior

h

Valid date
entered and
on or after
Project
Schedule
Start Date

ualStart

uuu_P6ActualStart

Update Activities

uuu_P |(uuu_P6 |uuu_P6

6Start |Finish

Planned
Start

uuu_P6 |uuu_P6
Planned | ActualSt
Finish art

uuu_P6 |uuu_P6Re
ActualFi | mainingEa
nish rlyStart

uuu_P6Re
mainingEa
rlyFinish

Behavio
r after
import

For No

No

Not Chang [Change

Starte |e
d
Activit
y:
Valid
date
provid
ed

No No
Change |Value

No No
Value |Change

No
Change

Activity
will be
update
d with
uuu_P6
Start
update
provide
d

uuu_P6
Finish
will be
calculat
ed
based
on Start
and
duratio
n

All
other
dates -
Planne
d Start,
Planne
d Finish
,Remai
ning
Early
Start
and
Remain
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ing
Early
Finish
will be
update
d same
as Start
and
Finish
Activity
status
will be
"Not
Started

No Valid No No No No No No Activity
Chang |date Change |[Change |Value |Value |Change |[Change |will be
e provide update
d d with
uuu_P6
Finish
and
duratio
n will
be
recalcul
ated

All
other
dates -
Planne
d Start,
Planne
d
Finish,
Remain
ing
Early
Start
and
Remain
ing
Early
Finish
will be
update
d same
as Start
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and
Finish
Activity
status
will be
"Not
Started

No No No No Valid No No No Activity
Chang [Chang |Change |Change |Value |Value |Change |Change |will be
e e entered update
d with
uuu_P6
Start

same
as

uuu_P6
ActualS
tart

Planne
d Start
and
Planne
d Finish
will not
be
change
d
Remain
ing
Early
start
will be
same
as
uuu_P6
ActualS
tart and
Remain
ing
Early
Finish
will be
same
as
uuu_P6
Finish
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Activity
status
will be
"In
progres
s
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No No No No No Valid No No Activity
Chang |[Chang |Change |Change |Change |date Change |Change |will be
e e entered update
d with
uuu_P6
Finish
same
as
uuu_P6
ActualF
inish
Planne
d Start
and
Planne
d Finish
will not
be
change
d
Remain
ing
Early
start
and
Finish
will not
show
any
dates
(empty)
as the
activity
is
complet
ed
Activity
status
will be
"Compl
ete”
Activity
percent
will be
100%
(one
hundre
d
percent

)
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Note: When you change any of the above dates, Unifier updates the
dates accordingly. For activities that are marked as "Not Started," the
values for the Start, Finish, PlannedStart, Planned Finish, Remaining

Early Start, and Remaining Early Finish will be the same.

Add Start Milestone Activity

uuu_P6
Start

uuu_P6
Finish

uuu_P6
Duration

Activity
Status

Activity
Type

uuu_P6
Actual St
art

uuu_P6
ActualFi
nish

uuu_P6
Percent
Complet
e

Behavio
r

Valid
date
provide
d

No
value

No
value

No
value

Activity
type is
provide
d

as 'Star
t
Mileston
e

No
value

No
value

No
value

Activity
will be
created
as
mileston
e with
Activity
Type
selected
as "Start
Mileston
e
Activity
Status
will be
"Not
Started"

uuu_P6
Start
and
uuu_P6
Finish
will be
the
same
date as
given in
input
Csv
for
uuu_P6
Start.
uuu_P6
Duration
will be O
(zero)
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uuu_P6
Start

uuu_P6
Finish

uuu_P6
Duration

Activity
Status

Activity
Type

uuu_P6
ActualSt
art

uuu_P6
ActualFi
nish

uuu_P6
Percent
Complet
e

Behavio
r

No
value

Valid
date
provide
d.

Valid
value
provide
d or
not
provide
d.

No
value

Activity
type is
provide
d

as 'Star
t
Mileston
e

No
value

No
value

No
value

Activity
will be
created
as
mileston
e with
Activity
Type
selected
as "Start
Mileston
e
Activity
Status
will be
"Not
Started"

uuu_P6
Start
and
uuu_P6
Finish
will be
the
same as
uuu_P6
Finish
uuu_P6
Duration
will be O
(zero)

No
value

No
value

No
value

Activity
Status
is
provide
d as
‘Not
Started'

Activity
type is
provide
d

as 'Star
t
Mileston
e

No
value

No
value

No
value

Activity
will be
created
as
mileston
e with
Activity
Type
selected
as "Start
Mileston
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uuu_P6
Start

uuu_P6
Finish

uuu_P6
Duration

Activity
Status

Activity
Type

uuu_P6
ActualSt
art

uuu_P6
ActualF
nish

uuu_P6
Percent
Complet
e

Behavio
r

e
Activity
Status
will be
"Not
Started"

uuu_P6
Start
and
uuu_P6
Finish
will be
the
project
schedul
e start
date

uuu_P6
Duration
will be O
(zero)

No
value

No
value

No
value

Activity
Status
is
provide
d as
‘Comple
ted'

Activity
type is
provide
d

as 'Star
t
Mileston
e

No
value

No
value

No
value

Activity
will be
created
as
mileston
e with
Activity
Type
selected
as "Start
Mileston
e
Activity
Status
will be
"Comple
ted"

uuu_P6
Start
and
uuu P6
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uuu_P6
Start

uuu_P6
Finish

uuu_P6
Duration

Activity
Status

Activity
Type

uuu_P6
ActualSt
art

uuu_P6
ActualFi
nish

uuu_P6
Percent
Complet
e

Behavio
r

Finish
will be
the
project
schedul
e start
date

uuu_P6
ActualSt
art and
uuu_P6
ActualFi
nish will
be the
project
schedul
e start
date

uuu_P6
Duration
will be O
(zero)

uuu_P6
Percent
Complet
e will be
100

(one

hundred

)

Valid
date
provide
d

Valid
date
provide
d and
not
same as
uuu_P6
start

Valid
value
provide
d or
not
provide
d.

No
value

Activity
type is
provide
d

as 'Star
t
Mileston
e

No
value

No
value

No
value

Activity
will be
created
as
mileston
e with
Activity
Type
selected
as "Start
Mileston
e
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uuu_P6
Start

uuu_P6
Finish

uuu_P6
Duration

Activity
Status

Activity
Type

uuu_P6
ActualSt
art

uuu_P6
ActualFi
nish

uuu_P6
Percent
Complet
e

Behavio
r

Activity
Status
will be
"Not
Started"

uuu_P6
Start
and
uuu_P6
Finish
will be
the
same
date as
given in
input
Ccsv
for
uuu_P6
Start
uuu_P6
Duration
will be O
(zero)

No
Value

No
Value

Valid
value
provide
d or
not
provide
d.

No
value

Activity
type is
provide
d

as 'Star
t
Mileston
e

No
value

No
value

No
value

Activity
will be
created
as
mileston
e with
Activity
Type
selected
as "Start
Mileston
e
Activity
Status
will be
"Not
Started"

uuu_ P6
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uuu_P6
Start

uuu_P6
Finish

uuu_P6
Duration

Activity
Status

Activity
Type

uuu_P6
ActualSt
art

uuu_P6
ActualFi
nish

uuu_P6
Percent
Complet
e

Behavio
r

Start
and
uuu_P6
Finish
will be
the
same
date as
given
project
schedul
e start
date

uuu_P6
Duration
will be O
(zero)

Valid
date
provide
d

Valid
date
provide
d and
not
same as
uuu_P6
start or
Value
not
provide
d

Valid
value
provide
d or
not
provide
d.

No
value

Activity
type is
provide
d

as 'Star
t
Mileston
e

No
value

No
value

No
value

Error
messag
e

Note:
This is
the
same
case
when
uuu_P6
ActualSt
art and
uuu_P6
ActualFi
nish are
provide
d, and
they are
different
dates.
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uuu_P6
Start

uuu_P6
Finish

uuu_P6
Duration

Activity
Status

Activity
Type

uuu_P6
ActualSt
art

uuu_P6
ActualF
nish

uuu_P6
Percent
Complet
e

Behavio
r

Valid
date
provide
d

Valid
date
provide
dand s
ame as
uuu_P6
start or
Value
not
provide
d

No
value

No
value

Activity
type is
provide
d

as 'Star
t
Mileston
e

Valid
date
provide
d

No
value

No
value

Activity
will be
created
as
mileston
e with
Activity
Type
selected
as "Start
Mileston
e
Activity
Status
will be
'‘Comple
ted'.
uuu_P6
ActualSt
art and
uuu_P6
ActualFi
nish will
be
same
date as
provide
d

uuu_P6
Start
and
uuu_P6
Finish
will be
the
same
date as
uuu_P6
ActualSt
art

uuu_P6
Duration
will be O

102




Activity Manager

uuu_P6
Start

uuu_P6
Finish

uuu_P6
Duration

Activity
Status

Activity
Type

uuu_P6
ActualSt
art

uuu_P6
ActualF
nish

uuu_P6
Percent
Complet
e

Behavio
r

(zero)

uuu_P6
Percent
Complet
e will be
100

(one

hundred

)
Activity
will be
created
as
mileston
e with
Activity
Type
selected
as "Start
Mileston
e
Activity
Status
will be
'‘Comple
ted'.
uuu_P6
ActualSt
art and
uuu_P6
ActualFi
nish will
be
same
date as
provide
d

uuu_P6
Start
and
uuu_P6
Finish
will be
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uuu_P6
Start

uuu_P6
Finish

uuu_P6
Duration

Activity
Status

Activity
Type

uuu_P6
ActualSt
art

uuu_P6
ActualFi
nish

uuu_P6
Percent
Complet

Behavio
r

e

the
same
date as
uuu_P6
ActualSt
art

uuu_P6
Duration
will be 0
(zero)

uuu_P6
Percent
Complet
e will be
100

(one

hundred

)

The following dates will show the same date as uuu_P6Start, uuu_P6Finish and

uuu_P6Duration for the milestone activities:

uuu_P6PlannedStart
uuu_P6PlannedFinish
uuu_P6PlannedDuration
uuu_P6RemainingDuration
uuu_P6RemainingEarlyFinish
uuu_P6RemainingEarlyStart

v v v v v Vv

Update Existing Activity (Not Started) to Start Milestone

uuu_P6 [uuu_P6 |uuu_P6 |Activity |Activity |uuu_P6 |uuu_P6 |uuu_P6 |Behavior
Start Finish |Duratio |Status |Type ActualS |ActualF | Percent

n tart inish Comple

te
Valid |Valid |Valid |Valid |Activity |Not Not Not Activity will be
value |value |value |value |typeis |applica |applica |applica |created as
provide | provide | provide |provide |provide |ble ble ble milestone with
dor |do |dor |do |d Activity Type
not not not not as 'St selected as
provide | provide | provide | provide | art "Start
d. d. d. d. Milesto Milestone™
ne'

Activity Status
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will be "Not
Started"

uuu_P6Start
and
uuu_P6Finish
will be the
same as
project
schedule start
date

uuu_P6Duratio
n will be 0
(zero)

Update Existing Activity (In Progress or Completed) to Start Milestone

uuu_P |uuu_P6 |uuu_P6 |Activity |Activity [uuu_P6 |uuu_P6 |uuu_P6 |Behavior
6Start |Finish |Duratio |Status |Type Actual |Actual |Percen

n Start Finish |tCompl

ete
Valid |Valid |Valid |Valid |Activity |Valid |Valid |Valid |Activity will be
value |value |value |value |typeis |value |value |value |created as
provid |provide |provide | provide | provide | provide | provide | provide | milestone with
ed or |[d or |d or |d or |d d or |d or |d or |Activity Type
not not not not as 'St [not not not selected as "Start
provid |provide |provide | provide |art provide | provide | provide | Milestone™
ed. d. d. d. Milesto |d. d. d. Activity Status
ne’ will be

"Completed"

uuu_P6Start and
uuu_P6Finish will
be the same date
as
uuu_P6ActualSta
rt

uuu_P6Duration
will be O (zero)

uuu_P6ActualSta
rt and
uuu_P6ActualFini
sh will be same
date and
uuu_P6ActualDur
ation will be O
(zero)

uuu_P6PercentC
omplete will be
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100 (one
hundred)

Activity will be
created as
milestone with
Activity Type
selected as "Start
Milestone"

Activity Status
will be
"Completed"

uuu_P6Start and
uuu_P6Finish will
be the same date
as
uuu_P6ActualSta
rt

uuu_P6Duration
will be O (zero)

uuu_P6ActualSta
rt and
uuu_P6ActualFini
sh will be same
date and
uuu_P6ActualDur
ation will be 0
(zero)

uuu_P6PercentC
omplete will be
100 (one
hundred)

Activity Sheet Categories
There are three categories of Activity Sheet:

» Duration Based Schedules
» Cost Loaded Schedules
» Resource Loaded Schedules

Duration Based Schedules

The Duration Based Schedules are schedules in which customer use P6 to capture “durations”
of schedules, only. Users define the CBS structure, Activities, Start / End Dates of Activities,
Durations, etc., but they do not do Resource Assignments, or Cost management in P6.
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Cost Loaded Schedules

Users use P6 to capture CBS structure, activities, durations, resource assignments, as well
costs.

The Activity Sheet, in this case, receives costs as well as dates that come from P6. Users can
directly use Unifier advanced modules (Earned value) for cost comparisons.

Resource Loaded Schedules

Users use P6 to capture “durations” as well as resource assignments (resource units, resource
CBS assignment, resource units spread, actual resources consumed till date, etc.). There are no
costs captured within P6.

The Activity Sheet, in this case, can receive all the resource units and calculate costs using P6
data and rates.

Unifier advanced modules (Earned value) use the calculated costs.
Activity Sheet based on the Schedule type:

» Duration Based Schedules
» The Activity Sheet receives duration based information from P6
» (Not always) The Activity Sheet receives resource assignment related information
» (Not always) The Activity Sheet receives cost related information
» The Activity Sheet is not available as a source for Cash Flow and Cost Sheet
» The Activity Sheet does not have any cost related feature (Assign rate sheet and Recost)
» The Activity Sheet is not available for Earned Value Analysis
» Cost Loaded Schedules
» The Activity Sheet receives the entire duration based information from P6
» The Activity Sheet receives the entire resource assignment related information
» The Activity Sheet receives the entire cost related information
» The Activity Sheet is available as a source for Cash Flow and Cost Sheet
» The Activity Sheet does not have any cost related feature (Assign rate sheet and Recost)
» The Activity Sheet is available for Earned Value Analysis
» Resource Loaded Schedules
» The Activity Sheet receives the entire duration based information from P6
» The Activity Sheet receives the entire resource assignment related information
» (Not always) The Activity Sheet receives the entire cost related information
» The Activity Sheet is available as a source for Cash Flow and Cost Sheet
» The Activity Sheet has all cost related feature (Assign rate sheet and Recost)
» The Activity Sheet is available for Earned Value Anal

Activity Sheet Columns
The Activity Sheet overlay page has columns that provide more details such as:
» Activity ID
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Activity Name

Activity % Complete

Activity Status

Activity Type

The following provides details about the columns:

»
»
»
4

Column name Description

Control This is Unifier specific field and is editable in the tab. This can also
Accounts be updated using import CSV. The accepted values are Yes/No.
(Editable)

Activity ID This is a unique identifier of the activity. In order to identify and

track activities, P6 assigns each activity a unique Activity ID that is
the result of joining the Activity ID Prefix with the Activity ID Suffix
and then adding an Increment value. For example, a prefix of
PROJ-A# combined with a suffix of 2500 and an Increment of 5 will
yield the following activity IDs: PROJ-A#2500, PROJ-A#2505, etc.
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Column name Description
Type Determines how duration and schedule dates are calculated for an
activity.

Task Dependent: Activities are scheduled using the activity's
calendar rather than the calendars of the assigned resources.
Choose task dependent when you want to control the duration of
the activity yourself (that is, no resources are assigned), or when
one or more resources assigned to the same activity can work
according to the same calendar.

For example, you might have an activity to cure concrete; you know
how long the task takes and the addition of resources won't
complete the task any earlier. You would designate this activity as
task dependent.

Resource Dependent: Activities are scheduled using the calendars
of the assigned resources. This type is used when several
resources are assigned to the activity, but they might work
separately. Choose resource dependent when you want to
schedule each resource according to his/her own time schedule, or
resource calendar, not the activity calendar. The assigned resource
availability determines the start and finish dates of the activity.
Typically, you use this type when multiple resources assigned to
the same activity can work independently, or when availability can
affect the activity’s duration.

For example, an activity that requires an Inspector might be
delayed if that resource is assigned to multiple projects or is on
vacation.

Level of Effort: Activities have a duration that is determined by its
dependent activities and are typically administration type. Choose
level of effort to indicate that the activity’s duration depends on its
predecessor and/or successor activities. A level of effort activity is
usually one that is ongoing, such as clerical work, Change
Management, or project management tasks. For example, site
cleanup could be considered a level of effort activity; it occurs
repeatedly and is dependent on the completion of a phase.

Start or Finish Milestone: Milestone activities are zero-duration
without resources, marking a significant project event. Choose start
milestone or finish milestone to indicate that the activity marks the
beginning or end of a major stage in the project. Milestones have
zero duration. A primary resource or an activity owner, and
expenses can be assigned to a milestone. In an office building
addition project, examples of milestones might include Project
Definition Complete, Structure Complete, or End Bidding Process.

CBS Summary: Activities that are used to aggregate date, duration,
and percent complete values for a group of activities that share a
common WBS code level. Choose WBS Summary to indicate that
the activity is a summary-level WBS activity. A WBS Summary
activity represents a group of activities that share a common WBS
level. The summary-level WBS activity enables roll-ups of dates for
the activity group. The duration of a WBS Summary activity extends
from-the start of the earliest activity in-a group-to the finish-of the
latest activity. WBS codes control which activities are part of a 109
WBS Summary activity; P6 incorporates any activities that share a
component of the WBS Summary activity's WBS code into the
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Column name

Description

CBS Code
(Editable)

The CBS code in Unifier to which you want to link an activity,
assignment, or expense. This is and editable field and can also be
updated using import CSV.

Performance %
Complete

The percentage of the activity, or project, planned work that is
currently complete. The Performance % Complete is used to
calculate earned value (EV). It can be based on the activity percent
complete, on the 0/100 rule, on the 50/50 rule, depending on the
technique for computing earned-value percent complete for the
activity's CBS.

Actual Start

If work has started, the date work on the activity, CBS, project, or
EPS began. If resources (labor, non-labor, or material) or roles are
assigned to the activity, the actual start date is the earliest among
all the resource or role assignments. For a CBS, project, or EPS,
the actual start date is the earliest actual start date among all
activities within the CBS, project, or EPS. When P6 is integrated
with Primavera Unifier, the Actual Start date might have been
imported from Primavera Unifier rather than calculated by P6.

Actual Finish The date on which the item, such as an activity, assignment, or
project, is complete. When P6 is integrated with Primavera Unifier,
the Actual Finish date might have been imported from Primavera
Unifier rather than calculated by P6.

Planned The expected amount of time required to complete an activity. The

Duration planned working time is calculated in P6 using the activity's

calendar. The duration is measured from the activity's planned start
date to its planned finish date.

Actual Duration

The total working time from the activity Actual Start date to the
Actual Finish date for completed activities, or the total working time
from the Actual Start date to the data date for in-progress activities.
The actual working time is computed using the activity's calendar.

Remaining
Duration

The total working time from the activity remaining start date to the
remaining finish date.The remaining working time is calculated
using the activity calendar. Before the activity is started, the
remaining duration is the same as the planned duration. After the
activity is completed the remaining duration is zero.

At Completion
Duration

The total working time from the activity's current start date to the
current finish date. The current start date is the planned start date
until the activity is started, and then it is the actual start date. The
current finish date is the activity planned finish date while the
activity is not started, the remaining finish date while the activity is
in progress, and the actual finish date once the activity is
completed. The total working time is calculated using the activity's
calendar.
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Column name Description

Activity Planned Total Units
Attributes (Units) | The planned units of work for the activity.
Actual Total Units

The exact number of units that have been expended on the
selected activity.

Remaining Total Units

The remaining units of work to be performed by the resource on the
activity. Calculated as Planned Units minus Actual Units.

At Completion Total Units

The sum of the actual units and remaining units for the resource
assignment on the activity. Calculated as Actual Units plus
Remaining Units.

Activity Planned Total Cost

Attributes (Cost) | The expected total cost of the activity, consolidating costs of all
assignments.

Actual Total Cost

The actual non-overtime plus overtime cost for all the resource
assignments of the activity.

Remaining Total Cost
The remaining cost of all the resource assignments for the activity.
At Completion Total Cost

The sum of the actual costs plus remaining costs for the resource
assignment on the activity. Calculated as Actual Costs plus
Remaining Costs.
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Column name

Description

Activity
Attributes
(Earned Value)

112

Planned Value

The portion of the baseline total cost of the activity or project that is
scheduled to be completed as of the project data date.

Earned Value

The portion of the project baseline total cost of an activity or all
activities in the project that are actually completed as of the project
data date. Budget at completion is calculated from the project
baseline. Calculated as Budget At Completion multiplied by
Performance Percent Complete. The method for computing
performance percent complete depends on the Earned Value
technique selected for the activity CS.

Estimate to Complete

The estimated cost to complete the activity, CBS, or project.
Calculated as Remaining Total Cost for the activity or the
Performance Factor multiplied by (Budget At Completion minus
Earned Value), depending on the Earned Value technique selected
for the activity CBS (calculated from the primary baseline). Budget
at completion is calculated from the project baseline.

Schedule Performance Index

A measure of the work accomplished as a percentage of the work
scheduled. Schedule Performance Index indicates whether you are
meeting earned and planned values within your schedule. A value
less than 1 indicates that less work was performed than was
scheduled. Calculated as Earned Value divided by Planned Value.
Cost Performance Index

A measure of the value of work accomplished as a percentage of
the actual costs. Cost Performance Index (CPI) indicates whether
you have spent money over the budget to date. On the My
Preferences page, you can set performance thresholds for CPI
calculated values to determine whether you need to take corrective
action. Calculated as Earned Value Cost divided by Actual Cost. A
value less than 1 indicates that the actual cost has exceeded the
planned value.

Cost Schedule Index
Product of Schedule Performance Index & Cost Schedule Index
Schedule Variance

The measure of schedule performance on a project. A negative
value indicates that less work was actually performed than was
scheduled. Calculated as Earned Value minus Planned Value.

Cost Variance

A measure of cost performance on an activity, CBS, or project. A
negative value indicates that the actual cost has exceeded the
planned value. Calculated as Earned Value minus Actual Cost.

To Complete Performance Index

The ratio of the remaining work to the remaining funds. Calculated
as (Budget at Completion minus Earned Value) divided by
(Estimate at Completion minus Actual Units or Cost).

Estimate at Completion
The expected total cost of a schedule activity, a work breakdown




Activity Sheet Dates
Activities with Status: Not Started

Activity Manager

Note: For Not Started activities, the dates are always the same for
Start, Finish, Planned Start, Planned Finish, Remaining Early Start, and
Remaining Early Finish dates.

Start Finish |Planned |Planne |Actual |Actual Actual |Remaining |Remaining
Start d Finish | Start Duration |Finish |Early Start |Early Finish

Defaul | Default|Default |Default |Not Not Not Default to |Default to
tto to to Start |to applica|applicab | applica | Start Date. |Finish
Project | Project | Date. Finish |ble. le. ble. Can be Date.
Sched |Sched |can be |Date. modified. | Calculated
ule ule modifie |Calcula based on
Start | Start g, ted Remaining
Date | Date based Start date +
gr 'E[O gr 'E[O on duration.
aa |oaa Planne Can be
Date if | Date if d Start modified.
the the date+
Project | Project duratio
Sched |Sched n
ule ule
Start | Start %‘rg&igg
Date |Date d
moved | moved '
forwar |forwar
d. d.
Can Can
modify | modify
the the
date. |date.

Calcul

ated

based

on

start

date +

duratio

n.

Activities with Status: In Progress

Note: For In Progress activities, the Start and Actual Start would always
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be the same, and the Remaining Early Start will be >= Actual Start Date.

Start Finish |Planned |Planne |Actual |Actual Actual |Remaining |Remaining
Start d Finish | Start Duration |Finish |Early Start |Early Finish
Defaul |Start |Planned |Calcula |Can In the Not Default to |Calculated
tto Date + | Start ted enter |attribute |applica |Start or based on
Actual |Durati |Date based |date in |form ble. Actual Remaining
Start |on. will not |on the and Start if not | Start Date
Date |can be Planne |colum |activity scheduled. |+ Duration
Can modify updated |d Start |n>= |sheet, Can be If
modify [the ~ |tolatest \date + |project |this field updated to | Scheduled,
the date SCheduI duratIO SChed IS |ater date then
date. |>= edata |n. ule read-onl by means |Remaining
If Start |Start |dates. | canbe |Start |y. The of the Finish will
date is |Date. |Can be |modifie |date. |value for actual start | be Data
modifi modifie |d. Start |this field date or Date +
ed d will be | will be start date. |Remaining
then manuall update | Updated r Duration.
update y. d gi:gfion scheduled, |Can be
Actual accord calculat then modified >=
Start ingly to od Remaining |Remaining
date align Start Date | Start.
and with | between will be
vice éctual étcetllrjtal Data Date.
tart
versa. Date. Date Can be
Can c and modified >
be ban Duration = Data
update € Date.
d by update |-
means d by
Of the means
update of
of Activity
Actual Status.
Start
Date.
Activities with Status: Complete
Start Finish |Planned |Planne |Actual |Actual Actual |Remaining |Remaining
Start d Finish | Start Duration |Finish |Early Start |Early Finish
Defaul |Default|Planned | Calcula | Can In the Not Will be Will be
tto to Start ted enter |attribute |applica|empty as |empty as
Actual |Actual |Date based |date in |form ble. the activity |the activity
Start |Finish |will not |on the and is is
Date |Date. |be Planne |colum |activity completed. | completed.
updated |d Start |n>= |sheet,
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Start Finish |Planned |Planne |Actual |Actual Actual |Remaining |Remaining
Start d Finish | Start Duration |Finish |Early Start |Early Finish

Can Can . Date + |project |this field

modify | modify |can pe |Duratio |sched |is

the the modifie |N- ule read-onl

date. |date d Can be |start |y. The

If Start | >= manuall | modifie |date. |value for

Date iS Start y d Can th|3 f|e|d

modifi | Date. be will be

ed update |updated

then dby |asthe

update means | Duration

Actual of calculat

Start Activity | €d

Date Status. | Petween

and ACtual

vice Start

versa. Date

Can and
Actual

be Finish

update '

d by

means

of the

update

of

Actual

Start

Date.

General Tab

The General tab displays the attributes for the selected activity in groups:

WBS Attributes

Activity Attributes (General)
Activity Attributes (Schedule)
Activity Attributes (Units)

Activity Attributes (Cost)

Activity Attributes (Earned Value)

See Attributes (on page 229) for details.

v v v v v Vv
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By default, the General tab details will be in the dock, at the bottom the activity log. You can see
the General tab by selecting the Activity ID column and using the split pane icon (the three
horizontal dots). The General tab will be seen for the activities that are created without attribute
form defined, and it will show the standard data elements (starting with uuu_P6). The order and
behavior of data elements are based on the design, except for the uuu_P6 element which has a
default behavior in the attribute form.

Use the General tab to view the activity details of the new activities created, or updated.

The WBS Picker and CBS Code, when added to the activity attribute form, are shown as
columns. You can select the WBS codes and CBS codes that can be assigned to the activities.

When you edit the activity attribute in the General tab, the Cancel and Save options will be
made available. You must save the edited data in order to move to the sheet. Edited data will
not be save, if you do not save the edited content, in the General tab.

You can switch between tabs before saving the information across the tabs.

Actual Dates

» An activity progress <uuu_P6PercentComplete> will be editable once the
<uuu_P6ActualStart> has been entered, or the <uuu_P6ActivityStatus> has changed to 'In
Progress'. If <uuu_P6ActualStart> has been entered, then the uuu_P6ActivityStatus will be
changed from 'Not Started' to 'In Progress' and vice versa, automatically.

» When <uuu_P6ActivityStatus> has changed from ' In Progress' to 'Completed' the
<uuu_P6ActualFinish> will be populated with current date and vice versa.

» When <uuu_P6ActivityStatus> has changed from ' Not Started' to '‘Completed' the
<uuu_P6ActualStart> and <uuu_P6ActualFinish> will be populated with current date.

» Actual Start Date <uuu_P6ActualStart> cannot be entered in future date (cannot be different
from the current date).

» Actual Finish Date <uuu_P6ActualFinish> cannot be entered in future date (cannot be
different from the current date).

Dependencies Tab
Use the Dependencies tab to:

a) Link one or more activities.
b) Define relationship between activities.
You can also enter predecessor dependencies between a selected activity and another activity.

The dependency relation is used to automatically shift activity dates forward or backwards based
on changes to the predecessor. This is also reflected in the Gantt chart.

In the predecessor section, you can add predecessor activities, in bulk, by using the Add option
in the predecessor section. In the successors section, you can add the successors, in bulk, to a
selected activity by using the Add option in successors section.
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Predecessors Columns

Column Description
Name
ID The ID column displays the activity ID of the predecessor for the current
activity. The ID column is added by way of the Add option, in the toolbar.
This field is editable, and you can change the activity ID. If you enter a
value in the ID column in the grid and that activity ID does not exist, then
Unifier displays and error message. You can enter alphanumeric
characters in the ID column, only.
Activity The value in the Activity Name column is populated with the activity ID
Name that was entered. This is a read-only column in the grid, and you cannot
enter or edit the Activity Name column value.
Relationshi | The following relationship types are supported:
p » Finish-to-Start
» Finish-to-Finish
» Start-to-Finish
» Start-to-Start
Lead/Lag The Lead/Lag (days) column enables you to specify the number of days
(days) the activity can start ahead (lead), or delayed (lag), by mentioning the

number of lead or lag days. This is an integer type field which allows
both the negative and the positive integers.

The lead days will be provided by specifying the negative number, and
the lag days can be provided by specifying positive number (specifying
the days that the successor activity can be delayed to start).

When you click Add, a picker with a list of all activities that were defined
in the activity sheet will be displayed. This list does not include activities
which are successors and current activity. Can select one or multiple
activities as predecessors. The default relationship shown in the grid is
Finish to Start once user adds the activities.

User should be able to select the relationship between the predecessor
and current activity by choosing the relationship drop-down and lead/lag
days.

The same functionality as seen while adding predecessors is applicable
in the case of adding successors in the Dependencies tab.

Successors Columns

Column Description
Name
ID The activity ID which will be the predecessor for the current activity. This

is added via the Add action on the tool bar.
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Relationshi | The following relationship types are supported:
p Finish-to-Start

Finish-to-Finish

Start-to-Finish

Start-to-Start

Lead/Lag The Lead/Lag (days) column enables you to specify the number of days
(days) the activity can start ahead (lead), or delayed (lag), by mentioning the
number of lead or lag days. This is an integer type field which allows
both the negative and the positive integers.

The lead days will be provided by specifying the negative number, and
the lag days can be provided by specifying positive number (specifying
the days that the successor activity can be delayed to start).

When you click Add, a picker with a list of all activities that were defined
in the activity sheet will be displayed. This list does not include activities
which are successors and current activity. Can select one or multiple
activities as predecessors. The default relationship shown in the grid is
Finish to Start once user adds the activities.

User should be able to select the relationship between the predecessor
and current activity by choosing the relationship drop-down and lead/lag
days.

The same functionality as seen while adding predecessors is applicable
in the case of adding successors in the Dependencies tab.

Assigning WBS Code to Selected Activities

Once the activities are created in the sheet, you can assign a WBS Code (Select WBS Code
window) to a selected activity by using the WBS picker. By default, all of the activities created in
the manual activity sheet will show the project-level WBS row as assigned WBS. You can select
a single WBS Code from the hierarchy. You can bulk assign the same WBS Code to multiple
activities, through drag-and-drop at the cell level within the activity sheet.

Bulk Assigning WBS Code to Different Activities

You can highlight the WBS Code column for multiple activities and assign the same code to all
of the selected activity sheet, by using the WBS picker.

Link Activities (Adding Dependencies)

You can link multiple activity sheets by selecting one or more activity sheets, right-click, and
selecting the Link Selected Activities option. The selected activity sheets will be linked with the
default relationship (Finish-to-Start) if no relationship exists.
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The Predecessor and Successor columns in the Activity Sheet log show the activity sheets
that are linked based on the Finish-to-Start relationship of the selected activity sheets. This
setup will also reflect in the Gantt Chart.

Similarly, you can unlink the selected activity sheets by highlighting one or more activity sheets,
right-click, and selecting the Unlink Selected Activities option. The Unlink Selected Activities
option will be available only if the selected activity sheets are linked.

When you link multiple activity sheets (using the Link Selected Activities option):

» If the same relationship exists for all of the selected activity sheets, then Unifier will not
update any values.

» If the predecessor activity has been already added as successor for the highlighted row, then
Unifier will display an error message.

» If the successor activity has been already added as predecessor for the highlighted row, then
Unifier will display an error message.

» If you select a single activity sheet and try to link (using the Link Selected Activities option
from Actions menu), then Unifier will display an error message.

Assignments Tab

The Assignments tab displays the resources and roles assigned to the activity selected in the
main grid. The layout displays the following columns:

Resource Name
Role Name

Rate Source

CBS Code

Planned Units
Actual Units
Remaining Units
At Completion Units
Price per Unit
Planned Cost
Actual Cost
Remaining Cost

At Completion Cost

VvV VvV vV vV vV vV VvV VvV VvV vV v v Vv

Assign Price/Unit

To override the price or unit. The Planning and Actuals will be fetched from corresponding Rate
Sheet or Overridden Price/Unit from override action. Whenever a different Rate is assigned to a
Resource, system will display the following alert message: Perform Recost to see updated costs.
The gear menu (ﬂ') options in the Assignments tab are:

» View Spread
» Assign CBS
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» Assign Rate Source

Select View Spread to view the spread of costs or units for a role or resource assignment in a
separate pop-up window.
The gear menu (ﬂ) options in the Assignments tab vary depending on the project type.
There is only one option for Cost-loaded and Schedule-based projects:
» View Assignment Spread
The following options are available for the Resource-loaded projects:
» View Assignment Spread
» Assign CBS
» Assign Rate Source
In the Type list, select Cost or Units. Column headings change accordingly.
In the Frequency list, change the granularity level of the spread to Week, Month, or Year.
In the Assignment Spread dialog, view values in the following columns:

» Period Start

Planned Cost (or Units)
Actual Cost (or Units)

At Completion Cost (or Units)

4
4
4
» Remaining Cost (or Units)
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Use this option to assign a CBS code to a resource and/or role. Select Assignh CBS and select a
code in the CBS field, and then click OK.

Select Assign Rate Source to assign a rate source to an assignment.
The Rate Source drop-down list has the following options:

» Resource (default)

» Role

» Override

Select an option.

Unifier updates the rates for price/unit of each assignment after retrieving them from the
corresponding source fields in the rate sheets as follows:

» If the rate source is Resource, the data is fetched from the Resource Rate Sheet.
» If the rate source is Role, the data is fetched from the Role Rate Sheet.
» If the rate source is Override, the Price/Unit data is not refreshed.

In this case, you must manually specify the value. To do so, click Rate Source and follow the
prompts. The Assign Rate Source is only applicable for Resource-loaded projects.

» Select Override and click OK.
» The gear menu (ﬂ') displays an additional option for Override. Click the gear menu

(ﬂ) and select Assign Price/Unit.
» Modify the existing rate and click OK.

When finished, click OK.
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Unifier rolls up the assignment values to calculate values at the activity level.

Audit Log Tab

The Audit Log tab displays the audit details at the activity level in the following columns:
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Date

Event
Action
Field Name
Old Value
New Value
User Name
Proxy User

v vV v vV vV v v Vv

CSV Import and Audit Log

For the existing activities, the Audit Log tab displays the entries for the fields that have been
updated by way of CSV import as follows:

» Date

Populated with date and time for the event.
» Event

The value is "Import,” in the case of adding or updating the activity.
» Action

For the new activities, the value is populated with, "Create." For the existing activities, the
value is populated with, "Update."

» Field Name

Populated with the field that was updated.
» Old Value

Populated with the existing value in case of an update.
» New Value

Populated with the new value.

Note: If a new activity is created by way of the CSV import, then the
Audit Log provides an entry.
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Manual Activity Sheets (Import of MS Project or P6 Schedules)

You can use data from (import) P6 or Microsoft Project in Unifier project, including creating or
managing activity, activity schedules, dependencies, and resource assignments.

Note: If you select multiple activity sheet or System Activity Sheet, then
import options will not be seen.

You also have the ability to import project schedules that are maintained in P6 or Microsoft
Project (.mpp or .xml) in the manual activity sheets. You can create a project schedule in Unifier
(manual activity sheet) and bring data by way of importing a Microsoft Project file (.mpp). After a
successful import, you can see that all of the activities, their dependencies, and assignments are
created in a new activity sheet.

You can create a project schedule in Unifier (a manual activity sheet) and bring data by way of
importing a P6 (.xml). After a successful import, you can see that all of the activities, their
dependencies, and assignments are created in a new activity sheet.

The imported data can be further used in the earned value calculations, cash flow management,
and so forth.

For the manual activity sheets, Unifier supports:
» Integrating with P6 or Microsoft Project to be able to import activities and related data to a

specified activity sheet.

» Adding new activities in an activity sheet, through P6 or Microsoft Project import, with no
additional setups.

Synchronizing matching activities, through P6 or Microsoft Project import.
Integrating with P6 or Microsoft Project out of the box (OOB), without any data mapping.

Importing activity schedules, dependencies, and resource assignments, through P6 or
Microsoft Project import.

» Updating the activities that are created, through P6 or Microsoft Project import.

When you access the Activity Sheets log (Activity Sheet node> Activity Sheets log), you can
click the Actions toolbar option and get data from P6 or Microsoft Project import.

» Actions > Import > From P6 XML
» Actions > Import > From Microsoft Project

You can export the XML version of an existing Unifier project schedule (of an activity sheet) into
other sources, such as MS project or P6 schedules.

The options above are available for the users who have the Create permission, at the activity
sheet node level.

Note: The gear menu displays the same options, for any selected
activity sheet.

The History tab contains the details for any import that you have initiated.

After a successful import, a new activity sheet will be created.
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The import will remove any existing data in the activity sheet. Only activities for the selected
activity sheet will be removed. The WBS associated to the activity sheet will not be removed.

The following file formats are supported, for the file upload:

» Microsoft Project (2007/2010/2013/2016/2019) schedule (.mpp format)
» P6 schedule (.xml format)

The following objects are supported:

» Activity Sheet properties

The project schedule start date and calendar. If there is no calendar, then the default project
or shell calendar is used, and the earliest start date (across all of the activities in the sheet)
will be the project schedule start date.

» Activity Sheet

The activity attributes (uuu_P6 elements only), Dependencies (Predecessors and
Successors), and Resource Assignments (units and costs).

» WBS Sheet
All of the WBS attributes (WBS Code, WBS Name, and other default mapped attributes).
» Master Rate Sheet:
Resources/Roles (along with calendars). The Resource ID and Name/Role ID and Name,
Currency, Calendar, Default Units/time, type of resource, and standard rates.
You can modify an existing activity sheet data only if you have the Edit permission.
The following data from the source file will be copied into an activity sheet:

Activity Sheet properties
Activity details

For Not Started, In Progress, and Completed activities: All uuu_P6 activity data elements and
other system defined data elements like uuu_successor, uuu_predecessor, and so forth.

For In Progress and Completed activities: The uuu_P6percentcomplete will be updated.
» WBS Summaries

Project WBS Sheet will be updated with the Summary tasks as WBS items, if no data exists.
» Dependencies

All the relationships between the activities will be retained during the import. Those
dependencies will be imported as successors and predecessors.

» Assigned Resources/Roles
Master Rate Sheet will be updated with adding new resources and roles.

» Resource Assignments
All the Resources/Roles assigned in the project schedule will be imported, along with units
and costs. All activities will show the rolled-up costs and units when there are assignments.

In case of errors, Unifier aborts the importing process. The History tab will contain details about
failed or successful imports.
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Import Activities by way of Microsoft Project

Activities are uniquely identified within one Microsoft Project file by the Unique ID (<UID>). The
following applies when importing activities from Microsoft Project:

» New activities inserted
» A new activity row will be created for each <UID>
» The <ID> will be copied into Activity ID (uuu_P6ActivitylD)
» The <Name> will be the Activity Name (uuu_P6ActivityName).
» The Unique ID (<UID>) will be copied from the corresponding Microsoft Project activities.
» All other default (mapped) elements will be copied into the new activity.
» Dependencies of new activities

» Dependencies will be added for the new activities (if dependencies exist) using elements
within the PredecessorLink tags.

» WBS summaries for new activities

»  The WBS will be identified using the hierarchy provided within the <WBS> tag in the .xml
file.

» This is WBS Code field in the source (the .mpp file for each activity in the Advanced tab).

» All the summary tasks (in .mpp file) will be created as WBS in project WBS Sheet, if they
do not exist.

» Resource assignments for new activities

» When a new activity is created, all assignments for that activity will be created. If the
resource does not exist (resource ID does not exist), then a new resource will be created
in Master Rate Sheet, with resource hame from Microsoft Project as resource ID and
Name. If the resource exists and matches the source, then the resource will not be
updated, and the existing resource will be assigned to the activity. If the resource exists
but does not match the resource (resource ID is different from the ID in the source
Microsoft Project file), then you must create a new resource with resource ID and Name
identical to the source file.

Also, when importing the project schedule by using Microsoft Project (.mpp), for:

» Activities with start date earlier than the project schedule start date:

The project schedule start date will show the earliest start date across all the activities and
the activities will be imported according to the schedule specified in the import file. In case
the project schedule start date is selected (from shell attribute), then Unifier displays: Import
has failed as activities have <label of uuu_P6start> earlier than project schedule start date
for the selected Activity Sheet. This takes place when importing the project schedule with
activities earlier than project start date. Similarly, when the required field values are missing
in the source Microsoft Project file, then Unifier displays: Could not add Activity <Activity ID>
as <Field1> is required.

» WBS Code import:

The summary tasks in Microsoft Project will be imported as a WBS summaries into the
project WBS Sheet. All of the summaries with hierarchy will be imported as a WBS
hierarchies into the Project WBS Sheet. Only the WBS Code and the Name will be populated
for the WBS Summaries.
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Note: Ensure that you add a new WBS Code and associate the activity, or task, with the
existing WBS Code if there is an existing WBS Code (with the same WBS name but different
WBS code), when importing the summary tasks as WBS codes.

If the WBS Code exists in the project WBS Sheet, then create an activity with the WBS
Picker populating the WBS Code. The Used By field, in the project WBS Sheet, will be
populated with Activity Sheet that the WBS Code is associated with. Similarly, when the
required fields are missing in the source Microsoft Project file Unifier displays the message:
Could not add WBS <WBS Code> as <Field1> is required.

Resources that do not exist in the Master Rate Sheet in Unifier:
Unifier matches the resources by resource name, in the Master Rate Sheet.

If the resource is not found in the Master Rate Sheet, then the resources will be added
with the resource ID and Name because the resource name (from the Microsoft Project),
and the source are selected as user-defined (User Defined).

If the resource already exists in the Master Rate Sheet with the same name, but the ID
does not match, then you must create a new resource.

The default values will be used for the resources that you create.

If the resource has a required field that is not available in the source Microsoft Project file,
then Unifier displays the message: Could not add resource <Resource ID> as <Field1> is
required.

Roles:
The Microsoft project resource assignment does not specify a role.
Project calendar in the Microsoft Project does not match with the Activity Sheet:

Use the project schedule calendar that is selected for the Activity Sheet. All of the imported
activities will be adjusted based on the calendar in the project schedule start date.

Resource calendar in the Microsoft Project does not match with any calendars available in
Standards and Libraries:

Use the company calendar for the resources that have calendar that do not match. All of the
imported resource assignments will be adjusted to the company calendar.

Currencies and formats:

All costs will be converted to the shell currency, from the source file, for the activities and
assignments.

Constraints and dependencies:

The import process will match the dependencies based on the connected activities. If a
dependency is matched, then all properties of the dependency will be updated from the
Microsoft Project file, based the mapping described earlier. Activities will be moved to retain
the new dependency values. By default, all of the activities will have the "As Soon As
Possible" constraint even if there are different constraints set for the activities.

Impact on milestone activities:

You can import the milestone activities into the activity sheet. All the activities that are
created as milestone will have activity type selected as: Start Milestone.

Required fields not part of Import file:

127



Unifier Earned Value Management User Guide

If there are any required elements in the activity attributes, and the imported file does not
have any values for the required elements, Unifier will display the following message in the
History tab, and the import will fail: <field name> is a required field in activity details. Or <field
name> is a required field in WBS details.

Note: The above condition applies to all of the required elements (in the WBS Sheet and
Master Rate Sheet) when importing the WBS Summaries and Resources.

» Rollback on error:

The various conditions (such as resources are not matched or no data for mandatory fields)
described above can cause the import process to abort. In such cases, all of the changes
made in the project schedule, by the import, will be reverted.

The errors and warnings will be reported in the History tab (log) for various miscellaneous
conditions such as: Activities with start date that is beyond the project start date, and the
activity sheet has "From Shell" attribute that is selected for project start date.

You can import the schedule irrespective of the status of the activity sheet.

Supported Objects for P6 XML Import

The following table lists the supported objects when you are importing a P6 XML file in order to
create a project schedule.

Note that the activity sheet selected will have the project schedule start date updated from the
source, if there are activities with the start date earlier than the project schedule start date. In
this case, the earliest start date will be the project schedule start date. If the project schedule
start date is set to begin from the project start date defined in shell attributes, in the case of
activities earlier than schedule start date, then Unifier displays an error message.

Business Objects Description Unifier

Project Information This is the highest level of With the import of P6 XML, the

(Project) information related to the following project properties will
project schedule. be added to the activity sheet

properties: Project Schedule
Start Date, Calendar (if exists
in Unifier; otherwise, the
default project or shell
calendar will be used), and

Data Date.
Activity (Elements This is the parent node to all | The import process will map
under Activity) child business objects non-complex type child
connected to any activity. elements from the Activity to

Unifier Activity data elements.

Relationship (Elements | The <Relationship> element | The import process will only
under Relationship) exists directly under the look at predecessor and
project. It stores predecessor |successor relationships

and successor relationships | between activities in the same
between activities. It also project.

supports relationships
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Business Objects

Description

Unifier

between activities from
different projects.

WBS (Elements under
WBS)

The WBS element wraps one
or more activities. WBS
elements can itself contain
other WBS elements.

The import process will map
all WBS Summaries from
source to Unifier WBS data
elements in WBS Sheet.

Assignment (Elements
under Assignment)

The <Assignment> element is
a child of <Activity>.

The import process will import
all assignments for each task.
Assignment properties will be
imported based upon data

mapping.

Resources/Roles
(Elements under
Resource/Role tags)

The resources assigned to
the activities under
assignments tab.

The import process will map
all resources/roles from
source to Unifier
resources/role in Master Rate
Sheet. If not available then

new resources will be created.

Exporting Selected Activity Sheet to XML

You can select an activity sheet and export the contents using an XML format.

The generated XML file is compatible with the Microsoft Project schema definition, and it will be
readable by Microsoft Project. The Resource and Assignment information will be included in
the output if you select to export the Resource and Assignment in the setup options. The
following actions take place during the exporting process in order to generate the XML file:

» Generating mandatory project shell data. This includes populating elements under Project
with default values. The default values can be generated by saving an empty project to XML
in Microsoft Project. Certain elements such as Start, Finish, Project Name, and Currency
Code can be obtained from the shell.

» Populating the calendar information based on the shell calendar assigned to the selected

activity sheet.

» Creating Resource elements based on all resources in the Master Rate Sheet which are

created manually and currently assigned to activities.

Creating resource calendars based on the calendar assigned to the resources.

Creating activities and populate values for the default elements and create dependencies
and assignments referencing activity UID.

Activity Picker

The activity picker in business process and attribute forms allows you to choose an activity from
a selected project. The activity picker supports reverse auto-population for multiple P6 Projects.
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Selecting a project:

1) Inthe View drop-down list, select a project. If there are a large number of projects, use
Search or Find on Page to quickly locate the project.

2) Highlight a project on the Activity Picker log and click Select.

Activity Sheet User Defined Report (UDR)

You can create User Defined Reports (UDRs) from the data present in your Activity Sheet.

The Create User-defined Report window enables you to define the following fields for your UDR
(template or individual reports):

» Data Type
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» Element

» Report Type
» Tabular
» Cross Tab
» Summary
» Alert

» Access Type

Note: The same fields will be available for permission-based data
sources.

The elements (Currency/Decimal), in OOTB Activity Sheet along with any user-defined column
will be available as DEs for your report.

Note: Only the data elements available in the Activity Sheet will be
available in the respective UDR.

Data for Reports can be imported to Unifier form the CSV file. You can import data for Date
Field, only (if it is in the same format as in the Unifier client). In case where Unifier client is using
mm/dd/yyy, you have to create custom settings in the CSV file.

In Excel, add the new custom formats as follows:

1) Select the cell.
2) Right Click and go to format cells.
3) Click Number Tab and Select Custom category and you can give "mm/dd/yyyy" format.

Roll Up Activity Sheet to Cost Sheet

The Column Properties window enables you to select your cost sheets.
The Type field enables you to select the following:

» Worksheet
» Activity Sheet

The Name/ID field displays the name of the worksheet that you have selected; otherwise, this
field displays the Activity Sheet, using the following naming conventions:

» Activity Sheet 01 (Activity) — for Activity Sheet with ID 01
» Activity Sheet 01 (Resource)

If there is no data or sheet for that ID, then Unifier displays an error message when you click
OK, after making the selection, and the value will be zero in the Cost Sheet for that column.

The Column field enables you to select the currency and decimal fields from the Activity Sheet
that are available to be rolled up into the Cost Sheet as a column.

Assignhments

» uuu_P6PlannedCost (Planned Cost - cost)
» uuu_P6ActualCost (Actual Cost - cost)
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uuu_P6AtCompletionCost (At Completion Cost - cost)
uuu_P6RemainingCost (Remaining Cost - cost)
uuu_P6PlannedUnits (Planned Units- Units)
uuu_P6ActualUnits (Actual Units- Units)
uuu_P6AtCompletionUnit (At Completion Units- Units)
uuu_P6RemainingUnits (Remaining Units- Units)

v v v v v Vv

Activity

uuu_P6PlannedTotalCost (Planned Total Cost - cost)
uuu_P6ActualTotalCost (Actual Total Cost - cost)
uuu_P6AtCompletionTotalCost (At Completion Total Cost - cost)
uuu_P6RemainingTotalCost (Remaining Total Cost - cost)
uuu_P6PlannedTotalUnits (Planned Units - units)
uuu_P6ActualTotalUnits (Actual Units - units)
uuu_P6AtCompletionTotalUnits (At Completion Units - units)
uuu_P6RemainingTotalUnits (Remaining Units - units)

v v vV vV vV vV v Vv

Note: The decimal type Data Element (DE) is available in the cost
formula.

The Column Name field, in the Cell Details window, displays the DE field label in the respective
Activity Sheet.

Note: You can have from 1 to 100 predefined cost DEs created in the
Cost Sheet.

Rate Sheet Node

There are two types of rate sheets in Unifier:

» Master Rate Sheet (company level)
» Rate Sheet (shell level)

Note: No calculations are needed for a cost loaded schedule in Unifier.
The Earned Value Analysis module directly uses the data imported from
P6.

A Rate Sheet is a subset of the Master Rate Sheet in a shell. You can create one or more rate
sheets to assign rates to all or selected projects in the Activity Sheet of a shell. The rate sheets

retrieve the resources and roles from the activity sheet of that shell and attain the corresponding
rates from the Master Rate Sheet.
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Note: By default, the rates present in the Master Rate Sheet are used
across all the resources and roles present in the activity sheets across
all shells unless you assign a shell-level rate sheet to the Activity Sheet
in that shell.

A rate sheet provides the rates for the roles and resources assigned to activities of resource
loaded schedules. This is required to perform costing and subsequent earned value analysis in
Unifier. You can have multiple rate sheets. These rate sheets are listed in the Rate Sheets node
log.

The Rate Sheet (at Project/Shell) log does not show any record at the shell level. When you use
the Rate Sheet for the first time, you have to create a subset of the Master Rate Sheet by
clicking on the Create option. The Create option can be used subsequently to create a rate
sheet directly from Master Rate Sheet.

You can define the rate breakdowns manually by using a formula to establish rates based on
other cost types. When you edit the cell Price/Unit, you can click the formula icon to open the
formula window. When you select the formula, Unifier displays the formula builder. The left-hand
pane displays the rate breakdowns defined for the rate that you have selected. You can select
more than one breakdown and add a formula.

The Rate Sheet node log contains a list of rate sheets listed in the Rate Sheets log window.
You have the following options for a rate sheet at shell level (in the Rate Sheet):

» Create
If you click Create, then Unifier creates a rate sheet, with the required activity sheet as the
list of roles and resources, and gets the corresponding rates from the Master Rate Sheet,
automatically.

» Copy

You can select a rate sheet from the log at shell level (Rate Sheet) and click Copy. In this
scenario, Unifier does not check the roles and resources list in activity sheet and just creates
a copy of the rate sheet selected with user entered name through a window.

Note: To view Rate Sheet, you must have appropriate permissions.

There are some minor differences in the log layout for rate sheet between Master Rate Sheet
(at Company Workspace) and Rate Sheet (at Project/Shell).

Rate Sheets Node Log Window

To access the Rate Sheets log, go to the shell (User mode), click to expand the Activity
Manager module, and click Rate Sheet.
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Note: The location may differ in your implementation based on the
Project/Shell User Mode Navigator configuration.

You can use the Rate Sheets log to:

» See a list of rate sheets.

» Review the following information (on the right-hand pane of the log) about a selected activity

sheet:

» Audit Log

» Permissions
» Schedule

The Rate Sheets log has the following toolbar options:

Toolbar option

Description

Create To create a new rate sheet by copying a
data from Company Workspace and
Activity Sheet.

Refresh To refresh the contents of the page.

Delete To delete an item

Find on Page To find an item on the page.

The Rate Sheets log has the following columns:

Column Description

Name The name of the rate sheet entered in the
Create Rate Sheet dialog.

Description The description for the rate sheet entered

in the Create Rate Sheet dialog.

Last updated

The date the sheet was last updated
manually or through Refresh.

Created By

The name of the user who created the rate
sheet.

The Rate Sheets log lists the rate sheets and each rate sheet row has a menu options that you
can access by way of the gear menu (ﬂ'). The following table explains the gear menu (ﬂ)

options for each rate sheet:
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Option Description

Open To open a rate sheet.
Note: You can also double-click to open
the sheet.

Copy To select a rate sheet and create a copy of

that rate sheet. Enter a name and
description and then click Save to
complete the action.

Delete To delete one or multiple rate sheets.

Note: The Delete option in the toolbar
allows you to delete multiple rate sheets
simultaneously. If a rate sheet is being
used in the Activity Sheet, then it cannot
be deleted.
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Option

Description

Refresh

To refresh a rate sheet based on

resources and roles that are used in the
system activity sheet of the shell.

Select a single or multiple rate sheets and
click Refresh to update the list of
resources and roles based on the latest
data available in the Activity Sheet, and
the corresponding rates from the Master
Rate Sheet. Click Yes in the Confirmation
window to update.

On refresh, the following updates are
implemented:

» If a resource/role has been removed in
the Activity Sheet in the shell, then
the role/resource and corresponding
rates are removed from the rate sheet.

» If a resource/role has been added to
the Activity Sheet in the shell, then
the new role/resource is added to the
rate sheet and its corresponding rates
are retrieved from the Master Rate
Sheet.

» If the resource/role exists in both
Activity Sheet and the rate sheet,
then the system updates the
resource/role name, if applicable
(using resource or role ID as the
identifier).

Export CSV

Use the options to export Role or
Resource Rate Breakdown as CSV. This
comprises the list retrieved from the shell
Activity Sheet. The structure includes ID,
name, status, effective date, cost type, rate
type, and price/unit information.

» Export Role Rate Breakdown: To
export role rates data.

» Export Resource Rate Breakdown:
To export resource rates data.
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Option Description

Update Data Use the options to import the modified
Role or Resource Rates CSV files in order
to update role and resource rates.

» Import Role Rate Breakdown: To
update the role rates using an imported
CSV and making changes to the data
from Export CSV (Export Role
Rates).

» Import Resource Rate Breakdown:
To update the resource rates using an
imported CSV and making changes to
the data from Export CSV (Export
Resource Rates).

The Rate Sheets log displays the rate sheet properties on the right-hand pane within the
following tabs:

Tab Description

Audit Log tab To provide the following information:

Date

Event
Action
Field Name
Old Value
New Value
User Name
Proxy User

Vv v vV vV VvV vV v Vv

Permissions tab To provide information about:

» Selected Users/Groups
» Permissions

Schedule tab To set Frequency for Refresh Rates.

Tip: Click the expand icon, in the right pane, to better view the tab details.
The following explains each tab in details.

Rate Sheets Log Window Tabs
The following explains the tabs in the Rate Sheets log window:
Audit Log
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The Audit Log tab tracks all the events of the rate sheet and the component roles and
resources.

Permissions

Use the Permissions tab to add users and groups and assign permissions for the specific rate
sheet: REVIEWER: We need description for the following.

» Modify Permission
» Edit & Refresh
> View

The creator of the rate sheet is assigned all permissions by default.
Schedule
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You can use the Schedule tab to set a frequency for automatic refresh of rates in the rate sheet
at daily, weekly, monthly or quarterly intervals between the specified start and end dates.

Creating a Rate Sheet

The Create option on the Rate Sheets log window enables you to manually create a rate sheet
and retrieve resources and roles information from the Activity Sheet and the corresponding
rates from the Master Rate Sheet.
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You can create multiple rate sheets as per business needs. For example, you can create an
Internal Rate Sheet to apply internal rates for the resources and roles in the project. If they work
on client sites, create another called External Rate Sheet. Other examples can include an
Overtime and Standard rate sheets. Use the same rate sheet across the individual projects in
the Activity Sheet or apply different rate sheets to the individual projects.

Note: Creating rate sheets is optional.

To create a Rate Sheet:

1) From the toolbar, click Create to open the Create Rate Sheet window.
2) Enter a name in the required Name field.

3) Optionally, add a description.

4) Click Create. (Click Cancel to exit the Create Rate Sheet dialog.)

The new rate sheet appears in the Rate Sheets log window.

Rate Sheet Window

Go to the shell (User mode) > Activity Manager module > Rate Sheet node to open the Rate

Sheets log which lists the rate sheets. Each rate sheet has a gear menu (ﬂ) that can be used
to open the rate sheet.

Note: You can also double-click to open the rate sheet.

The rate sheet log window has the following toolbar options:
View

Print

Refresh

Find on Page

Expand All Groups, or Collapse All Groups

v v v v Vv

The View toolbar option (the Resource view as is the default view) enables you to view the
attributes of the rate sheet derived from the activity sheet. From the View toolbar option, use the
Resource or Role option to switch between Resource or Role views respectively. The main
log, or grid, and the Rates tab layout are identical in the two views.

In the main log, or grid, you can see the following columns:

» ID

» Name

» Type (not available for the Role view)
» Status

» Currency

Select any item to view and the Rates tab displays the details.
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Rates
In the Rates tab, there are two columns:

» Effective Date
» Price/Unit
Information is retrieved from the Master Rate Sheet. You can create multiple rate instances for

a resource/role for different effective dates. The Cancel and Save options appear when you
make a change.

From the gear menu (ﬂ) of a rate, click Add to add a row above it. Complete the Effective
Date and Price/Unit fields. Click Save to save changes.

Note: The effective date and rates entered in the tab are not overwritten
on refresh. Clicking Refresh in the Rate Sheets log pulls any additional
resources and roles from the Activity Sheet.

On the Rates tab, you can click the Create option to open the Create Rate Breakdown window.
The Create Rate Breakdown window has the following columns:

» Cost Type

To select the cost type corresponding to the rate which is being created for the role or
resource.

» Rate Type
To select the type of rate which is being created for the role/resource.
» Price/Unit

To provide a price or unit by way of selecting from the drop-down field Manual (Price/Unit)
from the method. This can be done manually or by using the Formula Builder (click the
calculator icon in the Price/Unite cell).

WBS Sheet Node

A Work Breakdown Structure (WBS) sheet contains the following information:

Planned Units

Planned Total Cost
Actual Units

Actual Total Cost
Remaining Units
Remaining Total Cost

At Completion Units

At Completion Total Cost

The WBS Sheet node log displays the only available WBS sheet.
The WBS Sheet node log displays the only available WBS sheet. Use the three vertical dots

v v vV vV vV vV v Vv

icon (*) to expand the screen and see the properties of the sheet, if necessary.
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Note: The EVM data sources should not be seen in the WBS Sheet
columns for customers without the EVM license.

WBS Sheet Node Log Window

To access the WBS Sheet node log, go to the shell (user mode), click to expand the Activity
Manager module, and click WBS Sheet node.

Note: The location may differ in your implementation based on the
Project/Shell User Mode Navigator configuration.
You can use the WBS Sheet node log window to:

» See the list and properties of a WBS sheet.
» Access a WBS sheet.

The WBS Sheet node log window is divided into two panes:

» Grid or table (left-hand)
» Properties tab (right-hand)
4

The grid, or table, (left-hand pane) contains the following columns:

Name
Description
Last Updated
Created By

The Properties tab (right-hand pane) has the following fields:

»
»
»
4

Name
Description
Last Updated

»
»
»
» Created By

v v v v v Vv
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Accessing a WBS Sheet

To open a WBS sheet or WBS worksheet (window) form the WBS Sheet node log window click
to open the gear menu (ﬂ) and click Open to open the WBS Sheet worksheet (window).

The WBS Sheet worksheet (window) has the following toolbar options:

Add Column Enables you to create a new column by providing values for the
following mandatory fields:

» Name

Type
Datasource
Data Format
Display Mode
Total

Column Position

v v v v v Vv

Project Enables you to select a project from the drop-down menu.

View Enables you to change the view of the WBS Sheet window. You
can use this option to access created views, create new views, or
manage the existing views.

Edit View Enables you to select which columns to be displayed or remain
hidden, apply filters, group and sort by available fields. Save
custom views.

» Inthe Columns tab, add/remove/reorder columns in the
default view. You can save as a custom view.

In the Filter tab, add conditions to filter the results of a column.
In the Group By tab, create or modify groups using column
elements. For example, activity status.

» Inthe Sort By tab, define the sorting order (Ascending or
Descending) of columns.

Print Enables you to print or export the WBS Sheet contents.
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Refresh Enables you to see the added values to the columns of the WBS
sheet.

Find on Page Enables you to search a for a WBS sheet on the worksheet
(window).

Expand All Enables you to expand or collapse a WBS sheet to see the

Groups or subordinates. The tree- like structure displays the summarized

Collapse All WBS and corresponding values of the project selected in the

Groups Projects list. You can export the WBS structure from the sheet.

A=
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Menu icon The menu icon (the icon with three horizontal lines) drop-down
enables you to:

» Import

Enables you to import Column Details. The Column Name
drop-down list in the Import Column Details window displays
all of the direct cell entry columns that have been added to the
sheet. You can select any one column and import the values
into the column, using the exported CSV file.

» Export

Enables you to export Column Details or Summary WBS
Sheet. When you select Summary WBS Sheet, the exported
file will contain the entire WBS Sheet information including all
WBS Codes and columns data.

» Columns

Enables you to add, copy, or paste columns. See Adding
Columns to a WBS Sheet for more details.

» Row Coloring
Enables you to assign single or multiple colors.
» Variance Analysis Setup

Enables you to set up the variance analysis by selecting the
BP, workflow, record owner, and trigger conditions.

» Create Variance Analysis Record

Enables you to create the variance analysis records for all of
the WBS Codes in the sheet. Before creating a Variance
Analysis Record, you must set up the Variance Analysis at
WBS level.

Note: Ensure that the business process that you select is
active; otherwise, the system displays this error: "Business
Process has not been selected."”

The WBS Sheet worksheet (window) displays a list of WBS sheets, in rows. The following
columns provide detail information about each WBS sheet:

WBS Code

WBS Name

Linked Record (see below for more information)
BP Actuals

EVM - Planned Value

Actual Units

Activity Sheet - Planned Value
Planned Units

Planned Total Cost

Actual Units

Actual Total Cost

VvV VvV vV vV vV vV vV vV v v v
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» Remaining Units

» Remaining Total Cost

» At Completion Units

» At Completion Total Cost

The values for the following columns are coming from P6 directly:

Note: The General tab of each WBS Code will not display these
columns. In addition, formula values that depend on these columns will
not display.

Planned Units

Planned Total Cost
Actual Units

Actual Total Cost
Remaining Units
Remaining Total Cost

At Completion Units

At Completion Total Cost

Vv vV vV vV vV vV v v

When you right-click on a cell, Unifier displays the following options:

» Create Variance Analysis Record (available if you have Edit permission for the WBS
Sheet)

» Expand Row
» Collapse Row

Linked Record **

For a WBS Code, the Linked Record column indicates if there are any associated auto-created
records to hightlighted WBS Code, or not. When you click on the link, the right-hand pane
opens, with Linked Records tab highlighted (see below for more information on the Linked
Records tab).

The Linked Record column can be empty if no auto-creation of variance analysis record has
been triggered.

When a variance analysis record auto-creation fails, when you hover over the link cell, the
following message is will be displays: "<failure reason>. Click to see history details." When you
click, the right-hand pane displays the history details. Here are some of the failure reasons:

» Business Process is hot configured.

» Record owner does not have create permissions.

» Record owner is not active.

» Trigger conditions are not satisfied.

If the rotate icon is displayed instead of the link icon, then the auto-creation of the record is still
in progress. The link icon is displayed after the auto-creation is complete.
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You can use the gear menu (ﬂ) next to each WBS Code row, or right-click on a cell, to: Create
Variance Analysis Record, Expand Row, and Collapse Row. You can click the X icon to
close the WBS sheet, exit the WBS Sheet log, and return to the WBS Sheet node log window
(Activity Manager module > WBS Sheet node).

When you click on a WBS code on the WBS worksheet (window) grid, the right-hand pane
opens and displays a series of tabs.

Note: On the right-hand pane, you have the option to use the icons (on
the right) to expand the pane or to dock the pane.

The following table explains each tab:

Note: Users who have at least the view permission for the auto-created
record should be able to view the record by double clicking.

WBS Line |Displays the title, description, and amount, or quantity, of the WBS Line
ltems tab |Items.

Cell Details | Displays the WBS Code and WBS Name along with the column name,
tab currency, cell total amount, and status.

General tab | Displays details about the WBS Attribute Form such as the CM WBS
name, code, and WBS type, ETC Technique, and EVM PV.
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Variance
Analysis
tab

Displays the following information:
Setup block
Business Process

You can select the Business Process at WBS Code level similar to the
Variance Analysis Setup done at WBS Sheet. The drop-down menu lists
of all project level or shell level BPs, enabling you to select a new value or
modify the existing value.

Bypass Initiation Step during auto creation

If you select this option, then the auto-created BP record will bypass the
initiation step and land on the second step of the workflow.

Select Workflow

You can select a workflow if your selected BP has multiple workflows.
The Select Workflow field function is similar to the Variance Analysis
Setup window.

Record Owner

You can select the record owner at WBS level. This field lists all of the
OBS Pickers, User Pickers, and User Data Pickers added to the WBS
Attribute form. When you select the OBS Picker as the record owner, then
the picker in general tab displays the OBS users that you had selected.

Trigger Conditions block

Multiple trigger conditions can be defined for each WBS level. Adding
trigger conditions is similar to adding at WBS Sheet level setup. You can
add one or more additional conditions to indicate trigger condition of the
current WBS. The Data Element, Condition, and Value must be specified
exactly the same way as specified in the Variance Analysis setup at WBS
Sheet level.

The Create Now option is enabled once you select the required fields on
the tab. Use the Create Now option to auto-create the business process
record manually if a BP is present in the setup. If the record owner is not
specified, then Unifier uses the auto-creator in the destination BP
(auto-creation tab) as the record owner.

Note: Any trigger conditions defined are ignored
in case you select the "Create Now" option.
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Linked
Records
tab

All the auto-created records are shown in the Linked Records tab for each
WBS Code.

The following explains the toolbar options

» Refresh: To refresh the items based on the latest records.

» Find on Page: To enable you to conduct a text-based search for each
column.

The following explains the columns.

» Record Number: System auto-created business process record
number.

BP Name: The name of the Business process.
Title: the title value from the business process record.

Status: The current status of the auto-created record, including the
terminated records.

» Created By: The username of the user who is creator of the
auto-created record.

» Creation Date: The date that the record is auto-created.

Variance
Analysis
History tab

This tab captures the list of failed auto-creation for each WBS Code, in
case business process is inactive or trigger conditions have not been met,
etc. The following is a list of the columns in this tab:

» Event: Displays, "Error" for failed auto-creations.
» Action Displays, "Auto Create."

» Field Name: This will be WBS Code where the auto creation failure
occurs.

» New Value: Displays the error text.

When you right-click on each column heading, depending on which column on the grid, some or
all of the following options will be made available:

Lock
after this
Column

To lock or release the position of a column on the grid.
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Insert To insert a column through:
Business Process Data Source
Direct Cell Entry

From EVA Sheet

From Activity Sheet

WBS Custom Attributes
Formula

Hidden

Hide this | To hide the column that you had selected.
Column

Delete To delete a column.

Propertie | To open the Column Properties window and review or change (with
S limitations) the properties of a column.

When you hover over each column heading, Unifier displays information about that column.

Creating a WBS Sheet

When an activity sheet is created, Unifier creates the WBS sheet, automatically.
About Auto-Creation

A BP record can be created automatically or manually from the WBS sheet. A new BP record
can be created for any WBS, and the BP record will be permanently linked to the WBS. A WBS
can be linked to one and only one BP record at a time.

In a Project, if any of the WBS Codes (the Unifier WBS Codes with line item data removed from
P6) have line item data, Unifier dismisses the data and sets the WBS Status
(uuu_cmwbs_Status) as inactive.

Note: In the scenario above, you will notice a discrepancy between P6
and Unifier.

When you attempt to create new line items, or records, in CBS- or WBS-type BP, the WBS
Picker will not display inactive WBS Codes.

Note: In the EVM Sheet, the WBS Picker displays the all of the WBS Codes, regardless of the
status. This is so you can see the actuals for the WBS Code that you select.
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Manual WBS Sheet

WBS Sheets Log

A default WBS Sheets log, where there is no System WBS Sheet, contains the Create option,
if you have the "Create" permission, which enables you to create a manual WBS Sheet.

If you do not have the "Create" permission for manual WBS Sheet, then the Create option will
not be available. If the System WBS Sheet has been created, then the embedded sheet will be
seen (with project drop-down) by default showing the current project name. You can navigate to
the other source project data (received from P6) by using the project drop-down.

When a manual WBS Sheet has been created, the WBS Sheets log displays the sheet title as:
Project WBS Sheet. The Project drop-down (on the top section) displays the current project as
the selected project. This Project drop-down will be seen all the time, and the value defaults to
the current shell name for the Project WBS Sheet.

You can select another source (project) in the Project drop-down. The Project drop-down will
show the source if there is WBS data integrated from P6 or Primavera Cloud. The Project
drop-down will show the projects received from source (P6 or Primavera Cloud). When you
select a P6 project the WBS data that is related to the selected project will be displayed.

In addition to other options (explained in the previous topics), the toolbar within the WBS Sheets
log displays the following options:

» Add Sibling
» Add Child

The above options are available when the current project, for example Project WBS Sheet, is
displayed. If you navigate to a P6 or Primavera Cloud project, then the above options will not be
available.

The remaining options in the toolbar will be the same as seen for the WBS data received from a
P6 or Primavera Cloud project.

The Project WBS Sheet view has the default project row with:

» The project or shell number as WBS Code.
» The project or shell name as WBS Name.

The default project row is a read-only row in the sheet.

When you add a parent WBS Code, by using the Add Sibling option, a new WBS row will be
created with required fields such as WBS Code and WBS Name.

It is only after the creation of a new WBS row that the Cancel and Save options become
available. You cannot save your entry until the required fields are entered.

The condition above applies when you select the Add Child option.

Menu

The Menu option (the icon with three horizontal lines) contains the following options and
sub-options:

» Import
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You can import the WBS codes by using a CSV file. The CSV import works similar to the
import of CBS codes in the Cost Sheet. When you select the current project, the following
options are available:

4

4

WBS Details
To create WBS codes along with hierarchy, using CSV file.

You can import the WBS Details in bulk by means of CSV import. This option, if you
select the current project in the project drop-down, enables you to:

- Add new WBS hierarchy and WBS codes.

- Update ETC technique (see below for more information) and other attributes for an
existing WBS hierarchy.

When you import new WBS codes, using CSV file, Unifier checks for duplicate WBS
codes. Your import will fail if:

- You have modified an existing WBS hierarchy in the CSV file.
- You have removed an existing WBS hierarchy, or WBS Code, in the CSV file.

When you import the WBS codes successfully, the new WBS codes will be appended to
the existing codes in the activity sheet. The audit log (Audit Log) entry for the creation of
the WBS code, using CSV import will be:

- Date: The date and time of the event that has occurred.
- Event: WBS Details

- Action: Import

- Old Value: Not applicable.

- New Value: Not applicable.

Column Details

» Export

You can export the WBS codes by using a CSV file. When you select the current project, the
following opptions are available:
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WBS Details
To export the existing WBS rows in the Project WBS Sheet.

All of the columns that are seen in the WBS Sheet will be exported as column headers, in
the CSV file.

The entire WBS path will be seen in the first column, for the WBS Code. All of the existing
WBS codes will be exported in order to add new WBS codes at the end, by appending
the new WBS codes along with the hierarchy in the CSV file. You cannot remove the
existing WBS rows in the CSV file. Always new WBS Codes will be added using CSV file.
You cannot remove the existing WBS rows in the CSV file. New WBS codes will be
added using CSV file, always.

Column Details

The following columns will be required and shown as required in the exported CSV file
(the first two columns of the CSV file):

WBS Code
WBS Name
Summary WBS Sheet
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Columns

Row Coloring

Variance Analysis Setup

» Create Variance Analysis Record
» Earned Value Setup

This option will be seen in the Project WBS Sheet in addition to the options available for the
System WBS Sheet. This option allows you to set an ETC technique (see below for more
details) that can be used in ETC calculations that will be performed at the WBS level. The
technique selected here will be applied to all the WBS Codes in the sheet. The technique will
override the individual WBS Code ETC technique selected, if one exists.

» Properties
This option will be seen in the Project WBS Sheet in addition to the options available for the
System WBS Sheet. This option will show the Project WBS Sheet default properties.

» Audit Log

This option will be seen in the Project WBS Sheet in addition to the options available for the
System WBS Sheet. There are no changes to the events that get audited in System WBS
Sheet. For Project WBS Sheet audit log will capture the creation, update and removal of
WBS Codes in the Sheet. Besides any updates done manually in the Sheet will be audited.
The details of audit log in Project WBS Sheet is explained in further section.

The current project log, for example Project WBS Sheet, contains the following columns:

Column Description

Row number | This is a read-only column. This column does not have a header.
When you enter a new row, delete a row, or reorder rows, the row
numbers will get updated throughout the grid. You can use this column
to capture errors in the grid. For example, if you miss entering data in
a required field, or when validation fails, the cell for the corresponding
row displays a red triangle. You can click the triangle to see the errors
in a box, similar to a business process line item grid.

WBS Code This is an editable column and required when a new row is created by
(uuu_cm_wbsc |using the Add Sibling or Add Child options. The WBS Code value is
ode) unique across the hierarchy. Unifier notifies you if you enter a

duplicate WBS Code by way of an error message.

WBS Name This is an editable column and required when a new row is created by
(uuu_cm_wbsn | using the Add Sibling or Add Child options. The WBS Code value is

ame) unique across the hierarchy.
Linked This is a read-only column. This column is populated with the linked
Records record associated to the WBS Code. Unifier populates the icon of the

WBS Code that has the variance analysis record created.

Other columns | The other columns appear as defined in the column properties.

The fixed columns will be seen along with the user-defined columns. If
you do not define any user-defined columns, then by default all of the
fixed columns will be seen, only.
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You can drag the child WBS codes to another location, below any parent. The WBS Codes
cannot be dragged to any row beyond the parent or hierarchy. You cannot drag a parent WBS
Code.

Gear menu (ﬂ):
The gear menu is not available if you select multiple WBS rows (parent and child rows).

» Add Sibling
To add a sibling to the row.
» Add Child
To add a child to the row.
» Copy
You can copy one or more WBS rows at the same level. This option is not available if the

selected rows are in a hierarchy. This option is available when you select multiple WBS child
rows, only.

» Paste
This option becomes available if you have copied a row. Use this option to paste the copied
rows in the desired location, in the sheet. This option is available when you select multiple
WBS child rows, only.

» Remove

This option becomes available if the WBS row is not associated to any activity sheet, or there
are no costs allocated. This option is not available if at least one WBS row is associated to
an activity sheet or has rolled up cost. This option is available when you select multiple WBS
child rows, only.

Rows Added to WBS Sheet

The WBS Sheet, with the WBS rows added, will be seen on the left-hand side of the log. When a
WBS Code is associated to the manual activities, the activity sheet name will be populated in the
Used By column field, displayed in the WBS Details in the right pane. The Used By column field
is a read-only field and displays all of the activity sheets that this WBS Code is associated with.
The Used By column field will be available in the General tab only, for the Project WBS Sheet.
It is shown as a first field in the tab.

The WBS rows that are associated with an activity sheet cannot be removed. You can edit, or
enter the data, in the editable columns in the sheet (the Cancel and Save options will become
available at this stage). The WBS Picker (in the cost business process) will show the current
projects WBS that are associated with the activity sheet along with the source projects WBS
codes. You can create transactions against the WBS codes of the current project.

Earned Value at Project Level

You can set up the earned value at project level. Under the Menu option (the icon with three
horizontal lines), use the Earned Value Setup option to open the Earned Value window and
select an ETC technique that can be applied to all of the WBS codes. The selected ETC
technique overrides the existing ETC technique defined at the WBS Code level.
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In the Earned Value window, you can select the technique for computing estimate to complete
(ETC). By default, the ETC = Remaining Cost of activity option is selected. When you select
ETC = PF * (Budget at Completion - Earned Value), ETC is equal to a performance factor
(PF) multiplied by (Budget at Completion minus Earned Value), you can select one of the
following to set a value for the performance factor:
» PF=1
Performance Factor equals 1. This method yields an optimistic result with ETC equal to the
Budget At Completion (BAC) minus Earned Value Cost. This is the default option selected.
» Performance Factor = 1/ Cost Performance Index

Performance Factor equals 1 divided by the Cost Performance Index (CPI), where CPI
equals the Earned Value Cost divided by Actual Cost.

» PF=1/(Cost Performance Index * Schedule Performance Index)

Performance Factor equals 1 divided by the Cost Performance Index multiplied by the
Schedule Performance Index (the Earned Value Cost divided by the Planned Value Cost).

» PF = <select a value>
Performance Factor is specified by you. If you select this option, you must enter a value
(factor) in the field.

After you select an option and save your selection, Unifier displays the following message: The
selected ETC technique will be applied to all WBS Codes in the Sheet. Do you want to
continue? If you select to continue, then:

» The selected ETC technique will be applied to all WBS Codes.
» The audit log (Audit Log) of the WBS Code displays an entry of the ETC technique update.

If you select not to continue, then the selected ETC technique will not be applied to any WBS
Code.

Earned Value Setup at WBS Level

For the WBS level, in the Project WBS Sheet log (bottom portion of the log), you can click the
Earned Value tab to see the options for selecting a technique for computing the estimate to
complete (ETC). The Earned Value tab is available for both the summary level and leaf level
WBS codes. Once you select a technique, for the summary level WBS codes, you can apply the
ETC technique to all child WBS codes (Apply the ETC Technique to all child WBS Codes).

WBS Path Behavior in WBS Sheet

The General tab (in the Project WBS Sheet log (bottom portion of the log) contains a data
element (uuu_P6WBSPath) that shows the WBS Path.

Example

Projectl
w1
W2
Activity 1
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For the WBS W2, the WBS Path will be displayed as Projectl > W1 > W2 so that any activity
created using W2 (as WBS Code) will show WBS Path as Projectl > W1 > W2, using the
auto-populate definition.

WBS Sheet Properties Window

You can use the Menu option (the icon with three horizontal lines) in the Project WBS Sheet or
System WBS Sheet to access the Properties.

When a manual WBS Sheet is created (through the Create option in the log), Unifier creates the
following properties, automatically:

» Name
The name of the WBS sheet. For example, Project WBS Sheet. This field can be 100
characters long.
» Description
The description of the WBS sheet. This field can be 4000 characters long.
» Last Modified
This is a read-only field. The date the WBS sheet is created or updated.
» Created By

This is a read-only field. The signed in user who created the WBS sheet (using the Create
option).

Project WBS Sheet (Audit Log)

You can the Menu option (the icon with three horizontal lines) to access the System WBS
Sheet and Project WBS Sheet audit log (Audit Log). The audit log captures the details for all of
the manual WBS sheets (including their attributes) that have been created, updated, and
removed. The audit log entries for the events such as manual creation or update of the WBS
Codes and Earned Value Setup will be as follows, and all of the events are audited similar to
the System WBS Sheet:

Attribute Update Reason |Date Event |Action |Field Old |New
Valu |Valu
e e
WBS Code create Date and |Projec |Create |[<WBS Code> Not |<Ne
time event [t WBS appli |w
occurred |Sheet cabl |Valu
e e>
Fields in WBS attributes | Date and |Projec |Updat |<WBS Code> > <Old |<Ne
updates either from time event [t WBS |e <Field Name> valu |w
sheet or from form view |occurred |Sheet e> |Valu
e>
WBS Sheet level setups | Date and |Earne |Create | Project WBS Sheet |Not |<Ne
time event | d > Earned Value appli |w
occurred |Value Setup > All WBS cabl |Valu
Setup Codes e e>

156



Activity Manager

WBS Sheet level setups | Date and |Earne |Updat |Project WBS Sheet |<Old |<Ne
updates time event |d e > Earned Value Valu |w
occurred |Value Setup > Al WBS e> |Valu
Setup Codes e>
Rearrange of WBS Date and |Rearra|Cut, <WBS Code> <old |<ne
Codes will be audited time event |nge Copy, locat |w
occurred and ion> |locati
Paste on>

Adding Columns to a WBS Sheet

You can add WBS custom attributes to a WBS sheet, as columns. The WBS Sheet window

toolbar menu drop-down (the icon with three horizontal lines) = = enables you to add columns
to the WBS Sheet.

Note: By default, all of the predefined columns that are in hidden block in
the WBS Attribute Form will display when you open the WBS sheet.

The following explains how to add a column by way of creating a new column or copying an
existing column.

To add a new column:

1) On the toolbar, click the Add Column icon (the three vertical lines) to open the New
Column window.

2) Enter or select values in the following mandatory fields:
Name
Type
Datasource
Data Format
Display Mode
Total
Column Position
The following fields are optional and enable you to customize you newly added column:
» Data Format
» Display Mode
» Total
3) Click Save, or Save & Add New to continue.

No VU AW~

The following explains the mandatory fields.
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Name

The name of the column that you want to add. The value in this field is
pre-populated according to the selected Datasource; however, you can
override the pre-populated value.
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Type This field has the following options:

» Business Process Data Source: When you select this option, all of
the data elements, based on SYS BP Decimal Amount and SYS BP
Currency Amount which are added on the WBS Attributes Form, are
displayed in the Datasource drop-down list. Select this option if want
to pull the roll up information for the new WBS (Type-cost BP). The
Datasource drop-down list will be displayed followed by the Formula
creator option which enables you to create the query for the column.
When you select the Formula Picker, the Formula creator window
displays the list of new Cost-type BPs with different statuses where
you can select BPs to see the roll-up amount.

» Direct Cell Entry: When you select this option, all of the data
elements, based on SYS Numeric and Date logical data sources, are
displayed. You can define manual entry column by using the logical
sources. You can copy the data in the Direct Cell Entry field and
paste it into other manual entry column.

» From EVA Sheet: When you select this option, all of the data
elements, based on SYS Numeric logical data sources as data
sources, are displayed. Select this option if you need to populate data
into WBS sheet from an EVA sheet. When you select the logical data
source, you can select the sheet name and available DEs, per
selected sheet, are displayed as columns to add.

» From Activity Sheet: Select this option if you need to populate data
in to the WBS Sheet column from an Activity Sheet. When you select
this option:

» All of the data elements are displayed in the Datasource field
(based on SYS Numeric logical data sources and SYS Date
logical sources).

» The logical data source, you can select the sheet name and
available DEs, per selected sheet, are displayed as columns to
add.

When you select the SYS Date logical data source, all of the date
columns (like Planned Start, Planned Finish, etc.) from the Activity
Sheet will be available to pick.

» WBS Custom Attributes: When you select this option, all of the
custom attributes that are added in WBS Attributes Form are
displayed.

» Formula: When you select this option, all of the data elements are
displayed in the Datasource field (based on SYS Numeric, SYS
Date logical data sources, and SYS Integer Amount). If you select
Formula as the type, then the Datasource field displays the
following:

» Alist of all of the SYS Numeric and SYS Date logical source data
elements that allow formula-type entry. The logical source data
elements that already have been used to create a column will not
be listed.

» A formula creator window (Formula Creation Window) that you
can use to create the formula for the column. The formula window
shows the list of all numeric columns tha can be created as
formula.
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Datasource

The drop-down list displays a list of all SYS Numeric and SYS Date
logical source data elements which allow the formula-type entry. The
sources that have been used to create a column will not display in the list.
The Datasource drop-down list will be displayed followed by the Formula
creator option which enables you to create the formula for the column.
The Formula window shows all of the list numeric columns (all Numeric
Columns) that can be created as formula.

Data The data format options are:
Format » Currency
» Decimal
The Data Format option is available only when SYS Numeric logical
source Datasource is selected, and by default the Currency must be
selected. There are no data format for Date- and String-type data
elements.
If you select the SYS BP Currency Amount data element, then the default
option will be Currency.
If you select the SYS BP Decimal Amount data element, then the default
option will be Decimal.
When you select Decimal, and proceed to choose a number, Unifier
displays the choice of decimal places (values are zero to eight).
Summary | Within the formula columns, in the WBS Sheet, you can select the type of
Rows summary rows that you want to display. The options under the Summary
Rows block enable you to display the roll-up value from children (Sum of
All Rows), or to display the formula value (Use Formula Definition).
Your options are:
» Blank
» Sum of All Rows
» Use Formula Definition
Display The display mode options are:
Mode » Show
» Hide
Total The total options are:

» Blank
» Sum of All Rows
» Use Formula Definition: This option is available for a formula column.
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Column To position the newly added column.
i?é':'on » If you choose a column in the Cost sheet and then select to add a

WBS sheet.

the name of the last column in the WBS sheet.

column, then the Column Position After drop-down will be
pre-populated according to the name of the selected column in the

» If you select no column and then select to add a column, then the
Column Position After drop-down will be pre-populated according to

To add a new column by way of copying an existing column:

1) On the toolbar options, click the menu drop-down (the icon with three horizontal lines)

2) Click Columns.
3) Click Copy Column Data to open the Copy Column Data window.
4) Select values in the following fields:
I. Copy from Column (mandatory)
2. Percentage
3. Past to Column (mandatory)
5) Click Save to continue.

The following explains the fields.

Copy from Displays all of the existing manual-entry or formula-based numeric
Column columns for you to select.
(mandatory)

Percentage To enter the percentage value. The value must be greater than zero

and less than or equal to 100.

Paste to Displays all of the existing manual-entry numeric columns for you to
Column select.
(mandatory)

If you right-click on the Direct Cell Entry of a numeric column, you can hide, lock, copy (the
column data), paste (the column data) into, delete, or see the properties of that column. The

Copy Column Data option is available only for:

» Direct Cell Entry columns
» Custom elements that have been added as columns

The Copy from Column field will be pre-populated with the name of the selected column;

however, you can change the source to any other source.

If you right-click on the column header, you can see some or all of the following options:

» Insert

» Hide this Column

» Lock after this Column
» Delete
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» Properties

Auto-Creating Variance Analysis BP Records

The WBS Sheet window toolbar menu drop-down enables you to set up the variance analysis.
Click the toolbar menu drop-down icon and click the Variance Analysis Setup option. Use this
option to set up the auto-creation of business processes for all of the WBS Codes. The option
enables you to open the Variance Analysis Setup window and select the following elements in
order to be able to create the variance analysis record:

» Business Process

The Business Process field enables you to select the business process (BP) record that
must be auto-created. You can select from a list of all BPs that are active in the current
project or shell, one BP at a time.

» Initiation step

Selecting the Bypass Initiation Step during auto creation option enables you to create
workflow BP records by passing I-Step during auto-creation and land on the second step of
the workflow. In case of a non-workflow BP, an auto-created record will be in submitted
mode.

» Workflow

The Select Workflow field is available when multiple workflow schemas are available for the
BP that you have selected. If the selected BP is a Non-Workflow BP, then the Workflow field
will be disabled.

Record Owner

You can see the User Pickers, OBS Pickers, or User Data Pickers that have been added in
the WBS form.

» Trigger Conditions

You can add one or more conditions to determine the trigger condition of the WBS. For
example, the WBS Type can be CA. Once you select the trigger condition, click the plus icon
(+) to see an empty row in trigger conditions. A trigger condition is not required to save the
variance analysis setup. The Trigger Conditions block lists the following information:

- Data Element
- Condition
- Value
- Message
» Schedule

Under the Schedule block (scroll down on the Variance Analysis Setup window) you can
schedule auto-creation of the BP record and set frequency.

Range of Recurrence
You can determine a range for auto-creation to reoccur.

Create Variance Analysis Record
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Note: Before creating a Variance Analysis Record you must set up the
variance analysis (Variance Analysis Setup).

When you click the Create Variance Analysis Record option you trigger the auto-creation of
the BP that you have selected during the variance analysis setup for all the WBS Codes.

Viewing a WBS Sheet

The View option enables you to change the view of your WBS Sheet window. You can use this
option to access created views, create new views, or manage the existing views.

» Default

» Create New View

» Manage Views

You can click the three vertical dots on the left-hand side of the window, or the three horizontal

L ]

dots at the bottom of the window,(* or =##+) to expand the window and see the properties of
any selected WBS Code.

The Default view provides a view similar to the BP log view, Cost Sheet log view, or other logs
with the Standard View option.

To create a new view for the WBS Sheet worksheet window, click Create New View, then:

Use the Save View As field to name your new view. If you save a new view without selecting
any columns, then a new view is created with the WBS Code and WBS Name columns.

Use the following tabs for adding columns, filtering, grouping, and sorting:

» Columns tab

» Filters tab

» Group By tab

» Sort By tab

The Available Columns box displays all user-defined columns that you may need for your

newly created view, including the Linked Record. The Selected Columns box displays all of
the columns that you select. You can move columns in and out of the Selected Columns box.

Note: By default, Unifier includes the WBS Code and WBS Name
columns in the Selected Columns box; therefore, these two options are
not listed in the Available Columns box.

Use the following fields to set the position of the new view:

» Left Lock after Column

Displays a list of all columns, except the last column from the selected columns list. By
default, the "None" option is selected, which means that you have chosen no column to be
locked, from the left of the sheet.

» Right Lock after Column
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The default value is "None," which means that you can select not to right-lock the column in
the view. Other values in this field are based on the value that you have selected in the Left

Lock after Column.

The Filters tab enables you to filter the rows by WBS Sheet column data, or by WBS Attributes.
For WBS Sheets, there are two sections in this tab: WBS Attributes and Sheet Columns.

The Search Parameters block displays all of the DEs from the WBS Attribute form that are
added in uDesigner (this includes elements from WBS Attribute form that are added as
columns). The list also includes the fixed 8 columns that will be seen in WBS Sheet.

When a filter is applied, the view shows all of the WBS rows that match the filter criteria, with
their Summary Codes.

Additional check box for filtering rows with Linked BP records is also available (WBS Codes
with Linked BP Records). When you select this option, when filtering, then only the WBS
Codes that have linked records will be filtered.

The Group By tab has two columns:

» Group By
Displays all of the attributes that are added in the WBS form, which includes all of the
custom DEs. By default, "None" is selected, and you can select any field to set the Group
By. All columns include linked records column.

» Order
By default, the Ascending Order is selected, but you can select to show the contents of
the column in Descending Order, when groups are displayed.

The Sort By tab has two columns:

» Sort By
Displays all of the columns that are added in the WBS Sheet. By default, "None" is
selected, you can select any field and set Sort By.

» Order

By default, the Ascending Order is selected, but you can select to show the contents of
the column in Descending Order, for the data to be displayed in selected Sort By

column.

To manage the view for the WBS Sheet worksheet window, click Manage Views, and select
which of the available views (under the View Name block) you want to become visible to the
user. The Cancel and Save options enable you to cancel your changes (no changes will be
saved and window gets closed) or save any changes that you have made and close the window.

The Edit View option enables you to change the view of your WBS Sheet window. The function
of the Edit View option is identical to Create New View.

WBS Sheet with User-Selected View

When you select a user-defined view in the WBS Sheet worksheet window, you will notice the
following changes:

Toolbar options:

In the toolbar options, the Add Column option is not available, but the following toolbar
options are available:
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» Edit View

» Print

» Refresh

» Find on Page

» Collapse All Groups
» Expand All Groups

Menu options (the three-horizontal lines with drop-down arrow):

» Row Coloring (Multiple Colors, Single Color)
» Variance Analysis Setup
The row coloring changed in the view will be temporary.

Gear menu (ﬂ):

The gear menu (ﬂ') options available (for each WBS Code) enable you to expand or
collapse the component.

The gear menu (ﬂ) options available (for each WBS Code component) enable you to
Create Variance Analysis Record in addition to expanding or collapsing the component.

Column menu options and cell properties:

The column menu actions are not available when you right-click the column header.
When you click in a cell, the right pane opens with the following editable tabs:
» General tab
» Variance Analysis tab
» Linked Records tab
» Variance Analysis History tab
You can use:
= The Expand icon to expand the right pane.
» The Doc Bottom icon to move the right pane under the WBS Sheet worksheet.

Drag and Drop columns option:

You can drag and drop columns to different locations on the WBS Sheet worksheet. When you
do so, the user-defined view name (hame is shown in the View field of the toolbar) will get the
prefix: (Modified).
Edit View toobar option:
Use the Edit View toolbar option to modify the user-defined view. You can modify the list of
available columns, apply filters, change grouping, or change sorting.
In the Group By tab, you have the option of grouping based on appropriate rows grouped
within, in the view. Once you set the first option for group by, you can use the gear menu

(ﬂ) to add the second option. The header of each group, with its appropriate rows, appears
as an additional column before the WBS Code Column. Once you set the group-by to the
view, the group summary row displays the summary value based on the group by column
Properties > Total option. The summary, sum of all rows, formula definition will be blank.
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The data seen in the user-defined view will be based on the filters selected in the view.
For the numeric columns, the filter total will be shown along with the column total.

WBS Sheet views when you switch between P6 Projects

After applying a user-defined view, if you switch to another P6 Project, then the data will be
filtered based on the selected view. Also, when drag and drop a column in a user-defined view,
the view name will be prefixed with: (Modified). In this case, if you switch to a different P6
Project, still the (Modified) view name is displayed until you close the WBS Sheet. Position of
the columns and sort order of the columns remain as is, when you shift between different P6
projects, for a user-defined view.
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An Organization Breakdown Structure (OBS) sheet contains the following information:

Full Name

Short Name
Unifier User
Title

Department
Status

WBS Name
Contract No
Weekly Capacity

Vv vV vV vV vV vV v v Vv

The OBS Sheet node log displays the only available OBS sheet.

In This Section

OBS Sheet Node LOG WINAOW .......ccoiiiiiiiiiii e 167
ACCESSING aN OBS SHEEL ... e 168
Creating an OBS ShEEt..........uuuiiiiiiiiiiiiiiii e 169
OBS Sheet Node Log Window

To access the OBS Sheet log, go to the shell (User mode), click to expand the Activity
Manager module, and click OBS Sheet.

Note: The location may differ in your implementation based on the
Project/Shell User Mode Navigator configuration.

You can use the OBS Sheet log window to:

» See the list of OBS sheets with corresponding general information.
» Access an OBS sheet.

The OBS Sheet log window is divided into two panes:

» Grid or table (left-hand)
» General tab (right-hand)
» Audit Log tab (right-hand)

When you click on an OBS sheet on the grid, the General tab display the details about the OBS
sheet. The Audit Log tab displays a list of events with details. In the General tab, the Name
field will be editable as long as the OBS sheet is not used anywhere. The Description field will
always be available for changes. If you have View and Modify permissions, you can export the
Audit Log into a CSV file. A CSV export contains all the fields in the OBS sheet.
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Accessing an OBS Sheet

To open an OBS sheet form the OBS Sheet log window:
1) From the OBS Sheet log window, click on a row.

2) Click to open the gear menu (ﬂ).
3) Click Open to open the OBS Sheet log.

The OBS Sheet log has the following toolbar options:

» Add Sibling

Enables you to select a record and add an associated member.
» Add Child

Enables you to select a sibling and add an associated member.
» Actions

Enables you to import or export data.
» Find on Page

Enables you to search a for an OBS sheet on the log.
» Expand All Groups or Collapse All Groups

Enables you to expand or collapse an OBS sheet to see the subordinates. The tree- like
structure displays the summarized OBS and corresponding values of the project selected in
the Projects list. You can export the OBS structure from the sheet.

The OBS Sheet log displays the following required information about each OBS sheet:

» Full Name
» Short Name
» Status

The OBS Sheet log displays optional information about each OBS sheet such as:

Unifier User
Title

Department
WBS Name
Contract No
Weekly Capacity

You can click the X icon to close the OBS sheet, exit the OBS Sheet log, and return to the OBS
Sheet log window (Activity Manager module > OBS Sheet node).

v v v v v Vv

Additional information

OBS structure can also be generated through CSV import. Template can be exported using the
Export Data.

OBS Picker

The OBS picker will be available for assigning an OBS to WBS Sheet. The OBS Picker will
display only the OBS records with Active status.
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Note: The OBS picker supports both "And" and "Or" query conditions.

Creating an OBS Sheet

When there are no OBS sheet available, you can go to the OBS Sheet log window (shell > User
mode > Activity Manager module > OBS Sheet node) and create one.

Note: Once an OBS sheet is created, the Create option will no longer be
available because a shell can have one OBS sheet, only.

To create an OBS sheet, when there are none:

1) Click the Create drop-down menu and click to select one of the following options:
a. New

To open the Create OBS Sheet window and complete the fields required for creating a
new OBS sheet.

When finished, click Create.
b. From Template

To open the Templates window and select the required template for creating a new OBS
sheet.

When finished, click Select.
c. From Project

To open the Projects window and select the required project for creating a new OBS
sheet. You can select one project, only.

When finished, click Select.
2) Click Save to complete creating an OBS sheet.

About Unifier and P6 Integration

You can integrate multiple P6 projects into one Unifier project.

» When you integrate (Project ID mapping) a P6 project into a Unifier project through the
General tab of the Shell Attribute form, Unifier updates the Schedule Type field in General
tab.

The General tab is mostly used for one-to-one integration (one P6 project mapped to one
Unifier project).

» When you integrate (Project ID mapping) multiple P6 projects into one Unifier project through
the Integration tab of the Shell Attribute form, Unifier does not update the Schedule Type
field in the General tab.

In the Integration tab, the Schedule Type column is updated.
The Integration tab is mostly used for many-to-one integration (many P6 projects mapped to
one Unifier project).
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Prior to the Unifier 20.7 release:

When you performed Get Data from the Activity Sheets log, if the P6 Project ID was not
defined in the Shell Attribute form (General tab and Integration tab), then Unifier would
use the first import synchronization: Select Synchronization to Exchange Activity Data.

When you performed Get Data from the Activity Sheets log, if the P6 Project ID was
defined in the Shell Attribute form (General tab and Integration tab), then Unifier would the
second import synchronization: Select Synchronization to Exchange Activity and
Assignment Data.

Starting with the Unifier 20.7 release:

When you performed Get Data from the Activity Sheets log, whether the P6 Project ID is
defined, or the P6 Project ID is not defined, in the Shell Attribute form (General tab and
Integration tab), Unifier uses a single import synchronization: Select Synchronization to
Exchange Activity Data.

The drop-down field (Select Synchronization to Exchange Activity Data) displays all of
the import synchronizations defined in Gateway for Unifier deployment, including the import
synchronizations to get activity and assignment data which is used for EVM.

The system refers to the drop-down field (Select Synchronization to Exchange Activity
Data) for the import synchronization selected in all of the following cases:

a. P6 Project ID is added in the Integration tab
b. P6 Project ID is added in the Shell Attribute form

c. When the project number in the Shell Attribute form matches with the P6 project
number.

Update of CBS Codes from P6

You can get the latest CBS Codes updates assigned to activities from P6 into the activity sheet,
using gateway integration.

The Get Data synchronization that creates the activity sheet populates the following data:

4

Scheduling data (activities along with assignments and spread data) from the P6 projects
mapped to the current shell in the Integration tab.

CBS Codes assigned to the activities.
CBS Codes assigned to the resource and role assignments.
Roles and Resources along with rates assigned to the activities.

Note: Subsequent updates of Role and Resource Rates in P6 will not
trigger the updates in Unifier Master Rate Sheet; however, subsequent
updates of CBS Code for activities in P6 will trigger the updates in the
Unifier Activity Sheet CBS assignments.

You can use P6 to capture duration as well as resource assignments (resource units, resource
CBS assignment, resource units spread, actual resources consumed till date, and so forth). The
Activity Sheet, in this case, can receive all of the resource units, CBS assignments, and
calculate costs using P6 data and rates.
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Note: The export of CBS Cost codes from Unifier remain as is.

You can receive the latest updated CBS assignments to Activities and Resources and Role
assignments when P6 data is pulled into the Activity Sheet. After the latest Get Data, you will be
able to see that the CBS assignments updated in the Activity Sheet and re-costing sums the
costs, by the latest CBS assignments. This applies to the existing Activities and Resources and
Role in the Activity Sheet.

Note: All of the cost calculations will be updated based on the CBS
assignment updates. In addition, any new earned value analysis (EVA)
created will show the EVM data according to updated CBS Codes.

The following scenarios explain how to get the latest CBS codes updates assigned to activities
from P6 into the activity sheet using gateway integration:

» CBS Code assigned to the activity are updated from P6, and the CBS Code received is
inactive in project cost sheet

If the CBS Codes that are assigned to the activities, and updated, in P6, and the CBS Codes
are not active in Unifier Cost Sheet, then the Earned Value Analysis will not show those CBS
Codes even though they are updated in the activity sheet. In this case, you will not be able to
create BP actuals as those codes will not be shown in the CBS Picker.

If the CBS Codes updated for an Activity in P6 is no longer active in the Unifier Cost Sheet,
then do not update the current CBS assignment for the activity. There will be no change in
cost calculations.

The History tab log will show the following message: The CBS Code <CBS codel> received
from the P6 in Resource < Resource Name> of Activity <Activity ID> is inactive in the Unifier
Cost Sheet and cannot be updated. This indicates that the activities (where the CBS
assignments are) have not been updated.

For CBS Code assigned to the resources are updated from P6 and CBS Code received is
inactive in project cost sheet:

If the CBS Code (updated for the resource in P6) is no longer active in the Unifier Cost
Sheet, then do not update current CBS assignment for the resources. There will be no
change in the cost calculations.

In this case, the history log will show following message: The CBS Code <CBS codel>
received from the P6 in Resource < Resource Name> of Activity <Activity ID>. This
indicates that the activities where the CBS assignments are, have not been updated.

If the CBS Code is updated both at the activity and and at the resource assignment level
in P6, and the updated codes are inactive, then the following two messages will be seen
in the history log:

The CBS Code <CBS codel> received from the P6 in Resource < Resource Name> of
Activity <Activity ID> is inactive in the Unifier Cost Sheet and cannot be updated.

The CBS Code <CBS Codel> received from the P6 in Resource < Resource Name> of
Activity <Activity ID> is inactive in the Unifier Cost Sheet and cannot be updated.
Similarly, if the CBS Code that has been updated for the role in P6, and the CBS Code is
no longer active in the Unifier Cost Sheet, then do not update the current CBS
assignment for roles. There will be no change in cost calculations.
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The History tab log will show the following message: The CBS Code <CBS codel>
received from the P6 in Role < Role Name> of Activity <Activity ID> is inactive in the
Unifier Cost Sheet and cannot be updated. This indicates that the activities (where the
CBS assignments are) have not been updated.

» CBS Code is removed for Activity or Resource assignment in P6:

If the CBS Code assignment do exist for the activity in Unifier Activity Sheet, then do not
clear the CBS assignment (with the latest data from P6). This is the case where CBS Code
assigned to an activity is removed in P6 projects, and you received the latest activity data
from P6 using the Get Data option.
The History tab log will not show any additional warning messages; however, the system
ignores any cleared CBS assignments from P6.

» CBS Code is changed in Activity or Resource assignment in P6 and the activity sheet is
updated with latest CBS assignments:
The existing EVA will start to show the PV or AC, CV, and so forth for both the old CBS
Codes and the new CBS Codes.
The BP actual will no longer show the actuals that have line items with the old CBS Codes in
the EVM Sheet (default view).

About Unifier and Oracle Primavera Cloud
Integration

In the Activity Sheet overlay page, you can use the Open Project in <source name> option
(see System Activity Sheet (on page 44)) to open the Oracle Primavera Cloud page and open
the source URL either in P6 or Oracle Primavera Cloud, in a new tab. The Activities tab points
to the relevant project data (the project that is selected in the drop-down provided there is an
active login session).

The login on the new tab for P6 or Oracle Primavera Cloud will be displayed where you ender
your login credentials to sign in and see the relevant project data.

Note: You can see the project is opened even when that particular
project is closed in the source server.

Selecting this icon will open the source application in a new tab provided there is a valid URL
specified. If no URL is defined in the company properties page, then this link will not be shown in
the Activity Sheet.

Also, when you switch to Baseline, the link is not displayed.

Source Application Link in Activity Sheet
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In order for the link to open a project in P6, from the Unifier Activity Sheet, you must manually
add the mappings, as seen on the left hand side for project mapping template in the "Sync P6
and Unifier Projects."

Note: The mappings are not available in the project mapping template.

Parameters needed for the project mapping template in "Sync P6 and Unifier Projects:"

P6 Gateway Unifier
WBSObjectld p6_wbs_id uuu_int_internal_WBSObjectld
Objectld InternalProjectid uuu_int_internal_proj_id

Similarly, in order for the link to open a project in Oracle Primavera Cloud, from the Unifier
Activity Sheet, you must manually add the mappings, as seen on the left hand side for project
mapping template in the "Send Primavera Cloud Project data to Unifier."

Parameters needed for project mapping template in "Send Primavera Cloud Project data to
Unifier:"

P6 Gateway Unifier

projectld InternalProjectid uuu_int_internal_proj_id

Activity Sheet Created from P6 through Gateway

The activity sheets in Unifier capture the project scheduling data that is coming from either:

a) P6 project, or
b) Oracle Primavera Cloud project.

The project data (both current and baseline projects) from P6 or Oracle Primavera Cloud that is
brought over to Unifier by way of non-EVM synchronizations will be added to the activity sheet
which can further be used in cash flow analysis.

The costs associated to the activities can be rolled up to the cost sheet. In general, you can
assign a CBS code to the activities in the Activity Sheet when the activity sheet is created by
using non-EVM synchronizations. This enables you to use the schedules, or costs, associated
with the CBS code in your cash flow analysis. In particular, you can:

» Assign CBS Codes (cost codes) to the activities in the Activity Sheet created using non-EVM
synchronizations.

» Assign CBS Codes (cost codes) to the activities in the Activity Sheet created using EVM
synchronization for duration based schedules.

» Remove CBS assignments (assigned cost codes) to the activities, and resource
assignments, in the Activity Sheet.
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» View the planned, actual, at completion, remaining units, and costs associated with the CBS
Codes (cost codes) in the cost sheet.

You can create an activity sheet, from the Activity Manager, by using the Get Data option, by
way of P6 or Oracle Primavera Cloud integration with the following OOTB synchronizations
available in Gateway Integration Settings:

a) Get Activity data from P6
b) Get Activity and Assignment data from P6 for EVM
c) Send Oracle Primavera Cloud Activity data to Unifier

When you create an activity sheet by using the "Get Activity data from P6" or the "Send Oracle
Primavera Cloud Activity data to Unifier" synchronization, and using the "Get Activity and
Assignment data from P6 for EVM" synchronization for duration-based project, you can assign
CBS codes to the activities in the Activity Sheet regardless of the schedule type. This ability is
applicable to Activity Sheet created with:

» Duration schedules.
» Resource-loaded schedules.
» Cost loaded schedules.

Note: You can bring CBS codes from P6 using the "Get Activity data
from P6" and "Get Activity and Assignment data from P6 for EVM"
synchronizations for the resource-loaded and cost-loaded schedules.

In an existing activity sheet that has been created by using "Get Activity and Assignment from
P6 for EVM" synchronization,

» The Assign CBS options in the Actions field changes to Assign CBS Code, and the
Assign CBS window label changes to the Assign CBS Code.

» The Assign CBS option in the gear menu (ﬂ) changes to Assign CBS Code.

In an existing activity sheet that has been created by using any source-application (for all types
of schedules: Duration-based, Resource-loaded, and Cost-loaded):

» The Assign CBS Code option, in the gear menu (ﬂ), allows you to add a CBS code to the
activity sheet that uses the Duration-based schedule. You can select a CBS code from the
cost code picker. The cost code picker enables you to select an active CBS code from the
project cost sheet.

In the Assign CBS Code window, the General tab displays the associated CBS codes.

The Assign CBS Code option in the Actions field enables you to assign or update a single
CBS code for multiple activities (in bulk), one at a time. In this case, the General tab of each
activity sheet shows the updated CBS code.

» Any CBS code updates that have been made to an activity sheet will be audited and
displayed in the Audit tab.

» Use the Export CSV option, in the Actions field, to export the CBS code assignments for
the Resource-loaded and Cost-loaded schedules.
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» The Remove CBS Code option, in the gear menu (‘?), enables you to remove the existing
CBS assignment for the activity sheet. This option is only available if the activity sheet has a
CBS code assigned to it.

For Duration-based schedule, when you select the Remove CBS Code option:

4

4

If you select Yes, then Unifier removes the CBS code assigned to the activity sheet. The
audit log will have an entry for an assigned CBS code that has been removed for the
activity sheet.

If you select No, then the assighed CBS code remains as is.

In an existing activity sheet that has been created by using Resource-loaded and
Cost-loaded schedules, when you select the Remove CBS Code option:

4

If you select Yes, then Unifier removes the CBS code assigned to both the activity sheet
and the resource (Resource/Role). The audit log will have an entries for an assigned
CBS code that has been removed for the activity sheet and the resource. Oracle
recommends that you perform recost in order to calculate the costs (based on the CBS
code update).

If you select No, then Unifier informs you that you can only remove the CBS code
assigned to the activity sheet. If you select Yes, then Unifier removes the CBS code
assigned to the activity sheet. The audit log will have an entry for an assigned CBS code
that has been removed for the activity sheet. Oracle recommends that you perform recost
in order to calculate the costs (based on the CBS code update).

For Resource-loaded schedule, when you select the Remove CBS Code option:

4

4

If you select Yes, then Unifier removes the CBS code assigned to the resource
(Resource/Role). The audit log will have an entry for an assigned CBS code that has
been removed for the resource (Resource/Role).

If you select No, then the assighed CBS code remains as is.

To assign a CBS code or remove a CBS code for activities, in the Activity Sheet:

1) Go to your shell and from the left Navigator click Activity Manager to expand the node.
2) Click the Activity Sheet sub-node.

3) Inthe Activity Sheet log, click to select the activity that you want.

4) Click the gear menu (ﬂ) to open the menu and select one of the following options:

a.

Assign CBS Code

When you select Assignh CBS Code, the Assign CBS Code window opens which
enables you to use the cost code picker to select the cost code that you want to assign to
the activity sheet. The cost code picker displays only the active CBS codes within the
Unifier Cost Sheet.

The CBS code that you select to assign will become inactive after you assign it to the
activity sheet; however, the existing activity sheet data will roll up to the cost sheet and
you can view the data, for the Resource-loaded and Cost-loaded schedules.

For the inactive CBS codes, the new activity sheet data that is coming from P6 will not be
rolled up to the cost sheet. The CBS code assighments to the activities are audited and
the added or updated CBS codes are displayed in the audit log. This includes the CBS
code updates coming from any source by way of Get Data.
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Using Get Data enables you to get the Manage CBS Assignments to the activities, from
P6 by way of integration.

You can update a CBS code by way of Get Data from the Activity Sheet log, and the
Cost Sheet will be updated accordingly.

If you do not have permission to update the Activity Sheet, then the gear menu (ﬂ) and
the Actions menu will not display the Assign CBS Code, or the Remove CBS Code
options.

b. Remove CBS Code

Audit tab of the Activity Sheet

For every Activity Sheet, the Audit tab displays the audit log for each activity whenever the
following CBS Code updates are done at the activity level:

» New CBS Code assigned to the activity.

» Updating a CBS code assigned to the activity.
» Removing the CBS code assigned to the activity.

The audit log columns display information such as:
Event

Displays "Assign CBS Code" or "Update CBS Code," corresponding to the events that resulted
in adding or updating a CBS code. This column also displays "Remove CBS Code" in case of
removing the CBS code assigned to an activity.

» Field Name
Displays the activity ID.
» Old Value

Displays the existing CBS code. When you remove an assigned CBS code, this column
displays the existing CBS code.

» New Value

Displays the assigned CBS code. When you remove an assigned CBS code, this column
does not display any data.

Assigning a CBS code to multiple activities in the Activity Sheet created by using EVM
synchronization for Resource-loaded and Cost-loaded schedules:

Similar to assigning or updating a CBS code for an activity sheet, you can use the Assign CBS
Code option in the Actions field to assign or update a single CBS code to multiple activities (in

bulk), one at a time. In this case, the General tab of each activity sheet shows the updated CBS
code.

When you select the Assign CBS Code option, in the Actions field, for an activity sheet, the
Assign CBS Code window opens. You can select a CBS code from the cost code picker. The
cost code picker enables you to select an active CBS code, from the project cost sheet, and
assign it to the selected activities. The audit log will have an entry for an added or updated CBS
code.
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Assigning a CBS code to multiple activities, in the Activity Sheet created by using
Duration-based schedule, using the Export CSV option:

Use the Export CSV option in the Actions field to assign a CBS code to multiple activities (in
bulk), one at a time. Unifier will automatically performs validations (valid CBS code and active or
inactive CBS codes) regarding the assigned CBS code.

Removing a CBS Code from multiple activities in the Activity Sheet created by using
Duration-based, Resource-loaded, and Cost-loaded schedules:

Use the Remove CBS Code option in the Actions field to remove a CBS code assigned to
multiple activities (in bulk), one at a time. When you select the Remove CBS Code option:

» If you select Yes, then Unifier removes the CBS code assigned to selected multiple activities
(in bulk). The audit log will have an entry for an assigned CBS code that has been removed.
For the Activity Sheet created by using Resource-loaded and Cost-loaded schedules, Unifier
requires your confirmation. If you select Yes, then Unifier removes the assigned CBS code
for the selected activities and all of the associated resources (Resource/Role). If you select
No, then Unifier displays messages regarding the removal of the assigned CBS code for the
selected activities for the activity sheet, only.

» If you select No, then the assigned CBS code remains as is.

Using CSV import to assign CBS Code to multiple activities

In a Unifier Activity Sheet with all of the schedule types, you have the option to import CSV to
multiple activities, in bulk.

To import the CSV template to multiple activities:

1) Click Actions.

2) Click Update Data.
3) Click Activities.
4) Click Import CSV.

You can export the CSV template, using Export CSV, and bulk assign the CBS codes to multiple
activities, in Duration-based schedules.

All of the validations (CBS codes, active, and inactive CBS codes) regarding the assigning of the
CBS codes to multiple activities take place during the CBS code assignment.

Activity Sheet Created from Oracle Primavera
Cloud Project through Gateway
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When you create an activity sheet by way of integration with Oracle Primavera Cloud, you can
assign CBS codes to the activity sheet.

In the Activity Sheet log, click and select the activity that you want.

Click the gear menu (ﬂ) to open the menu and select one of the following options:

a) Assign CBS Code
b) Remove CBS Code

In the activity attribute form, the General tab displays the associated CBS code.

For details about the functionality for assigning, updating, and removing CBS code from an
activity (in Activity Sheet) from P6 using both non-EVM and EVM synchronizations, see the
preceding topic: Activity Sheet Created from P6 Through Gateway (on page 173).
Using CSV import to assign CBS Code to multiple activities

In a Unifier Activity Sheet with all of the schedule types, you have the option to import CSV to
multiple activities, in bulk.

To import the CSV template to multiple activities:

1) Click Actions.

2) Click Update Data.
3) Click Activities.
4) Click Import CSV.

You can export the CSV template, using Export CSV, and bulk assign the CBS codes to multiple
activities, in Duration-based schedules.

All of the validations (CBS codes, active, and inactive CBS codes) regarding the assigning of the
CBS codes to multiple activities take place during the CBS code assignment.

Unifier Activity Manager for Oracle Primavera
Cloud Schedules

You can also integrate multiple Oracle Primavera Cloud projects into multiple Unifier projects.

In Oracle Primavera Cloud, if two or more projects have the same Project ID, then when
integrating those projects into a single Unifier project, Unifier will randomly select only one of the
Oracle Primavera Cloud projects that have same Project ID and integrates that project into
Unifier.

178



Unifier Activity Manager for Oracle Primavera Cloud Schedules

Note: You can access the Activity Manager module for setting up
Oracle Primavera Cloud schedules the same way as accessing the
Activity Manager module in a shell. The Activity Sheets log
components (for setting up Oracle Primavera Cloud schedules) are also
the same as the Activity Sheets log in a shell.

The following explains the information specific the Activity Sheets log for Oracle Primavera
Cloud schedules.

Get Data

Use this option (Get Data) to:

a) Create an activity sheet for the first time.

b) Update an existing activity sheet with the most recent activity spread
data from the Oracle Primavera Cloud project.
Updating triggers a new OOTB import synchronizations if you have
selected the Select Synchronization to Exchange Activity Data option
in Gateway integration settings drop-down list.
All of the synchronized Oracle Primavera Cloud project activities,
planned dates, actual, at completion dates, and associated WBS Code
will be displayed in the activity sheet.

If the shell is not active (inactive shell), then Gateway integration will fail.

When you select this option (Get Data), the system checks for the Oracle
Primavera Cloud project that as defined in the Integration tab and then
brings the Oracle Primavera Cloud project activity data and their schedules
into the activity sheet:

» Based on the import synchronization defined in Gateway settings, and
» If Oracle Primavera Cloud and Unifier projects are linked.
If you select this option and there is no Project ID added in the Integration

tab, Unifier will display this message: Valid Project ID is not specified in the
Shell Integration Tab.

Note: Unifier does not bring the baseline (project data) from Primavera
Cloud.
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Send
Data

Use this option (Send Data) to run the export synchronization to send the
updated activities and schedules from Unifier Activity Sheet to the Oracle
Primavera Cloud.

The data elements in the business processes, or the shell attribute form,
which have been set to reverse auto-populate (RAP) back to the Oracle
Primavera Cloud Activity Sheet (using P6 Activity Picker) will get the latest
updates into the Oracle Primavera Cloud Activity Sheet.

You can send the updated Unifier Activity Sheet data (such as: updated
Actual Start Date or Finish Dates) to the Oracle Primavera Cloud project
which is linked by way of the OOTB export synchronization option: Update
Unifier Activity data in to Primavera Cloud.

The Schedule tab, in the Activity Sheet log, shows this option, and you can
set the scheduled send data based on frequency.

Mapped
Projects
tab

The Mapped Projects tab has the following toolbar options:

» Refresh
To refresh the log items for both the Mapped Projects tab and the
History tab.

» Find on Page
To conduct a search for items on the list.

The Mapped Projects tab displays a list of all of the mapped Oracle
Primavera Cloud projects. The following columns are available in this tab:

Project ID: Displays the linked Oracle Primavera Cloud Project ID.
Project Name: Displays the project name.
Project Type: Displays the value of either Current or Baseline. If you
receive the current schedule information, the Project Type column
shows: Current.
Project Start Date: Displays the start date of the project.
Data Date: Displays the last refreshed date from Oracle Primavera
Cloud.

» Schedule Type: Displays Duration as schedule type.

Schedul
e tab

The Schedule tab enables you to set the frequency for Get Data along with
a table that shows the schedules based on the frequency. This is applicable
to all projects in the activity sheet. Other drop-down values for the Set
Frequency for will be Send Data. You can select Send Data, but the OOTB
synchronization option is not available for sending the updated activity data
back to Oracle Primavera Cloud.

History
tab

The History tab displays the history of all of the events that are being
performed across the Oracle Primavera Cloud projects that are present in
the activity sheet.
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When you open an activity from the Activity Sheets log, the Activity Sheet overlay page
opens.

The Activity Sheet overlay page displays all of the activities data, in columns, such as:

Activity ID

Activity Name
Activity % Complete
Activity Status
Activity Type

v v v v Vv

The Activity Sheet overlay page displays the general information about an activity in the
General tab (right-hand pane), categorized by blocks, such as:
» WBS Attributes

» WBS Code (uuu_P6WBSCode): WBS Code associated to each Activity.

»  WBS Name (uuu_P6WBSName): WBS Name associated to each Activity.

»  WBS Path (uuu_P6WBSPath): WBS Path associated to each Activity.

»  Work Package (uuu_P6WorkPackage): This is the leaf node for every WBS structure and
will have the values Yes/No.

» Activity Attributes (General)
» Activity ID (uuu_P6Activityld)
» Activity Name (uuu_P6ActivityName)
» Status (uuu_P6ActivityStatus)
» Type (uuu_P6ActivityType)
» Performance % Complete (uuu_P6PercentComplete)
» Activity Attributes (Scheduling)
» Planned Start (uuu_P6PlannedStart)
» Planned Finish (uuu_P6ActualFinish)
» Planned Duration (uuu_P6Planned)
» Actual Start (uuu_P6ActualStart)
» Actual Finish (uuu_P6ActualFinish)
» Actual Duration (uuu_P6ActualDuration)
» Remaining Duration (uuu_P6RemainingDuration)
» At Completion Duration (uuu_P6AtCompletionDuration)
You can use this activity data in a business process using Activity Picker, and the updated
dates can be reverse auto-populated into the activity sheet. The activity sheet data can be sent

back to Oracle Primavera Cloud using the export synchronization selected in Gateway
integration settings.

Activity Mappings in Gateway

The following activity attributes are displayed in the log:
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Oracle Primavera Cloud

Gateway

Unifier

activityPercentComplete

PercentComplete

uuu_P6PercentComplete

actualDuration

ActualDuration

uuu_P6ActualDuration

actualFinishDate

ActualFinishDate

uuu_P6ActualFinish

actualStartDate ActualStartDate uuu_P6ActualStart
atCompletionDuration | AtCompletionDuration uuu_P6AtCompletionDuration
finishDate FinishDate uuu_P6Finish

activityCode Id uuu_P6Activityld
activityName Name uuu_P6ActivityName

plannedDuration

PlannedDuration

uuu_P6PlannedDuration

plannedFinishDate

PlannedFinishDate

uuu_P6PlannedFinish

plannedStartDate

PlannedStartDate

uuu_P6PlannedStart

projectld

Projectld

uuu_int_p6_project_id

remainingDuration

RemainingDuration

uuu_P6RemainingDuration

remainingFinishDate

RemainingFinishDate

uuu_P6RemainingEarlyFinish

remainingStartDate

RemainingStartDate

uuu_P6RemainingEarlyStart

startDate StartDate uuu_P6Start
activityStatus Status uuu_P6ActivityStatus
activityType Type uuu_P6Activitytype
wbsCode WBSCode uuu_P6WBSCode
whbsld WBSObjectld uuu_P6WBSElementid
whsPath WBSPath uuu_P6WBSPath
wbsName WBSName uuu_P6WBSName

The WBS Sheet will be created if the WBS Structure field mapping template is defined in
Gateway. The WBS Sheet sheet shows the WBS hierarchy, or structure, associated with the

activities.

Note: OOTB synchronization does not provide field mappings for the
WBS Structure. You must define the WBS structure mapping in
Gateway for the WBS sheet that has been created in Unifier.

The WBS Sheet sheet lists the WBS structure. All of the cost and units columns will be zeros
(Os) in Unifier 20.7. All of the predefined eight columns are displayed by default, with cost and
unit values as zeros (0s).

The System Data Elements that are available in the WBS Attribute form are not be editable,
but you can add additional data elements in the WBS Attribute form.
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You can add additional columns based on type directly as a cell entry, formula, or from:

» WABS Custom Attributes
» Business Processes
» Activity Sheet

Refer to the FRD ANSI EVM - WBS Sheet - Phase Il regarding additional columns and other
functionalities allowed in WBS Sheet.

Note: For duration based schedules, the WBS Picker does not show the
associated WBS Codes in the business processes, when the EVA
Sheet is not created.

Activity Picker in Business Process or Shells

When an Activity Picker that is based on P6 Activity Picker data definition is placed on a
business process upper form or detail form, or in the Shell attribute form in uDesigner, you can
use that picker to select activities from the Activity Sheet located within that shell.

When you select an activity by way of a P6 Activity Picker, the system displays the Activity
Picker log, as defined in uDesigner. The Activity Picker log lists all of the Oracle Primavera
Cloud Projects in the Projects drop-down, where you can select the current schedule and select
the activity sheet. After selecting the activity sheet, the hierarchy (similar to the one used in the
activity sheet) will be displayed.

The list of activities from the picker is filtered according to the query conditions defined within the
Data Picker configuration, in Unifier Admin mode.

The data elements that can be set to auto-populate from a picker will be populated from the
selected activity in the picker.

The data elements that have been set to reverse auto-populate (RAP) to Oracle Primavera
Cloud will RAP according to the RAP conditions, in uDesigner. If no RAP conditions are defined,
the data elements that have been set to reverse auto-populate (RAP) to Oracle Primavera Cloud
will RAP when the record is moved to next step (for Workflow BPs) and when the record is
marked as: Finish Edited’ (for Non-Workflow BPs).

The linked data elements using an activity picker get updated when the activity gets updated by
way of integration.

The auto-population will take place if the picker is set to auto-populate from another picker, and
also is set as a source to auto-populate into other data elements.

If a picked activity is deleted, then the system will remove the picker value, and the data
elements that hold auto-populated from that activity (the deleted activity) continue to display their
values. In such scenario, the system will remove the data elements that hold dynamically linked
values.
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Using Activity Sheet Data to Track Baseline,
Forecast, and Spends in Cash Flow

Cash Flow Analysis enables you to gain an idea of the financial health and liquidity of your
business, by showing what is actually available to use to meet your business needs.

You can use the CBS-type Cash Flow curve to get the Units, or Cost Data, from the Activity
Sheet as per CBS code either at the Activity level, at the Resource level.

You can use the Baseline Cash Flow curve to get the Planned, Remaining, and At Completion
units. In this case, the total for each CBS Code and Cost comes from the Cost Sheet column,
the Planned, or the At Completion costs (from the Activity Sheet).

Similarly, the Forecast Cash Flow curve brings the Planned, Remaining, and At Completion
units, or the costs per CBS Code (from the Activity Sheet).

You can use the Spends-type Cash Flow curve to get the Actual Costs from the Activity Sheet,
in addition to getting the costs from the Cost Sheet column, or from the P6 Summary Sheets.

You can perform Cash Flow analysis based on the budgets, forecast projections, and actuals
received by using the Planned, Remaining Cost, and Actual Costs received from the Activity
Sheet. In summary, for:

Cash Flow curves: CBS Detail, Baseline, and Forecast (Activity level)
Ability to define Baseline and Forecast Cash Flow curves with the Activity Sheet (Activity
level) selected as a source for distribution or cost. In this scenario:

The period distribution for each CBS Code will be received at Activity level, from the selected
Activity Sheet. The value is the sum of all the planned units for each CBS code by day which
it will be used to distribute the costs. The schedule will be disabled once you select Activity
Sheet as the distribution source.

The cost distribution for each period can either be calculated based on the units and total
cost received from cost sheet column, or based on the cost spread received from Activity
Sheet (Activity level).

You can get data either from the current project or the baseline.

Cash Flow curves: CBS Detail, Baseline, and Forecast (Resource level)
Ability to define Baseline and Forecast Cash Flow curves with the Activity Sheet (Resource
level) selected as a source for distribution or cost. In this scenario:

The period distribution for each CBS Code will be received at Resource level, from the
selected Activity Sheet. The value is the sum of all the planned units for each CBS code by
day which it will be used to distribute the costs. The schedule will be disabled once you
select Activity Sheet as the distribution source.

The cost distribution for each period can either be calculated based on the units and total
cost received from cost sheet column, or based on the cost spread received from Activity
Sheet (Resource level).

You can get data either from the current project or the baseline.
Cash Flow curves: CBS Detail, Spends (Activity level)

184



Using Activity Sheet Data to Track Baseline, Forecast, and Spends in Cash Flow

You can define Spends Cash Flow curves when the Activity Sheet (Activity level) is selected
as a source for cost. The value is the sum of all the actual costs for each CBS code per day
across the activities.

Cash Flow curves: CBS Detail, Spends (Resource level)

You can define Spends Cash Flow curves when the Activity Sheet (Resource level) is
selected as a source for cost. The value is the sum of all the actual costs for each CBS code
per day across the activities.

Similar to the P6 Summary Sheet, you can use the Activity Sheet as a source in Cash Flow.

The following table explains the details:

Type CBS

Baseline | Activity Sheet (Activity Level)

(Distributio | sym all the planned units for each CBS code by day which will be used to
n) distribute the costs. You can select either the current project or the
baseline. (Schedule disabled)

Activity Sheet (Resource Level)

Sum all the planned units for each CBS code by day which will be used to
distribute the costs. You can select either the current project or the
baseline. (Schedule disabled)

Baseline Cost Sheet Column
(Cost) Activity Sheet (Activity Level)

Sum all the planned costs for each CBS code by day. You can select if
this is from the current project or the baseline.

Activity Sheet (Resource Level)

Sum all the planned costs for each CBS code by day. You can select if the
from the current project or the baseline.

Baseline Schedule is derived from the unit distribution.

(Schedule)
Spends Activity Sheet (Activity Level)
(Cost) Sum all the actual costs for each CBS code by day.

Activity Sheet (Resource Level)
Sum all the actual costs for each CBS code by day.

Forecast |Activity Sheet (Activity Level)

(Distributio | Sum all the remaining or at completion units for each CBS code by day
n) which will be used to distribute the costs. (Schedule disabled)

Activity Sheet (Resource Level)

Sum all the remaining or at completion units for each CBS code by day
which will be used to distribute the costs. (Schedule disabled)

Forecast Cost Sheet Column
(Cost) Activity Sheet (Activity Level)
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Sum all the planned costs for each CBS code by day.
Activity Sheet (Resource Level)
Sum all the remaining or at completion costs for each CBS code by day.

Forecast Schedule is derived from the unit distribution.
(Schedule)

Activity Sheet with Resource-Loaded and
Cost-Loaded Schedules

For all of the CBS shells, the following Cash Flow curves can get data from an Activity Sheet:

» Baseline
» Forecast
» Spends

When you are defining a Baseline, Forecast, and Spends Cash Flow curves (when the detail
level is selected as CBS, based on the schedule type of the source project), the Activity Sheet is
available as a source for:

» Distribution
» Schedule
» Cost

The option is not available for Cash Flow curves when the detail level is selected as:

» By Project
» By Summary
» By Contract

The Cash Flow curve properties window enables you to select to get data from:

Baseline

General

Schedule sheets

P6 Source

» Activity Sheet

If you select Activity Sheet, then additional options (Cost, Schedule, and Distribution) will be

made available, based on the type of activity sheet that you select. In the case Resource-loaded
Activity Sheet and Cost-loaded Activity Sheet, the schedule is derived from the source.

»
»
4
4

The other fields in the Cash Flow curve properties window enable you to select the distribution
method and schedule for the Cash Flow curve based on the source of the Activity Sheet.

An Activity Sheet can be linked to more than one source project.
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If an Activity Sheet is linked to two or more source projects, then if at least one source project is
duration-based and the other source projects are resource-based, or Cost-loaded, then the other
fields in the Cash Flow curve properties window will be based on resource-loaded or cost-loaded
projects.

When the source project and the Activity Sheet (Activity level) are selected as source, the
properties window for the Baseline Cash Flow Curve type enables you to select:

Where to get the original data
Activity sheet name

Data type

Cost

Schedule and distribution method
Variance

v v v v v Vv

For Resource-loaded and Cost-loaded schedules, the properties window for the Baseline Cash
Flow Curve type enables you to select cost, schedule, and distribution. When you select Activity
Sheet, as a source, the Sheet Name drop-down field allows you to select one of the following
system activity sheets, from the project activity sheets:

» System Activity Sheet (Activity)
» System Activity Sheet (Resource)

By default, the System Activity Sheet (Activity) option will be selected.

Note: The Baseline Cash Flow curve type will display the data from the
system activity sheet, if the source is a single project.

In the properties window, the Project Type drop-down field enables you to select the following
project schedules:

» Current Project
» Baseline Project

These options are available based on the schedules that have been received.
Note: If you do not receive a Baseline project spread, then the options
above will not be displayed.

By default, the Current Project option will be selected.

When you select Activity Sheet as the source and Sheet Name as System Activity Sheet
(Activity), the Cost drop-down field allows you to select the following options:

» Manual
» Cost Sheet Columns
» Activity Sheet Columns

The Cost Sheet Columns option enables you to display all of the columns of the Cost Sheet.
The Activity Sheet Data Sources will display the Planned, At Completion, and Remaining
Costs, based on the Sheet Name that you have selected.

In the scenarios above, the Cost options are:
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Use the Cost option to select one of the cost sources for the Baseline Cash Flow curve type.
By default, the Manual option is selected.

The Schedule & Distribution drop-down field displays all of the units based on the Sheet
Name and the project type that you have selected. If you select the Cost as Activity Sheet
Columns, then the Schedule & Distribution field drop-down will be disabled while displaying
From Activity Sheet.

The Schedule & Distribution drop-down field displays the following options when you select
Sheet Name as System Activity Sheet (Activity), and the Cost is selected as Cost Sheet

Columns or Manual:

» Planned Total Units
» At Completion Total Units
» Remaining Total Units

By default, the value in the drop-down field will be Planned Total Units.

The following table lists the various selections and results:

When Sheet
Name is selected
as:

Project type is
selected as:

Cost options are:

Schedule & Distribution options
are:

System Activity | Current Project | Activity Sheet From Activity Sheet option
Sheet (Activity) |or Baseline Columns: selected and disabled.
Project » Planned
Total Cost
> At
Completion
Total Cost
» Remaining
Total Cost
System Activity | Current Cost Sheet Will show following options:
Sheet (Activity) | Project/Baseline | Columns » Planned Total Units
Project » At Completion Total Units
» Remaining Total Units
System Activity | Current > At From Activity Sheet option
Sheet (Resource) | Project/Baseline Completion |selected and disabled.
Project Cost

» Remaining
Cost

» Planned
Cost
System Activity | Current Cost Sheet Will show following options:
Sheet (Resource) | Project/Baseline | Column » At Completion Units

Project

» Remaining Units
» Planned Units
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The following explains Forecast Cash Flow curve properties for when the Activity Sheet is
selected as a source:

» Start at the end of the actuals. Use the drop-down field and select the actuals curve. The
drop-down field displays all of the actual curves that have been defined with the Cash Flow
curve family.

Note: The Forecast options will be disabled if the Activity Sheet is the
source of data.

Replace the current period Forecast with the actuals on the cut off date.

For the unassigned amount, the auto-distribution options will be enabled. You can select the
redistribution of unassigned amount based on the weighted average calculations.

» The period close settings option is not applicable to Spend, if the period close settings are
received from the Activity Sheet.

The following explains Spends Cash Flow curve properties for when the Activity Sheet is
selected as a source:

In the Spends Cash Flow curve properties, you can select the source of cost as Activity Sheet.
The Spends Cash Flow curve properties has the following Cost and Distribution options, based
on the source that you select:

» Where to bring the approved Spends data from.

The Bring <Spends Curve name> data from drop-down field displays a list of sources that
you can use to bring the actuals cost and distribution. If you select Activity Sheet from the
list, then the Sheet Name field value will be activated and provides the list of sheet names,
both at the Activity level and Resource level.

» Sheet name

The Sheet Name drop-down field displays the Activity Sheets in the project, which is a single
activity sheet or the System Activity Sheet. The following are the options available for the
Sheet Name drop-down field:

» System Activity Sheet (Activity)
» System Activity Sheet (Resource)
» Cost
The Cost drop-down field displays:
» The business process columns that are available in the Cost Sheet.
» The formula columns which are based on the business process.

» The Activity Sheet column, Actual Total Cost, if the Sheet Name is selected as
System Activity Sheet (Activity).

» The Activity Sheet column, Actual Cost, if the Sheet Name is selected as System
Activity Sheet (Resource).

» Schedule & Distribution

» This option displays Actual Total Units when you select Cost as the Cost Sheet
column, and the Sheet Name is selected as System Activity Sheet (Activity).

» This option displays Actual Units when you select Cost as the Cost Sheet column, and
the Sheet Name is selected as System Activity Sheet (Resource).
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» Variance

The following table shows the various selections:

Sheet Name Cost Schedule & Distribution
System Activity Sheet Cost Sheet Column Actual Total Units
(Activity)

System Activity Sheet Cost Sheet Column Actual Units

(Resource)

System Activity Sheet Actual Total Cost From Activity Sheet text
(Activity) selected and disabled.
System Activity Sheet Actual Cost From Activity Sheet text
(Resource) selected and disabled.

If you select the Cost option, then Unifier draws the Spends Cash Flow curve by using the
Actual Cost spread, Actual Start Date, and Actual Finish Date for each CBS Code, from the
selected Activity Sheet.

The following topics explain the various Baseline and Forecast Budget (Cost Distribution)
Cash Flow curve properties for when the Activity Sheet is selected as a source:

» Baseline curve or Forecast curve when Schedule & distribution are derived from the
Activity Sheet and Cost is derived from the Cost Sheet

» Baseline curve or Forecast curve when Schedule & distribution and cost are derived
from the Activity Sheet

» Baseline curve or Forecast worksheet when Schedule, distribution, and cost are
derived from the Activity Sheet

» Baseline curve or Forecast worksheet when Schedule, distribution, and cost are
derived from the Activity Sheet

When you select the original source as Activity Sheet for the Baseline Cash Flow curve, the
From and To dates and the spread for each CBS Code will be derived from the selected Activity
Sheet and Project Type. Unifier uses the spread data from the selected Activity Sheet to draw
Baseline Cash Flow curve (the period units are coming from the activity spread, and the cost
will be derived either from the Cost Sheet column, or from the activity spread.

Baseline curve or Forecast curve when Schedule & distribution are derived from the
Activity Sheet and Cost is derived from the Cost Sheet:

You can select the following distribution and cost sources when the data is originating from
the Activity Sheet:

190



Activity Sheet with Resource-Loaded and Cost-Loaded Schedules

Distribution Cost Cost per CBS Code

Sheet Name: System Cost Sheet Column: | Cost for each unit per CBS Code =
Activity Sheet (Activity) Assigned Budget Total cost from the Cost Sheet
Project Type: Current column/ The number of total units.
Project Cost for each period per CBS Code =
Data Source: Planned The number of units * Cost per unit.
Total Units

Example

Monthly time scale: Sample monthly unit spread for CBS Codel which is coming from
Planned Total Units in the above scenario:

January |February |March April May June July

CBS 100 100 100 100 100 100 100
Code 1

If Total cost per CBS Codel = $70000, then the cost per unit = $70000/700 = $100 and cost
per period will be = 100 * $100 = $10000

Monthly time scale: Sample cost spread for CBS Codel for each period will be calculated as
follows:

January |February |March April May June July

CBS $10000 [$10000 |$10000 |$10000 |$10000 |[$10000 |[$10000
Code 1

The above Cost spread sample will be distributed in the Baseline Cash Flow curve. If the
user selects Sheet Name: Activity Sheet (Resource level), with resource units selected as
distribution source, and the cost source is coming from the Cost Sheet column, then sum all
of the Planned units for each CBS Code by day which it will be used to distribute the costs.
The Cost per unit will be calculated as shown above. The user should be able to select the
units spread from either the current project or the Baseline. The cost distribution will be done
in the similar way (as shown above) for the other time periods such as yearly scale or
financial periods.

Baseline curve or Forecast curve when Schedule & distribution and cost are derived from
the Activity Sheet:

You can select the following distribution and cost sources for the data that is originating from
the Activity Sheet:

Distribution Cost Cost for each unit per CBS Code
Sheet Name: System Cost in this case is | The cost will be calculated in the
Activity Sheet (Activity) coming from source Activity Sheet itself using the
Project Type: Current Planned Total Cost | units and assigned role or resource
Project spread data at rate at Activity level.
Data Source: Planned | Activity level for each| cost for each period per CBS
Total Cost CBS Code. Code: Sum of all planned costs for
each CBS Code at activity level.
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The sample cost spread for the CBS Code 1, when the selected Planned Total Cost in the
above scenario is as follows:

Note: In this case, the cost spread data will be received from the
selected Activity Sheet (either from current project or Baseline).

January |February |March April May June July

CBS
Code 1

$100 $100 $100 $100 $100 $100 $100

If you select the new distribution and cost options from the Activity Sheet, then:

4

4

4

4

Both the cost and dates will be received from the Activity Sheet spread data.

The forecast curve, which is set to begin at the end of actuals curve, shows data from the
data date instead of the current period.

You can select distribution from the Activity Sheet and cost from the Cost Sheet column,
or manual, so that the cost spread will be calculated using the total spread units from the
Activity Sheet, and the total cost received from the Cost Sheet, or entered manually.

The Project Type drop-down field and the Data Source field enables you to get the units
or cost spread from the Activity Sheet current project or baseline. The values for the
fields are Planned, At Completion, and Remaining. By default, the Planned options is
selected.

For the Forecast Cash Flow curve, the spread data (units or costs) comes from Planned,
At Completion, and Remaining costs or units. In the Forecast Cash Flow curve the
default data source is At Completion. The Forecast Cash Flow curve that is set to begin
at the end of actuals shows the actuals received as of current date, from the Activity
Sheet or from the Cost Sheet column, and the remaining periods show the spread data
received from the Activity Sheet (including the redistributed unassigned amount). The
unassigned amount is redistributed in the remaining periods, based on the selected
weighted average option.

Baseline curve or Forecast worksheet when Schedule, distribution, and cost are derived
from the Activity Sheet:

For each CBS Code in the Baseline or Forecast worksheet, when the source is selected as
Activity Sheet:
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From Date will be the earliest date (beginning period from the selected Project spread
data). This can be either at Activity level or Resource level based on the sheet name that
you have selected. Similarly, the dates come from the current project or baseline.

To Date will be the latest date (from the selected Project spread data). This can be either
at Activity level or Resource level based on the sheet name that you have selected.
Similarly, the dates come from the current project or baseline.

From Date and To Date are read-only.
The Profile column remains empty and will be read-only.
The Period data shows the costs distributed from the spread.

The distributed costs can be calculated when units are coming from the Activity Sheet,
only (you can bring the costs from the Activity Sheet). The data will be read-only, similar
to the data received from the P6 Summary Sheets.
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Note: The project picker will not be available in the worksheet. You can
see the project picker when you are allowed to pick a project as source.
In this case, the data is filtered (in the graph and worksheet) based on
the project.

» The worksheet tab enables you to export.
» The Cumulative and Incremental graphs are available.

» The unassigned amount in the Forecast curve, or Baseline curve, is redistributed in the
remaining periods, based on weighted average option that you have selected.

Spends Curve and Data Distribution

The following explains:

» When both cost and distribution is coming from Activity Sheet

» When the total actual cost is derived from cost sheet and schedule/distribution is derived
from Activity Sheet

When both cost and distribution is coming from Activity Sheet

You can define the Spends curve to get the actuals spread data from the Activity Sheet for the
Resource loaded or Cost loaded projects. When you select the Activity Sheet as a source for the
Spends curve, Unifier will derive the distribution and actual costs from the Activity Sheet. The
actual spread data will be coming from the current project.

The From Date and To Date fields are displayed according to the values of the earlier Actual
Start Date and Date which is across the activities, per CBS Code for In progress activities. The
From Date and To Date fields are read-only.

Note: The Data Date field value can be in the past, current, or in the
future. The Actuals are always shown, until the date of the Data.

The Actuals in periods show the spread data coming from the Activity Sheet that you have
selected.
The distribution data is read-only.

The Actual spread data as of the data date is displayed in the Forecast curve worksheet if in the
Forecast curve properties, the curve is set to begin at the end of the actuals.

The graph shows both the actuals (cumulative and incremental values).

The Actual spread data per CBS Code will be until the data date. For example, if the Actual Start
is 02/10/2020 and Data Date is 08/15/2020, then the Actuals cost spread will be shown until the
data date (08/15/2020), in the worksheet.

From |To Feb Mar Apr May Jun Jul Aug
Date Date

CBS |02/10/2|08/15/2|$100 |$100 [$100 |$100 |$100 |$100 |$100
Code 1 {020 020

Forecast with Actuals

193



Unifier Earned Value Management User Guide

When you select the source as Remaining Total Cost, or Remaining Total Units, the
remaining spread data will be used as source for the Forecast curve. The Actuals will be
seen as of data date, and the remaining spread will start from the data date. For example, in
the table above, the month of August will show the Actuals as of date + remaining Forecast
data ($700 + $100).

From |To Aug |[(Sep |Oct |Nov |Dec |Jan |Feb [Mar |Apr
Date |Date
CBS |08/15 [04/15 |$800 |$100 [$100 |[$100 |$100 [$100 |[$100 |$100 [$100
Code |/2020 (/2021
1

When the total actual cost is derived from cost sheet and schedule/distribution is derived
from Activity Sheet

You can receive the Actual spread units from the Activity Sheet, and the total payment amount
from the Cost Sheet column. In this case, the Actual cost can be calculated as the number of
actual units * actual cost per unit. See the following example for the monthly time scale:

January February
CBS Code 1 50 10
CBS Code 2 0 20

In this example, if the total actual cost (received from the Cost Sheet column) for CBS Code 1 is
$6000, and the CBS Code 2 is $1000, then the actual cost per unit will be as follows:

January February
CBS Code 1 $50000 $1000
CBS Code 2 $1000

Additional Information:

»

»

If an Activity Sheet has more than one mapped source projects, then Unifier displays the
following message: You cannot view the data because the system activity sheet is mapped
to more than one source project with different data dates.

Note: Cash Flow curves will receive data from the System Activity Sheet
mapped with multiple source projects, if they all have the same data
date.

If you select an Activity Sheet as a source to one or more Cash Flow curves in the Cash
Flow detail curves, then you cannot open the Cash Flow curve in Classic View, and Unifier
displays the following message when you try to open a Cash Flow worksheet, or properties,
in Standard View: The source for one or more curves is Activity Sheet. You cannot view the
curves in Classic View.

If an Activity Sheet has not been created in the project, then the drop-down field will not
display Activity Sheets as an option for the Baseline, Forecast, and Actuals Cash Flow
curves.
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» The Baseline, Forecast, and Actuals Cash Flow curves show the properties irrespective of
the schedule type for the System Activity Sheet. Furthermore, the Sheet Name drop-down
field displays manual activity sheets that are created in the project.

» The Cash Flow worksheet does not show the data for the Cash Flow curves that are based
on the Activity Sheet, if there is no cost spread or unit spread associated with the activities in
the selected Activity Sheet.

P6 Activity Picker in Business Process or Shell
Details

When you access a business process form, or a shell attribute form, with activity sheets (both
system activity sheet or manual activity sheets) and create a new form, the Create New <form>
window opens. In this window, you can go to the P6 Activity Picker field, click Activity Sheets,
and open the P6 Activity Picker window.

In the P6 Activity Picker window, the Activity Sheets field drop-down displays a list of all of the
active activity sheets, in alphabetical order. In the case where the multiple source projects are
integrated with System Activity Sheet, the Activity Sheets drop-down shows the source projects
prefixed with "System Activity Sheet," for example: System Activity Sheet - <Source Project1>,
System Activity Sheet - <Source Project2>, and so forth. You can switch between the activity
sheets and select a specific activity sheet to populate the information on to the business process
or attribute forms.

The activities are filtered according to the query conditions defined within the Data Picker
configuration in uDesigner (Company Workspace > Admin mode > uDesigner > <Business
Process or Shell Attribute form>) where P6 Activity Picker field is added.

The form fields that have been set to auto-populate from P6 Activity Picker field will get
auto-populate from the selected activity attributes.

The form fields that have been set to Reverse Auto-Populate (RAP) to the Activity Sheet will get
Reverse auto-populated from the conditions specified in uDesigner or the latest data will be
reverse auto-populated (updated) back to the Activity Sheet when "Send" in the Workflow, or
"Submit" in the Non-workflow BP, is used. Similarly, when the user clicks "Save" in the shell
properties, the updated date will be reverse auto-populated (RAP) back to the activity sheet.

The form data elements that are linked to the attributes form from a P6 Activity Picker field will
get updated as the P6 activity data gets updated by way of integration.

Auto-population will complete if the P6 Activity Picker field is set to auto-populate from another
picker, and the P6 Activity Picker field is also selected as a source to auto-populate other data
elements on the form.

If you delete a selected (picked) activity sheet, then Unifier clears the picker value for the
existing records, but the auto-populated values will remain as they are. Similarly, Unifier clears
the linked data elements if the selected (picked) activity sheet no longer exists.

Additional Information about P6 Activity Picker

» The P6 Activity Picker is supported when creating records through CSV import and RESTful
services.
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» When more than one P6 project is associated with the System Activity Sheet, the CSV
template, or the RESTful call, accepts the following format for P6 Activity Picker value: <P6
Project ID> ~~ <Activity ID>

» If the Unifier project has manual activity sheets defined, then the following format is allowed
in the input CSV file and RESTful services to select an Activity: <Activity sheet Name> ~~
<Activity ID>

» If the Unifier project has System Activity Sheet with multiple projects, or a single
source-project, then the following format is allowed in the input CSV file and RESTful

services for the selection of Activity ID: <System Activity sheet - P6 Project ID> ~~ <Activity
ID>

WBS Picker in a Business Process

The WBS Picker field in a business process form has an additional toolbar option (Source) that
shows the source value as either P6, Primavera Cloud, or Custom. The Source field drop-down
will display "Custom" by default and all of the WBS Codes from the Project WBS Sheet will be
shown.

You can switch between different sources (P6 or Primavera Cloud and Custom) if your project
has both Project WBS Sheet and System WBS Sheet. The WBS Codes created from the
selected source will be shown in the Picker window.

To select the code, the WBS Code shows the entire path.
You can select a unique WBS Code to add a cost transaction.
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The Earned Value Manager enables you to do the following by using one of the nodes.

» Perform earned value analysis corresponding to the activity sheet in a shell.
» Run the earned value analysis of cost loaded projects directly.
» Generate reports on EVA scenarios.

The Earned Value Manager module contains the following nodes:

» Earned Value Analysis
» Earned Value Analysis Report

To access the Earned Value Manager module:

1) Go to your shell in user mode.
2) Click Earned Value Manager module to expand.

The following provides details about each node.

In This Section

Earned Value ANAIYSIS .........ouueiiiiiiiiiiiiiiiiee e 197
Earned Value AnalySiS REPOIM........cciiiiiiiiiiiii e e e 214

Earned Value Analysis

The Earned Value Analysis node (Earned Value Manager module > Earned Value Analysis
node) in Unifier is based on the scheduling set of data (activities and rates) imported from P6
through integration. The Earned Value Analysis node allows you to:

» Perform earned value analysis corresponding to the activity sheet in a shell.
» Run the earned value analysis of cost loaded projects directly.

Note: For resource-loaded projects, you must calculate resource and
role rates before analyzing earned value and other matrices.

Planned Value (PV), Actual Value (AC) and Earned Value (EV) are required to calculate
variances, indexes, and at completion project values. Unifier performs all calculations in the
Activity Sheet and rolls up the values to the Earned Value Analysis scenario. The values
corresponding to each project, WBS (Work Breakdown Structure) or CBS (Cost Breakdown
Structure) are used to plot different graphs, thus providing a visual way to determine the health
of projects, and Forecast future outcomes based on the performance indexes.

Earned Value metrics can be categorized as under:

Basic » Planned Value (PV)
» Actual Cost (AC)
» Earned Value (EV)
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Cost Variance (CV)
Schedule Variance (SV)

Variances

Schedule Performance Index (SPI)
Cost Performance Index (CPI)
Cost Schedule Index (CSI)

Indexes

Estimate to Complete (ETC)
Estimate at Completion (EAC)
To Complete Performance Index (TCPI) by EAC or BAC

Forecast

v v VvV |(|Vv v Vv | ( Vv W

Earned Value Analysis Log Window

The Earned Value Analysis log lists the earned value analysis. To access the Earned Value
Analysis log, go to the shell (User mode), click to expand the Earned Value Manager module,
and click Earned Value Analysis.

Note: The location may differ in your implementation based on the
Project/Shell User Mode Navigator configuration.

You can use the Earned Value Analysis log to:

» See a list of analysis.
» Review the following information (on the right-hand pane of the log) about a selected
analysis:

» Preview

» General

» Properties
» Schedule
» History

The Earned Value Analysis log has the following toolbar options:

» Create (see below for details)
» Data Refresh

Use this option to manually update the summarized values retrieved from the shell activity
sheet. The values in the scenario are not updated automatically if there are changes in the
associated activity sheet.

» Delete
Use this option to delete the analysis.

The Earned Value Analysis log has the following columns:

Name
Description
Activity Sheet

>
>
4
» Cost Sheet Column
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Graph Type

Performance Measurement Technique
Created By

Created Date

Last Refreshed

Last Modified

v v v v v Vv

The Earned Value Analysis log lists the analysis and each analysis has a gear menu (ﬂ') that
can be used to:
» Open
To open and view the select EVA.
» Open Grid Indicators

To open the Grid Performance Indicators window and color-code the grid values
corresponding to the variances and indexes. Depending on the options that you have
selected, you can define the range to color-code Project, WBS, or CBS performances. The
settings will be applied to all of the sheets in the log. Currently, there is only one EVA sheet
and color-code settings apply only to the existing sheet.

This option is available to all users who have the Create permission.
The Grid Performance Indicator window has the following toolbar options:
» Add: To add a new color indicator.
» Find on page
» Save
» Cancel
The Grid Performance Indicator window has the following columns:
Error (indicator labeled with an x icon)
» No.

» EV Metrics: This is a value selected for the Select Metrics drop-down field. It allows you
to select the metrics that you want to color-code. There are no restrictions on the number
of scenarios that you can create. The following options are available when you
double-click in the cell and activate the drop-down field:

= Schedule Variance

= Cost Variance

= Variance at Completion

= Cost Performance Index

= Schedule Performance Index

* |ndex

= Cost Schedule Index
= TCPI (EAC)

= TCPI (BAC)

» Condition: This enables you to select the following conditions or values for users who
can create criteria for color-coding (double-click in the cell to activate the drop-down
field):
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4

equals

greater than

greater than or equals
less than

less than or equals
between

To prevent overlapping of conditions or values, the following priority order is used:

Equals will override any other defined condition.
Between will override any other defined condition, except equals.

In case of less than and less than or equals, the lower value will override the
higher value.

In case of greater than and greater than or equals, the higher value will override
the lower value.

In case of conflict between a value which comes under less than/less than or
equals and greater than or greater than or equals, Unifier displays the message:
Overlap in the conditions defined.

Text box: This field (Value 1 and Value 2) can be a single text box or two text boxes
(condition = between), depending on the condition selected.

Color: This is a drop-down field that allows you to select the color corresponding to the
criteria that you have created. The following are the values (double-click in the cell to
activate the drop-down field):

Black
Red
Purple
Orange
Yellow
Green
Blue

The gear menu (ﬂ') option Delete enables you to delete the color indicators.
» Open Performance % Completion

To open and view the historical performance percentage completion values of a project
activities against data dates. Unifier uses the values to calculate earned value metrics.

» Delete
To delete the analysis.

The Earned Value Analysis log displays the analysis properties on the right-hand pane within
the following tabs:

» Preview
General
Properties
Schedule
History

4
4
4
4
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Tip: Click the expand icon, in the right pane, to better view the tab details.
The following explains each tab in details.

Preview Tab

The Preview tab enables you to preview the earned value analysis for the P6 projects (cost
loaded and resource loaded) in the Activity Sheet without opening the Earned Value Analysis
sheet.

» The upper section in the tab displays a graph with consolidated information of PV and AC
across data dates. A vertical blue bar represents the last data date.

» The lower section shows the Summary Table with columns displaying EV metrics and
derived values: BAC, EAC, PV, EV, AC, ETC, RC, CV, SV, VAC, CPI, SPI, CSI, TCPI(EAC),
TCPI(BAC) for projects satisfying the last data date.

General Tab

The Preview tab enables you to enter details, export details as template, and import data. To
populate the fields in the General tab, you can export a template (use the export icon), enter the
values in the exported template, ensuring that all columns, or conditions, are completed or met,
save the template, and import the template back to Unifier.

Properties Tab

The Properties tab enables you to update the following fields:
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Name

Description

Activity Sheet

Graph Type

Progress Measurement Technique

Template ID

Cost Sheet Column

The logical sources will show the entire cost data regardless of the data date.

Below the Cost Sheet Column field, the Technique for computing estimate to complete
(ETC) block enables you to select the ETC calculation method.

v v v vV vV v Vv

The Activity Sheet and Name fields are read-only and populated with the values you entered
when creating the earned value scenario.

The Description field is an editable field.

The Cost Sheet Datasource is editable, so you can update the Cost Sheet Datasource for the
Earned Value Analysis.

Select Graph Type (optional): Data Date or Period Based

Schedule Tab

The Schedule tab enables you to see the frequency for updating the data (Data Refresh). The
Schedule tab is consistent with the Schedule tab in other EVM-related places.

In the Frequency drop-down list, select from Daily, Weekly, Monthly, or Quarterly options,
select start and end dates and click Save.

Select None in the Frequency field to discontinue the automatic refresh of the earned value
analysis sheet.

History Tab

The History tab enables you to see the following information about the past events related to
the activity sheet:

» Action
» Requestor
» Initiated On
» Start Date
» End Date
» Status

The History tab is similar to the History tab in other EVM-related places.

» The grid displays the details of scheduled refreshes only.

» The columns list the action taken (data refresh only), the name of the user who initiated the
scheduled refresh, date and time the scheduled job is initiated, start and end dates for each
refresh job, and the status of the refresh process (Completed, In Progress, or Failed).
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» Select an item to view details in the History Details section below. Click Refresh to refresh
the status of an ongoing job.

Creating an Earned Value Analysis Sheet

In the Earned Value Analysis log window, use the Create option to create an EVA sheet by
following the details below:
1) Click Create to open the New Earned Value Analysis window.
2) Inthe Name field, enter a name.
3) Inthe Description field add a description (optional).
4) From the Activity Sheet drop-down select an activity sheet.
5) From the Graph Type drop-down select one of the following sources:
a. Data Date Based
b. Period Based

6) From the Progress Measurement Technique drop-down select one of the following
sources:

a. Cost Based
b. Unit Based
7) From the Template Id drop-down select one of the Earned Value Analysis (1 through 6).
8) From the Cost Sheet Column drop-down select a cost sheet column.
9) Click Save to save the newly created EVA sheet.
You can create multiple EVA scenarios with different properties, performance indicator settings,
and details in general tab. Each EVA will have a different PPC for the activities under the

project. This will enable you to prepare reports, and see the trend depending on their
preferences. You are also able to select the EVA sheet from the rolled up data in Cost Sheet.

Note: Except the grid performance indicator, if you select any other
action, then Unifier displays the alert asking you to select 1 record.

Earned Value Analysis Sheet

To access the EVA sheet:

1) Goto the Earned Value Analysis log window.
2) Click to select your sheet.

3) Click the gear menu (ﬂ) to open and select Open. The Earned Value Analysis sheet
opens in new window. Alternatively, you can double-click on the sheet to open the sheet
window.

The upper section of the EVA sheet is fixed and viewed across all tabs. It includes the toolbar
functions and a dynamic data table. The following explains the elements.

Filter Y To adjust the view for particular information.
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To print the sheet.

Print

Data Date This field has a drop-down menu with historical dates. This is
available for graph based on Data Date.

Projects This field enables you to open the Project Picker window and select
a project. The information is constrained with value in Data Date
field. The Project Picker window enables you to Find on Page.

Period The drop-down list with weekly, monthly, quarterly, half a year,
yearly, and if applicable, financial period that has been selected in
the shell. This is available for graph based on Period.

WBS or CBS This toggle option is followed by the corresponding picker in the

drop-down adjacent field (WBS Code or CBS Code drop-down). The picker
user interface has Expand, Collapse, and Find on Page. the values
are constrained by selections in the previous fields.

Select the WBS graph and click WBS picker to filter by the OBS.
The WBS picker will also display the WBS codes from the Unifier
project, if the Unifier project is selected from the Projects Picker.

WBS Code or Click to open and select from WBS Picker or CBS Picker windows,

CBS Code respectively.

drop-down

Cost & Rate Displays all rate- and cost-type breakdowns available. It enables you

Type to select a rate-type or a cost-type grouping. Once you select the
breakdown rows to filter, then all of the costs will be displayed based
on breakdowns that you had selected.

Apply Click to apply selections in the drop-down fields.

Reset Click this to remove any zoom or filters applied via the curve picker.

The middle section of the EVA sheet contains a Dynamic Data Table.

The headings for the dynamic data table are as follows, depending on the graph type:

» Project

» All is displayed when all projects have the same data date.

» All (Filtered) is displayed when there are projects with differing data dates, and projects

with the selected data date are filtered in the view.

» WBS

Displays the calculated values for the point plotted in the graph.
» Cost & Rate Type
Displays the cost and rate types in the graph.
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The other headings may include:

» Date

» Related EV metrics labels based on the tab. For example, in the Cumulative tab, the
columns show PV, EV, AC, ETC, RC, CPI, and SPI.

The middle section of the EVA sheet contains the following tabs:

» Cumulative

» Incremental (only applicable to period based graph.)
» At Completion

» Variance

» Indices

Depending on the tab that you select, you get the pertinent graph.

Curve Picker: Filter curves you want to view by selecting or clearing the colored boxes in the
legend.

Unit Based
Earned Value Analysis - Graph

All of the Planned Units and Actual Units will be rolled-up for Project, WBS, and CBS from the
Activity Sheet. The EV value will be calculated using the following formula:

EV Units = BAC Units* PPC

Earned Value Analysis - Grid

For the Graph Type Unit based, the Grid will display units instead of costs (Planned units,
Actuals Units, and so forth). The Variances, Indices, and At Completion values will also be
updated based on the values.

Earned Value Analysis - Top bar

For the Graph Type Unit based, the bar will display units instead of costs (Planned units, Actuals
Units, and so forth). he Variances, Indices, and At Completion values will also be updated based
on the values.
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Remaining Cost > Remaining Cost/Units
Cost Sheet

After you create multiple EVA graphs, the cost sheet drop-down menu displays all the
cost-based graphs.

Roll up Actuals to EVA

The Amount and the uuu_quantity fields are going to rollup to the WBS Sheet. They will be
used to feed into the Actuals in the EVM sheet. Unlike the existing column in the Cost Sheet
that creates a new row in the EVM sheet, the new BP will rollup to the WBS and CBS for a P6
project. Since Unifier captures units in the EVM, you can add uuu_quantity and have the units
roll up to the EVM sheet.

Cost Based EVA Scenario

In the EVA Sheet, The Actuals amount will be rolled up by associated WBS when you select a
new Cost-type BP (CBS or WBS) column as the Cost Sheet column source. You can see the
Actuals associated with the selected WBS codes by using filtering.

When you filter by WBS codes in the EVA, the Actuals data will be in two separate rows (both
Unifier and P6 Actuals).

By default, in the Project view, all the Actuals (including the actuals from cost sheet column
source) are displayed.

The Actuals amount will be rolled up by associated CBS when filtered by CBS codes, in
Cost-based EVA scenario. When selected filter by CBS or by P6 Projects, you can see the
Actuals for Unifier and P6 for the filtered CBS codes, separately.

Filtering by CBS codes in EVA Sheet

The Rolled up Actual cost will be displayed in the EVA Sheet for the selected CBS codes
only when there is a valid CBS-WBS combination allocated for the line item. That is to state,
the Rolled up Actual cost will be displayed in the EVA Sheet for selecting any CBS assigned
to receptive Activity and selecting WBS code from the same p6 project.

Filtering by WBS codes in EVA Sheet

The Rolled up Actual cost will be displayed in the EVA Sheet for the selected WBS codes
even when there is an invalid CBS-WBS combination allocated for the line item. That is to
state, the Rolled up Actual cost will be displayed in the EVA Sheet for selecting any CBS
assigned to receptive Activity and selecting WBS code from the the same, or different, p6
project.

Units Based EVA Scenario

The WBS Sheet column field is available in unit based EVA scenario as the Actual source. The
list of sources available are all WBS Sheet columns which are of type SYS BP Decimal Amount.
You can select any of the new CBS- or WBS-type BP columns (which are of SYS BP Decimal
Amount added in WBS Sheet as WBS Sheet column source).

The Formula columns which are based on CBS- or WBS-type BP of SYS BP Decimal Amount
should are available to select.

By default, the Actual Units (per project) include the quantity (rolled up from new Cost-type BP)
when the Actual Units are selected as WBS Sheet column source.

206



Earned Value Manager

The Actual Units (uuu_qguantity) by associated WBS codes are displayed when you filter the
WBS codes.

Similarly, when CBS codes are filtered, the associated Actual Units are displayed. The same is
applicable when other Cost-type BPs are also selected as the Cost Sheet column source. The
graph includes the Actual Units from WBS Sheet column source.

Cumulative Tab

Like the Preview tab in the log, the Cumulative tab displays an upper graph and a bottom
summarized table in the Cumulative Values and Indices section. It shows data as of the last
Data Date.

Note: All other tabs display a graph only.

As you move the cursor across the curves in the graph, a flagged indicator displays the curves,
dates and values at the selected point in a curve. The indicator is color-coded for specific curves
as per the legend. The tool-tips provide the expanded form of acronyms. The last data date is
represented by a vertical blue bar. If available, data dates preceding the last data date are
displayed. After the last data date, weekly intervals are indicated along the X-axis for the
duration of a year.

The zoom control is enabled by using the mouse wheel; values on X- and Y-axes remain static.
You can also drag the zoomed area along the X-axis; the X-axis intervals remain constant.

The Cumulative Values and Indices section toolbar has Export, Find on Page, and a toggle
Expand or Collapse buttons. While the columns present values for earned value metrics and
derivatives, the rows list the projects for the selected data date in separate rows.

Depending on the selection that you have made in the filter, the grid that is displayed follows
theses scenarios:

Scenario One:

If you select Project with CBS filter:

The Summary (filtered) shows the actuals in the activity sheet that corresponds to the P6
project and the CBS selected from the filter.

The Summary (P6) displays the actuals that corresponds to CBS across all the P6 projects
(from the activity sheet) until the Data Date that has been set or selected in the filter.

The Summary (Unifier & P6) displays consolidated amount from actuals (summary p6) and
the sum of cost sheet actuals for CBS corresponding to the column selected during the EV
creation until the data date selected in the filter.

Scenario Two:
If you select Project with WBS filter:
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No additional summary row.
Period based graph
EVA Graph (Cumulative, At Completion, Indices & Variance)

If a user selects Graph Type as "Period based" for a particular Earned Value analysis scenario
then:

The data date drop-down does not appear in the graph. Instead, a new drop-down is displayed
(Periods) with the following options:

> Weekly

» Monthly

» Quarterly

» Yearly

» <Financial period name> selected in shell details tab (if applicable)

If the graph type is Periods, you can select multiple projects with same or different data date.

Any Actual value of other projects, after the least data date among the projects, will be
presented as Forecast.

For the existing users, when plotting the graph based on periods, the old financial period data,
using the current baseline, is displayed.
Note: The data for each project is locked until the project data date.

Also, the data which is being displayed in the graph will be updated according to the financial
period that is selected.

Note: The graph shows weekly data points on x-axis and filters the
project with same data date.

If you have selected the period type as financial period, then the data for all, or filtered, projects
will be consolidated and plotted in the graph. The Data points on the x-axis will be the period
end date.

The following two scenarios explain the results of your selections:
Scenario One:

If the user selected weekly, monthly, quarterly, or yearly from the drop-down, then the start
date of the first sub period will be the least project start date across all projects. The last sub
period will be determined based on the last data date across all projects. In other words, the
end date of last sub period should be greater than the last data date across all projects.

Scenario Two:

If the user has selected a financial period defined under Standards & Libraries, then the
graph will only display the data between the first sub period and the last sub period.
Everything else will be filtered out of the graph.
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Incremental Tab

In Unifier, you can generate the earned value analysis graph based on the data date
corresponding to a P6 Project. The graph shows the EV and Actuals data from project start date
until the most recent data date, and every data date which lies in between.

You can also plot the graph based on periods.
EVA Graph (Incremental)

If you select Graph Type as "Period based" (for a particular Earned Value analysis scenario),
then an additional tab for incremental graph will be displayed along with other graphs. The tab
for Incremental graph will show the incremental curves for planned value, earned value, actual
cost, and forecast for the filters selected in the pickers. In other words, each X-axis data point
shows the consolidate data since last data point. The Y-axis displays the amount (in hundreds,
thousands, millions, etc.), and the value is determined by the graph dynamically showing the
best possible representation based on the data available. The maximum and minimum values
are determined by the maximum or minimum values as explained above.

Pre-requisites

You must have at least one Financial Period defined under Standards & Libraries (Company
Workspace > Standards & Libraries > Period Structure).

You must have selected the relevant financial period in the shell options (Shell Details > Options
> Financial Period).

Once you have performed the steps above you will be able to select the Financial Period from a
newly created drop down “Period” in EVA graph if they select graph type as "Period based"
screen as follows:

Create

Click Create and select the Graph type.

Properties

In the Properties tab, click on the Graph Type drop-down menu and select your option:

» Data Date Based
Enables you to continue using the data date to filter projects.

» Period Based
Enables you to see the graph in Earned Value Analysis based on the financial period
selected in the shell details tab (weekly, monthly, quarterly, or yearly).

EVA Graph (Cumulative, At Completion, Indices & Variance)

If you select the Graph Type as "Period based" for a particular Earned Value Analysis scenario,
then:
» Except a custom financial period, the x-axis points for any period will be the period start date.
» The start point will be the earliest project start date.
» The end point will be the farthest project end date.
» For custom financial period, the start and end points are period start and end points.
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» Data date drop-down menu will not appear in the graph. Instead, the Periods drop-down
menu is displayed that contains the following options:

»  Weekly

» Monthly

» Quarterly

» Yearly

» <Financial period name> selected in shell details tab (if applicable)

» If the graph type is Periods, then you can select multiple projects with the same or different
data date. The Actual value of other projects (after the least data date among the projects)
will be treated as Forecast.

» For existing users, when plotting the graph based on periods. The old financial period data is
generated through using the current baseline. Unifier freezes the data for each project until
the project data date. Also, the data which is being displayed in the graph will be updated
according to the financial period selected. The graph shows weekly data points on x-axis,
and the graph filters the project with same data date.

If you select the period type as financial period, then the data for all or filtered projects will be
consolidated and plotted in the graph. Data points on the x-axis will be the period end date. The
following two scenarios explain your selections:

Scenario one

If you have selected weekly, monthly, quarterly, or yearly from the drop-down, then the start
date of the first sub period will be the least project start date across all projects. Last sub
period will be determined based on the last data date across all projects. In other words, the
end date of last sub period should be greater than the last data date across all projects.

Scenario two

If you have selected a financial period define under Standards & Libraries, then the graph will
only displays the data between the first sub period and last sub period. Everything else will
be filtered out of the graph.

EVA Graph (Incremental)

If you select the Graph Type as "Period based" for a particular Earned Value Analysis scenario,
then an additional tab for Incremental graph is displayed along with the other graphs. A new tab
for Incremental graph displays the incremental curves for planned value, earned value, actual
cost, and forecast for the filters selected in the pickers. In other words, each x-axis data point
displays the consolidate data since last data point. The y-axis displays the amount (in hundreds,
thousands, millions, etc.), and the amount is determined by the graph dynamically to show the
best possible representation based on the data available. The maximum and minimum value is
determined by the maximum or minimum values as explained above.

At Completion Tab

View VAC, EAC, and BAC curves in the graph. Use the graph features as in the Cumulative
tab.
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Variance Tab
View CV and SV curves in the graph. Use the graph features as in the Cumulative tab.

Indices Tab

View CPI, SPI, and CSI curves in the graph. Use the graph features as in the Cumulative tab.

Performance Percentage Completion Sheet

Click the corresponding button to open the Performance Percentage Completion sheet
overlay in the EV Analysis log.

During each synchronization, the performance percentage completion value of an activity gets
updated from P6. Unifier stores the values against corresponding data dates, which are then
used to calculate earned value metrics.

Note: The functionality is only applicable to the current schedule of a
project.

Performance Percentage Completion Sheet - Toolbar

The following explains the toolbar options, columns, and rows:

» Actions
» Export CSV
» Update Data

To update historical performance percent completion for the activity against any date,
excluding Data Date coming through P6.

= Export CSV Template
* |Import CSV
Columns imported through Import CSV will be marked with an "*" icon.
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» Refresh: Click Refresh to update the performance percentage completion values from the
latest synchronization.

Find on Page

Projects drop-down: Select a project to view the performance percentage completion for
each activity against data dates.

Columns

The left pane of the grid displays Activity Id, and Activity Name. The right pane displays a
series of data dates based on the frequency of updates in P6.

Rows

The left pane of the grid displays display the activities of the project selected in the Projects
drop-down. The right pane displays % values against data dates for each activity.

Roll Up Earned Value Analysis to Cost Sheet

The Column Properties window enables you to select your cost sheets.
The following table explains the fields and options in the Column Properties window:

Field Description

Name Sheet name.

Datasource The name of the source.
Element To select the data element.

Entry Method

The options and sub-options are:
Manual Entry

» Direct entry into cell

» Lineitem content

Sheet

» Type (See below for details)

» Name (See below for details)

» Column (See below for details)
Formula

Data Format

The options are:
» Currency
» Percentage
» Decimal

Display Mode

The options are:
» Show
» Hide
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Total The options are:

» Blank

» Sum of All Rows

» Use Formula Definition

Column Position To indicate where the column must be positioned
After

Delete To delete the column properties.

OK To accept changes.

Cancel To cancel changes.

The Type field enables you to select the following:

» Worksheet
» Earned Value Analysis (EVA)
» Activity Sheet

The Name field displays the name of the Earned Value Analysis (1 to 6).

If there is no data or sheet for that Name field, then the value will be zero in the Cost Sheet for
that column. Once you refresh the EVA Sheet, the data will be rolled up to the Cost Sheet as a
column.

The Column field enables you to select the currency and decimal fields from the Earned Value
Analysis that are available to be rolled up into the Cost Sheet as a column.

Earned Value Management (EVM)

pv (Planned Value - cost)

ev (Earned Value - cost)

ac (Actual Cost - cost)

cv (Cost Variance - cost)

sv (Schedule Variance - cost)

bac (Budget At Completion - cost)
eac (Estimate at Completion - cost)
vac (Variance at Completion - cost)
etc (Estimate to Complete - cost)
forecast (Forecast - cost)
remaining_cost (Remaining Cost - cost)

Vv vV vV vV vV vV vV vV v v v

Note: The decimal type Data Element (DE) is available in the cost
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formula.

The Column Name field, in the Cell Details window, displays the DE field label in the respective
Earned Value Analysis.

Note: You can have from 1 to 100 predefined cost DEs created in the
Cost Sheet.

Earned Value Analysis User Defined Report (UDR)

You can create User Defined Reports (UDRSs) from the data present in your Earned Value
Analysis.

The Create User-defined Report window enables you to define the following fields for your UDR
(template or individual reports):

» Data Type

» Element

» Report Type
» Tabular
» Cross Tab
» Summary
» Alert

» Access Type

Note: The same fields will be available for permission-based data
sources.

The elements (Currency/Decimal), in OOTB Earned Value Analysis along with any user-defined
column will be available as DEs for your report.

Note: Only the data elements available in the Earned Value Analysis
Sheet will be available in the respective UDR.

Earned Value Analysis Report

The Earned Value Analysis Report node (Earned Value Manager module > Earned Value
Analysis Report node) in Unifier enables you to access and work with the EVA reports.

Earned Value Analysis Reports Log Window

The Earned Value Analysis Reports log window enables you to create and run reports. The
Earned Value Analysis Reports log window contains the following toolbar options:

Create This option is available for users with Create permission, at the node
level. See the Creating an Earned Value Analysis Report for details.
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Delete This option is available for users with Create permission, at the node
level.
View This option enable you to view all, create a new view, and manage views.

By default, the All view is selected. To define new views, click Create
New View. You can use the Manage Views option to manage the
user-defined views.

Edit View |To change the view of the log.

Refresh This option enable you to refresh the report log and view the latest report
definitions that have been added.

Print This option enable you to print the report log information using the
options available.

Find on Enables you to conduct a text-based search for each column in the log.
Page

The Earned Value Analysis Reports log window contains the following columns which
correspond to the fields that you have included in the report when you created one, in addition to
several more fields:

Name

Description

Earned Value Analysis Scenario
Report Template

Owner

Last Run

v v v v v Vv

The Earned Value Analysis Reports log window contains the following tabs:

General |Enables you to both view and change some of the fields in the report.
When you alter report detail in the General tab, you must save or save and
run the report to ensure that your changes have been applied.
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Schedule |Enables you to:

» Set Frequency for Scheduled Report Runs
» Determine the Output Information

The day value will reset to one, if you enter a numeric value that is out of
range.

The report will run on day twentieth of the first month of every quarter, if:

» You select a day between the first and thirty-first.
» You select the twentieth day of each quarter.

The email subscription option enables you to control the type of
Unifier-related email notifications that you want to receive.

In the user Preferences window (User control panel > Preferences >
Email Subscription tab) you can subscribe to receive emails when reports
are scheduled in the EVM reports (Earned Value Analysis Reports >
Results from scheduled EVA reports). This option will be available only
when the Earned Value Manager module is loaded in the company. When
you select the option and have a valid email address, then you will receive
email notification with the report attached. The format of the report is
according to the format selected when the scheduled report was set to run.
The email received contains the report (as an attachment, in Excel format)
with the following information:

» Source Name: Displays the shell name.

» Report Name: Displays the EVA report name.

» Description: Description provided in the EVA report properties.
» Unifier Login: To go to the Unifier login page.

The User Preferences Template window (Company Workspace >
Admin mode > Standards & Libraries > User Preferences Template),
Preferences tab, displays the option related to the Earned Value Report
scheduled runs (Earned Value Analysis Reports > Results from
scheduled EVA reports). Unifier uses the active user's preferences
template when creating new users, as default. The other templates can be
used to update preference settings for existing users.

History Enables you to see the following information:

» Run Date (the date the report was generated)
» Run By (who generated the report)
» Status (if the report is generated successfully)

Each report row has a gear menu (ﬂ) that enables you to run a report or delete a report:

» Run Report
You must have the View permission in order to be able to run the report, using the gear

menu (ﬂ). This option is shown when you select one report at a time. The report will be
displayed using the format saved in the properties.
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Delete

You must have the Full Access and the Create permissions in order to be able to use the

delete option. You can select one or more reports to delete.

Creating an Earned Value Analysis Report

Click Create in the Earned Value Analysis Reports log window to open the Earned Value
Analysis Report window.

1)
2)
3)

4)

5)

6)

In the Name field, enter a descriptive name.
In the Description field, enter description.

From the Earned Value Analysis Scenario field, select a scenario. The drop-down menu
lists all of the earned value scenarios that have been defined in the project. You can select
one scenario, only. Also:

» For formatl to format3, the cost-based earned value scenarios are available to select.
» For format4 you can select a unit-based earned value scenario.

From the Report Template field, select a template from the drop-down lists all of available
templates:

a. CONTRACT PERFORMANCE REPORT - FORMAT 1 (Based on WBS)

Format 1 defines cost and schedule performance data by product-oriented Work
Breakdown Structure (WBS).

b. CONTRACT PERFORMANCE REPORT - FORMAT 2 (Based on OBS)

Format 2 defines cost and schedule performance data by the contractor's organizational
structure.

c. CONTRACT PERFORMANCE REPORT - FORMAT 3 (Baseline Changes)
Format 3 defines changes to the Performance Measurement.
Baseline (PMB).

d. CONTRACT PERFORMANCE REPORT - FORMAT 4 (Staffing Forecasts)

e. Format 4 provides staffing forecasts for correlation with the budget plans, cost, and
schedule estimates.

f. CONTRACT PERFORMANCE REPORT - FORMAT 5 (Analysis report)

Format 5 is a narrative report used to provide the required analysis of data contained in
Formats 1-4

If you want to include additional parameters in your report, click to select the Set
Parameters field and proceed to select additional parameters from the options provided.
When you select a period type, Unifier displays the last 10 periods, starting from the current
period, for you to select.

When finished, click one of these options:
a. Create to create the report and run it later.
b. Create & Run Report to create the report and run it immediately after.
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Note: The staffing numbers are rounded to the closest decimal,
however, the total is calculated per actual value (the numbers before
being rounded).

Record-Level Permissions

The following explains the record-level permissions for Earned Value Analysis Reports.
To see the record-level permission:

1) Go to your project or shell (User mode).
2) Click Earned Value Manager to expand.

3) Click Earned Value Analysis Report sub-node to open the Earned Value Analysis
Reports log window.

4) Click to select a record.
5) On the right-hand pane, click Permissions tab.

The Permissions tab displays all the participants and their permission details.
To assign permissions:

1) Go to your project or shell (User mode).
2) Click Earned Value Manager to expand.

3) Click Earned Value Analysis Report sub-node to open the Earned Value Analysis
Reports log window.

4) Click to select a record.
5) Click Actions drop-down menu and click Permissions. The Permissions window opens.

Alternatively, you can click on the gear menu (ﬂ) of the select record and click
Permissions.

In the Permissions window, click the select icon of the Add field to open User and Group
Picker window (if you know the name, you can enter the name in the field--type ahead). This
enables you to select the user or a group of users who need permission. In this window, use the
View field to find users or groups and follow the prompts. When finished, ensure that you click
Done.

In the Permissions window, you will see the following columns:

» Name (locked column)
» Company (locked column)
» Select All
To select all of the permission options.
» Modify Permissions
If selected, then the Edit Report and View & Run options would also be selected.
Edit Report
View & Run
» Remove
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You must save your changes before you can use the Remove option. The Remove option is
not available if you are the owner of the selected record.

Assigning permissions to a single report can be done by a user who is the report owner or has
full access permission.

Assigning permissions to multiple users or groups is allowed if you are the report owner, or have
the required permissions, at the module level. Similar to assigning permissions on a single
record, you can select multiple records from the Earned Value Analysis Reports log window,
click Actions drop-down menu and click Permissions.

Additional information about record-level permissions:
When you assign permissions to multiple reports, you are adding new permissions.

When you select multiple reports to assign permissions, you must be the reports owner, or have
full access permission for all the selected reports.

If you have view permission at module level, or can only run permissions, then clicking the
Permissions option (Actions > Permissions) opens the view only permission window. In this
case, the columns are disabled and the Remove option is not available.

If you highlight, for example, the first three rows but select a permission option on the fifth row,
then the fifth row option will get selected and highlighted.
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Permissions

You can assign Earned Value Management permissions in the following permissions-related
modules:

» Permission Templates under Standards & Libraries
» Access Control, and Users / Groups under User Administration

Permissions correspond to the:

» Activity Manager and it sub-nodes
» Earned Value Analysis in shell (User mode)
» Master Rate Sheet in the Company Workspace (User mode).

In addition, Gateway configuration permissions are required to set up the synchronizations at the
Company Workspace (Admin mode level).

Assumptions: Permissions for other related areas -- Exchange Rates under Standards &
Libraries are granted at the Company Workspace (Admin mode level), and permissions to
modify properties of the shell types under Company Sponsored Shells are also given.

In This Section

GateWay PeImMISSIONS. ... ..uuuuuutuiiiiiiiiiiiieaiereerer bbb nnnsnnnnnne 221
Master Rate SNEet PErMISSIONS ........uuuuuuuieiiiiiiiiiiiiiieieiiieieesasseessseeseeeseeeenseeeeeeeeee 222
Activity Sheet in Shell (User Mode) PermissionS ..........cocuuvvuieiiiieeeieeeiiiiiiieeeeeeeeenns 223
Rate Sheet in Shell (User Mode) PermiSSiONS.............uuuvuveiiiriiiieeeiieiiiiiiieeiiiennnnnnns 224
Earned Value Analysis PErmiSSIONS ........cccuuuuiiiiiieeiiieiiiee e e e e 225
Earned Value Analysis Report PErmisSions..........ccoovvvvviieiiiieciieeeiiiee e, 226
OBS Sheet PeIMISSIONS ....cceiiieiie ettt e e e e e e e e e e e e e e 227
WBS Sheet PeIrMISSIONS .....iii it e et e e e e e e eeatea e e e e e eeeeeees 227

Gateway Permissions

The permissions for Gateway are as follows:

» Configure
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» Get/Send Activity Sheet Data

Master Rate Sheet Permissions

The permissions for Master Rate Sheet are as follows:

» Get Data
If this permission is enabled, user will be able to take action "Get Data" for Master Rate
Sheet (Company Workspace) which will update the roles and resources list from P6. When
Get Data is checked, the "View" permission gets checked automatically. User has the ability
to deselect the "View" permission. This automatically deselects "Get Data" permission. Thus,
the user cannot have "Get Data" permission without the "View" permission but can have
"View" permission without the "Get Data" permission.

» View

222



Permissions

If this permission is enabled, the user will be able to view the Rate Sheet node at company
workspace along with the Master Rate Sheet present in that node (if applicable).

Activity Sheet in Shell (User Mode) Permissions

The permissions for Activity Sheet in a shell (User mode) are as follows:

» Send Data
» Get Data - All
If this permission is enabled, user will be able to take action ‘Get Data" for system Activity

Sheet which will update the system Activity Sheet from P6. When Get Data is checked, the
"View All" and "View Current”" permissions are not selected automatically.

User has the ability to deselect the "View" permission. This automatically deselects "Get
Data" permission. Thus, the user cannot have "Get Data" permission without the "View"
permission but can have "View" permission without the "Get Data" permission.

» Get Data - Current

If this permission is enabled, when user clicks on Get Data, the user can only get the current
project data from P6, the user cannot get the baseline project data from P6.

» Modify - All

If this permission is enabled, then the user can modify both baseline and current P6 project
data.
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If Modify - All permission is given, the user will be given view All permission implicitly even if
the permission has not been selected.

» Modify - Current
If this permission is enabled, then the user can modify the current P6 project data, only.

The user will be given View - Current permission implicitly even if the permission has not
been selected.

» View - All

If this permission is enabled, then the user can view both baseline and current P6 project
data, present in the Activity Sheet.

» View - Current

If this permission is enabled, then the user will be able to view the Activity Sheet node along
with the Activity Sheet present in that node (if applicable).

» Full Access

If this permission is enabled, then the user will get full access to the Activity Sheet with all the
permissions mentioned above. In addition, the user can see the schedule tab, where the user
can schedule the Gateway synchronizations.

» Create Manual Activity Sheets
If this permission is enabled, then the user will be able to:
» Create, update, delete, and view all sheets.

» Receive and send the scheduling and resource spread data into the Activity Sheet from
P6 or Primavera Cloud.

Rate Sheet in Shell (User Mode) Permissions

The permissions for Rate Sheet in a shell (User mode) are as follows:

» Full Access
» Create
» View
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When checked, this will allow the user to view the Rate Sheet node and the Rate Sheets
present in the associated log.

Earned Value Analysis Permissions

The permissions for Earned Value Analysis are as follows:

Permission | Description

Create This will allow users to create an earned value analysis record. When
'‘Create' is checked, then "Copy, Refresh & View" permissions gets
checked automatically. User has the ability to "deselect" the "Copy,
Refresh & View" permission. This automatically deselects "Create"
permission". Thus, the user cannot have "Create' permission without
'‘Copy, Refresh & View" permission but can have "Copy, Refresh & View"
permission without the "Create" permission.

Copy This will allow users to create a copy of an earned value analysis. When
'Copy' is selected, the "Refresh & View" permission gets checked
automatically. User has the ability to 'deselect’ the "Refresh & View"
permission. This automatically deselects "Copy permission". Thus, the
user cannot have "Copy" permission without the "Refresh & View"
permission but can have "Refresh & View" permission without the "Copy"
permission.
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Data If this permission is enabled a user can refresh the Earned value analysis
Refresh data from the corresponding Activity Sheet. When selected, the "View"
permission gets checked automatically. User has the ability to "deselect”
the "View" permission. This automatically deselects "Refresh' permission.
Thus, the user cannot have "Refresh" permission without the "View"
permission but can have "View" permission without the "Refresh"
permission.

View When selected, this will allow the user to view the Earned Value Analysis
node with the list of records.

To grant permissions:

1) Go to Company Workspace (Admin mode).

2) On the left-hand Navigator click Access Control to open the Access Control log window.
3) Onthe Access Control log window click User Mode Access to expand.

4) Click Shells / Projects (Standard) to expand.

5) Click Earned Value Manager to expand.

6) Click Earned Value Analysis to open the Module Permission Settings window
(Permission Settings for: Earned Valued Analysis).

7) Click Add to open the Permission/Access Control window.

8) Click Add Users/Groups and add users, or groups, or both.

9) Inthe Permission Settings block select the necessary permissions.

10) When finished, follow the prompts to close windows and complete granting permissions.

Earned Value Analysis Report Permissions

The permissions for Earned Value Analysis Report are as follows:

Permission | Description

Full User or Groups with Full Access permission are allowed to create new
Access reports, modify, run, and delete reports under Earned Value Analysis
Reports. The log displays all of the reports that are created.

Create User or Groups with Create permission can create, modify, and delete
reports that have been created by the users. The log displays all of the
reports that are created.

View User or Groups with View permission can view the Earned Value Analysis
Report node.

View All User or Groups with View All Reports permission can view and run all the
Reports reports that have been created by the users.

User or Groups with View All Reports permission cannot modify the
existing reports or create new reports.

To grant permissions:
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Permissions

Go to Company Workspace (Admin mode).

On the left-hand Navigator click Access Control to open the Access Control log window.
On the Access Control log window click User Mode Access to expand.

Click Shells / Projects (Standard) to expand.

Click Earned Value Manager to expand.

Click Earned Value Analysis Report to open the Module Permission Settings window
(Permission Settings for: Earned Valued Analysis Report).

Click Add to open the Permission/Access Control window.
Click Add Users/Groups and add users, or groups, or both.
In the Permission Settings block select the necessary permissions.

10) When finished, follow the prompts to close windows and complete granting permissions.

OBS Sheet Permissions

To grant access, go to Access Control and select the OB Sheet.

The following permissions are available:

»

Create and Add Users to Project - Allow user to bring in active users from template or from
an existing project while creating OBS Sheet from template or from project.

Create - Allow users to create an OBS sheet by copying from template, project or new
structure from scratch.

Modify - Allows users to edit an existing structure
View - Allow users to view the OBS sheet
Hide Audit Log - Allow users to see audit if the permission is not enabled.

WBS Sheet Permissions

To grant access, go to Access Control and select the WBS Sheet.

The following permissions are available:

4
4
4

Modify - Allows users to edit WBS Attributes (including CSV Import) & view WBS Sheet.
View - Allow users to view the WBS Sheet.
Hide Audit Log - Allow users to see audit if the permission is not enabled.






Attributes

The following explains the Earned Value Management Attributes. For details about the data
elements, refer to the Unifier Reference Guide.

In This Section

ReCOSt — ACHIVILY AMIDULES .......eviiiiiiiiiiiiiie e 229
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Recost — Activity Attributes

By default, the Master Rate Sheet in the Company Workspace will be used to do the costing.
You can assign a custom rate sheet at the activity sheet level, or a project sheet level, and then
do the re-costing. Accordingly, the price/unit from the respective sheet is used to do the
re-costing.

The following logic is used to do the re-costing:

» If no rate (Price/Unit) is defined in the Activity Sheet, and no rate is defined for the
resource/role, then user will see a warning included in the history and a default value of O.

» If arate is defined for the individual resource on an activity, Unifier selects the project
currency and multiply that number by the number of units to get the cost.

Only the following fields will be re-costed for baseline schedule:
Activity Attributes

» Planned Total Cost (uuu_P6PlannedTotalCost)

» Actual Total Cost (uuu_P6ActualTotalCost)

» At Completion Total Cost (uuu_P6AtCompletionTotalCost)

» Remaining Total Cost (uuu_P6RemainingTotalCost)
Assignment Attributes

» Planned Cost (uuu_P6PlannedCost)*
» Actual Cost (uuu_P6ActualCost)*
» Remaining Cost (uuu_P6RemainingCost)*
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» At Completion Cost (uuu_P6AtCompletionCost)*

As part of baseline re-costing, the new planned total cost in current schedule has been updated

and recalculated for all the fields that are impacted by change in baseline planned cost.

» Spread Costing: Applying the correct cost-applicable on that day.

» CBS: Unifier uses the Estimate to Completion (ETC) calculation from Project ETC Formula.
» PV Cost: Planned Value (PV) cost of activity in Current Schedule is Planned Cost of the

same activity in baseline.

For cumulative calculation Unifier applies the formula on cumulative data, and similarly, does the

same for incremental data.

If a project does not have a baseline schedule, then Unifier uses the corresponding baseline

values from the current schedule.

Activity |Date Element |Calculation

Attribute

Planned |[uuu_P6Pla |Planned Total Cost is calculated by consolidating the planned

Total nnedTotal |cost across all assignments under an activity.

Cost Cost

Actual uuu_P6Act |The actual total cost incurred for the activity as of the project

Total ualTotalC |data date.

Cost ost Calculated by consolidating Actual Total Cost across all
assignments under an activity.

At uuu_P6AtC | At Completion Total Cost is calculated by consolidating the at

Completi [ompletion |completion costs across all assignments under an activity.

on Total |TotalCost

Cost

Remaini |uuu_P6Rem |Remaining Total Cost is calculated by consolidating the

ng Total [ainingTot |remaining costs across all assignments under an activity.

Cost alCost

Planned |uuu_P6PVC |The portion of the baseline total cost of the activity or project

Value ost that is scheduled to be completed as of the project data date.
Calculated as Planned Total Cost multiplied by Planned
Completion of the activity at the data date.
Planned Total Cost and Planned completion of the activity are
calculated from project baseline.

Earned |uuu_P6EVC |The portion of the project baseline total cost of an activity

Value ost actually completed as of the project data date.

Calculated as Planned Total Cost multiplied by Performance
Percent Complete.

The method for computing performance percent complete
depends on the Earned Value technique selected for the
activity's WBS.

Planned Total Cost of the activity is calculated from the
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Activity |Date Element | Calculation
Attribute
project baseline.
Estimate |uuu_P6ETC |The estimated cost to complete the activity is calculated as
to Remaining Total Cost for the activity or the Performance
Complet Factor multiplied by (Planned Total Cost minus Earned
e Value), depending on the Earned Value technique selected
for the activity's WBS (calculated from the primary baseline).
Planned Total cost is calculated from the project baseline.
For CBS, project level earned value technique is used for
data roll up.
Schedul |uuu_P6SP1 |A measure of the work accomplished as a percentage of the
e ndex work scheduled.
Performa Schedule Performance Index indicates whether you are
nce meeting earned and planned values within your schedule. A
Index value less than 1 indicates that less work was performed than
was scheduled.
Schedule Performance Index = Earned Value/Planned Value.
A value less than 1 indicates that the project is behind
schedule.
For not started activities, SPI is 1.
Cost uuu_P6CPI | A measure of the work accomplished as a percentage of the
Performa | ndex actual costs.
nce Cost Performance Index (CPI) indicates whether you have
Index spent money over the budget to date.
Cost Performance Index = Earned Value/Actual Cost. A value
less than 1 indicates that the actual cost has exceeded the
planned value.
For not started activities, CPI is 1.
Cost uuu_CSInd |A measure to check the overall status by combining cost &
Schedul |ex schedule.
e Index Cost Schedule Index = Schedule Performance Index * Cost
Performance Index.
For not started activities, CSl is 1.
Schedul uuu_PGSch The measure of schedule performance on a project.
e edulevari | A negative value indicates that less work was actually
Variance |ance

performed than was scheduled and vice versa.
Schedule Variance = Earned Value — Planned Value.
For not started activities, SV is 0.
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Activity |Date Element | Calculation
Attribute
Cost uuu_P6Cos | A measure of cost performance on an activity, WBS, or
Variance |tVariance |project.
A negative value indicates that the actual cost has exceeded
the planned value.
Cost Variance = Earned Value - Actual Cost.
For not started activities, CV is 0.
To uuu_P6TCP | A measure of the value of the project work that is remaining.
Complet | Index To Complete Performance Index (TCPI) is essentially a ratio
€ of the remaining work to the remaining funds.
Egzéforma It helps determine the level of performance that must be
Index achieved on the remaining work to meet recognized business
goals, such as the Budget at Completion (BAC) or the
Estimate at Completion (EAC).
You can set performance thresholds for calculated TCPI
values to display visual indicators that help you determine
whether you need to take corrective action.
To Complete Performance Index = (Remaining Work) /
(Remaining Funds) where the Remaining Work = Budget at
Completion - Earned Value.
If under budget, then:
Remaining Funds = Budget at Completion - Actual Cost
If over budget, then:
Remaining Funds = Estimate at Completion - Actual Cost
Estimate |uuu_P6EAC |The expected total cost of a schedule activity when the
at Cost defined scope of work will be completed. Calculated as Actual
Completi Cost (14) + Estimate to Complete Cost (24).
on The method for calculating estimate to complete depends on
the earned value technique selected for the activity's WBS.
The estimate at completion (EAC) will help you find a new,
realistic, budget to complete the project. It tells you how much
you may have to spend to complete the project.
The EAC can be calculated in three cases depending on the
situation.
Budget [uuu_P6BAC |The planned total cost through activity completion calculated
at by consolidating costs across all assignments.
Completi
on
Variance |uuu_P6VAC |The difference between the baseline total cost and the current
at estimate of total cost.
Completi A negative value indicates an estimated cost overrun. Budget
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Activity |Date Element | Calculation
Attribute
on At Completion is calculated from the current baseline.

Variance at Completion = Budget At Completion - Estimate At

Completion.

Recost — Assignment Attributes

Assignme |Data Calculation

nt Element

Attribute

Planned |uuu_P6Pla |Calculated at spread level.

Cost nnedCost | ypifier Planned Units X Price/Unit.
If the rate source is Override, then the system uses the rate
present in the activity sheet corresponding to that
assignment.

Actual uuu_P6Act | Calculated at spread level.

Cost ualCost | ypifier Actual Units X Price/Unit.
If the rate source is Override, then the system uses the rate
present in the activity sheet corresponding to that
assignment.

Remainin UL_IUTPGRem Calculated at spread level.

g Cost iunlngCos Unifier Remaining Units X Price/Unit.
If the rate source is Override, then the system uses the rate
present in the activity sheet corresponding to that
assignment.

At uuu_P6ATC | Calculated at spread level.

Completio |ompletion | ynifier At Completion Cost is the sum of actual cost and

n Cost Cost remaining cost for that assignment.

WBS Attributes

Assignment Data Element Calculation

Attribute

WBS Code uuu_P6WBSCode | The unique identifier of the WBS for the
associated activity.

WBS Name uuu_P6WBSName |The name of the WBS Code for the associated
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Assignment Data Element Calculation

Attribute
activity.

WBS Path uuu_P6WBSPath | The location of the activity on the WBS
hierarchy.

WBS Type REVIEWER: Need REVIEWER: Need info

info
ETC Technique |uuu_P6ETC The field is populated with the formula used for

the ETC calculation. ETC is the estimated cost to
complete the activity, WBS, or project.
Calculated as Remaining Total Cost for the
activity or the Performance Factor multiplied by
(Budget At Completion minus Earned Value),
depending on the Earned Value technique
selected for the activity's WBS (calculated from
the primary baseline). Budget at Completion is
calculated from the project baseline.

Activity Attributes (General)

Assignment Data Element Calculation
Attribute
Activity ID uuu_P6Activityld |The unique identifier of the activity. In order

to identify and track activities, P6 assigns
each activity a unique Activity ID that is the
result of joining the Activity ID Prefix with
the Activity ID Suffix and then adding an
Increment value. For example, a prefix of
PROJ-A# combined with a suffix of 2500
and an Increment of 5 will yield the
following activity IDs: PROJ-A#2500,
PROJ-A#2505, etc.

Activity Name uuu_P6ActivityName | The name of the activity.

Activity Status  |uuu_P6ActivityStat|The current condition of the activity. Valid

us values are Not Started; In Progress; and
Completed.
Activity Type uuu_P6ActivityType | Determines how duration and schedule
dates are calculated for an activity. Options
are:

Task Dependent: Activities are scheduled
using the activity calendar rather than the
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Assignment Data Element Calculation
Attribute

calendars of assigned resources.

Resource Dependent: Activities are
scheduled using the calendars of assigned
resources.

Level of Effort: Activities have a duration
that is determined by its dependent
activities and are typically administration
type.

Start or Finish Milestone: Indicates if the
activity marks the beginning or end of a
major stage in the project. Milestones have
zero duration and no resources.

WBS Summary: Activities that are used to
aggregate date, duration, and percent
complete values for a group of activities
that share a common WBS code level.

Activity % uuu_P6PercentCompl | An activity level setting in P6 used to
Complete ete update the amount of work completed on
an activity. Use one of 3 options for
identifying Activity Percent Complete:

Duration % Complete: Used to report
progress based on Remaining Duration:
[(Original Duration — Remaining
Duration)/Original Duration]*100.

Units % Complete: Used to report progress
based upon actual work performed and
remaining units to complete: (Actual
Units/At Completion Units) * 100.

Physical % Complete: Used to progress
based on personal judgment.

CBS Code bitemlID The cost code in Unifier to which you can
link an activity, assignment or expense.

Performance % |uuu_P6Performance% |The percentage of the activity or project
Complete Complete planned work that is currently complete.
Performance % Complete is used to
calculate earned value. It can be based on
the technique for computing earned-value
percent complete for the activity's WBS —
e.g., the activity percent complete, 0/100
rule, 50/50 rule, etc.
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Activity Attributes (Scheduling)

Assignment
Attribute

Data Element

Calculation

Planned Start

uuu_P6PlannedSta
rt

The date the activity is scheduled to start.

Planned Finish

uuu_P6PlannedFin
ish

The date the activity is scheduled to finish if
the activity has not started.

Planned
Duration

uuu_P6PlannedDur
ation

The expected amount of time required to
complete an activity. The planned working
time is calculated in P6 using the activity's
calendar. The duration is measured from the
activity's planned start date to its planned
finish date.

Start

uuu_P6Start

Start date is equal to the early start when an
activity has no progress. When the activity is
in progress or complete, start is equal to the
actual start.

Finish

uuu_P6Finish

Finish date is equal to the early finish when
an activity has no progress. When the activity
is in progress, finish will remain equal to early
finish. When the activity is complete, finish
date is equal to the actual finish date.

Actual Start

uuu_P6ActualStar
t

If work has started, the date on which the
activity, WBS, project, or EPS began.

If resources (labor, non-labor, or material) or
roles are assigned to the activity, the actual
start date is the earliest among all the
resource or role assignments.

For a WBS, project, or EPS, the actual start
date is the earliest actual start date among all
activities within the WBS, project, or EPS.

When P6 is integrated with Primavera Unifier,
the Actual Start date might have been
imported from Primavera Unifier rather than
calculated by P6.

Actual Finish

uuu_P6ActualFini
sh

The date on which the item, such as an
activity, assignment, or project, is complete.
When P6 is integrated with Primavera Unifier,
the Actual Finish date might have been
imported from Primavera Unifier rather than
calculated by P6.
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Assignment
Attribute

Data Element

Calculation

Actual Duration

uuu_P6ActualDura
tion

The total working time from the Actual Start
date to the Actual Finish date for completed
activities, or the total working time from the
Actual Start date to the data date for
in-progress activities. The actual working
time is computed using the activity's
calendar.

Remaining Early
Start

uuu_P6RemainingE
arlyStart

Remaining early start date is basically the
earliest date the activity can start or continue
after the data date. If the Activity has no
progress then remaining early dates are set
equal to the early dates. If progress follows
as expected, then remaining early start is
equal to the data date. Once the activity is
complete, remaining early start is blanked
out.

Remaining Early
Finish

uuu_P6RemainingE
arlyFinish

Remaining early finish is calculated by
adding the remaining duration to remaining
early start. Once the activity is complete,
remaining early finish is blanked out.

Remaining
Duration

uuu_P6RemainingD
uration

The total working time from the activity
remaining start date to the remaining finish
date. The remaining working time is
calculated using the activity's calendar.
Before the activity is started, the remaining

duration is the same as the planned duration.

After the activity is completed the remaining
duration is zero.

At Completion
Duration

uuu_P6AtCompleti
onDuration

The total working time from the activity's
current start date to the current finish date.
The current start date is the planned start
date until the activity is started, and then it is
the actual start date. The current finish date
is the activity planned finish date while the
activity is not started, the remaining finish
date while the activity is in progress, and the
actual finish date once the activity is
completed. The total working time is
calculated using the activity's calendar.

Primary
Constraint

uuu_P6PrimaryCon
straint

A user-imposed date restriction can be
applied to an activity that impacts the
scheduling of dependent activities. For
example, use the Start On or After constraint
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Assignment Data Element Calculation

Attribute
to specify the earliest date on which an
activity can begin.

Secondary uuu_P6SecondaryC | A maximum of two constraints — a primary

Constraint onstraint and a secondary can be applied to an
activity. To specify a secondary constraint, a
valid primary constraint must first be applied
to the activity.

Activity Attributes (Units)

Assignment
Attribute

Data Element

Calculation

Planned Total
Units

uuu_P6PlannedTot
alUnits

The planned units of work for the activity.

Actual Total
Units

uuu_P6ActualTota
IUnits

The exact number of units that have been
expended on the selected activity.

Remaining Total
Units

uuu_P6RemainingT
otalUnits

The remaining units of work to be performed
by the resource on the activity. Calculated as
Planned Units minus Actual Units.

At Completion
Total Units

uuu_P6AtCompleti
onTotalUnits

The sum of the actual units and remaining
units for the resource assignment on the
activity. Calculated as Actual Units plus
Remaining Units.

Activity Attributes (Cost)

Assignment
Attribute

Data Element

Calculation

Planned Total
Cost

uuu_P6PlannedTot
alCost

The expected total cost of the activity,
consolidating costs of all assignments.

Actual Total
Cost

uuu_P6ActualTota
ICost

The actual non-overtime plus overtime cost
for all the resource assignments of the
activity.

Remaining Total
Cost

uuu_P6RemainingT
otalCost

The remaining cost of all the resource
assignments for the activity.
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Assignment Data Element Calculation

Attribute

At Completion |uuu_P6AtCompleti |The sum of the actual costs plus remaining
Total Cost onTotalCost costs for the resource assignment on the

activity. Calculated as Actual Costs plus
Remaining Costs.

Activity Attributes — Earned Value

Assignment
Attribute

Data Element

Calculation

Planned Value
(PV)

uuu_P6PVCost

The portion of the baseline total cost of the
activity or project that is scheduled to be
completed as of the project data date.

Earned Value
(EV)

uuu_P6EVCost

The portion of the project baseline total cost
of an activity or all activities in the project that
are actually completed as of the project data
date. Budget at completion is calculated from
the project baseline. Calculated as Budget At
Completion multiplied by Performance
Percent Complete.

Estimate to
Complete (ETC)

uuu_P6ETC

The estimated cost to complete the activity,
WBS, or project. Calculated as Remaining
Total Cost for the activity or the Performance
Factor multiplied by (Budget At Completion
minus Earned Value), depending on the
Earned Value technique selected for the
activity's WBS (calculated from the primary
baseline). Budget at completion is calculated
from the project baseline.

Schedule uuu_P6SPIndex A measure of the work accomplished as a

Performance percentage of the work scheduled. Schedule

Index (SPI) Performance Index indicates whether you are
meeting earned and planned values within
your schedule. A value less than 1 indicates
that less work was performed than was
scheduled. Calculated as Earned Value
divided by Planned Value.

Cost uuu_P6CPIndex A measure of the value of work accomplished

Performance as a percentage of the actual costs. Cost

Index (CPI) Performance Index (CPI) indicates whether

you have spent money over the budget to
date. On the My Preferences page in P6, you
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Calculation

can set performance thresholds for CPI
calculated values to determine whether you
need to take corrective action. Calculated as
Earned Value Cost divided by Actual Cost. A
value less than 1 indicates that the actual
cost has exceeded the planned value.

Cost Schedule

uuu_P6CSIndex

Product of Schedule Performance Index and

Index (CSI) Cost Schedule Index.
Schedule uuu_P6ScheduleVa | The measure of schedule performance on a
Variance riance project. A negative value indicates that less

work was actually performed than was
scheduled. Calculated as Earned Value
minus Planned Value.

Cost Variance

uuu_P6CostVarian
ce

A measure of cost performance on an
activity, WBS, or project. A negative value
indicates that the actual cost has exceeded
the planned value. Calculated as Earned
Value minus Actual Cost.

To Complete uuu_P6TCPIndex The ratio of the remaining work to the

Performance remaining funds. Calculated as (Budget at

Index Completion minus Earned Value) divided by
(Estimate at Completion minus Actual Units
or Cost).

Estimate at uuu_P6EACCost The expected total cost of a schedule activity,

Completion a work breakdown structure component, or
the project when the defined scope of work
will be completed. Calculated as Actual Cost
plus Estimate to Complete Cost. The method
for calculating estimate to complete depends
on the earned value technique selected for
the activity's WBS.

Budget at uuu_P6BAC The planned total cost through activity or

Completion project completion. Calculated as Planned
Labor Cost plus Planned Non-labor Cost plus
Planned Expense Cost plus Planned Material
Cost.

Variance at uuu_P6VAC The difference between the baseline total

Completion cost and the current estimate of total cost. A

negative value indicates an estimated cost
overrun. Budget At Completion is calculated
from the current baseline. Calculated as
Budget At Completion minus Estimate At

240




Attributes

Assignment
Attribute

Data Element

Calculation

Completion.

Resource Attributes

Assignment Data Element Calculation

Attribute

ID uuu_P6ResourcelD |Resource code from P6.

Name uuu_P6ResourceNa |Resource name from P6; It can be a team
me name or resource name depending on the

rate assigned to that level.

Status uuu_P6ResourceSt |Status of the resource — Active/lnactive.
atus

Currency uuu_P6RateCurren |Currency for the rate.

Role Attributes

(¢}
‘ <

Assignment Data Element Calculation

Attribute

ID uuu_P6RolelD Role code from P6

Name uuu_P6RoleName Role name from P6; It can be a team name
or role name depending on the rate assigned
to that level.

Status uuu_P6RoleStatus |Status of the role — Active/Inactive

Currency uuu_P6RateCurren |Currency for the rate

Rate Sheet — Rate Tab

9]
‘ <

Assignment
Attribute

Data Element

Calculation

Effective Date

uuu_P6RateEffect

iveFrom

Date from which the rate is applicable.
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Price/Unit uuu_P6priceperun |Rate or price per unit.

it
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In This Section

OBS TeMPIALES ...ttt 243
WBS TEMPIALES ... 243

OBS Templates

1) Go to the Company Workspace and switch to the Admin mode.

2) From the left-hand Navigator click Templates module to expand.

3) Click OBS Sheets to open the OBS Sheets log.

4) Click Create to open the Create OBS Sheet window.

5) Enter a name in the Name field.

6) Enter a description in the Description field.

7) Click Create. The OBS Sheets log window displays the newly created OBS sheet.

8) Click the gear menu (ﬂ) on the newly created OBS sheet to open and click Open.

9) Proceed to create an OBS structure, under Templates. This can be used when creating the
OBS in a shell (Activity Manager > OBS Sheet).

WBS Templates

No templates are needed for WBS sheet as the WBS sheet is created directly by way of P6 and
Unifier Integration.
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In This Section
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WBS Configuration PacCKage ...........ccooiiiiiiiiiiiiiiiiiie 245

OBS Configuration Package

Open the New Component List > Earned Value Manager > OBS Attributes.

WBS Configuration Package

If you select the Schedule Manager in uDesigner, when creating a configuration package, then
WBS Sheet design will also be available as an option.
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